Movavi Video Suite 18

& Movavi Video Suite 18

® video
Edit video

Audio

Convert video
Photo

Record computer screen
Extras N1 Capture from cameras, VHS, TV
User Guides

Split video

Watch video

2, Activate BUY NOW

What do you need help with today?

Removing trial restrictions
Activate Movavi Video Suite save videos without a watermark and remove all restrictions.

Recording screen Editing video
Capture any fragment of your screen or the full desktop. Create a movie from videos and photos
Capturing video Cutting video
Record video from a camera. Cut video files into multiple files or cut out scenes.
Burning files to DVD Upload files to the web
Burn files and videos to DVD, create audio CDs. Upload videos and photos to social networks in bulk.

Need more help?
Write to us at support@movavi.com
Or click here to open live chat.



mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345
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Activating Video Suite
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

£l

Buy Activation Key

Step 2:
 Open the Movavi Video Suite launcher and click the Activate button.
» Or launch any application in Movavi Video Suite, then open the Help menu and select Activate Software.


http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
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(® video

Edit video

{®, Activation

Please enter your activation key:

Activate offline (by e-mail)

Activate Cancel

Watch video

Q, Activate BUY NOW

Step 3: Enter your activation key and click Activate.

i, Activation *

Please enter your activation key:

Activate offline (by e-mail)

Activate Cancel

Activating without Internet access
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

Buy Activation Key

Step 2:
* Open the Movavi Video Suite launcher and click the Activate button.
+ Or launch any application in Movavi Video Suite, then open the Help menu and select Activate Software.


http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
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Edit video

{®, Activation

enter your activation key:

Activate offline (by e-mail)

Activate Cancel

Watch video

Step 3: Enter your activation key and select the Activate offline option. Then, click Activate.

i, Activation *

enter your activation key:

Activate offline (by e-mail)

Activate

Step 4: In the next window, click Copy and transfer this information to a computer or device with an Internet connection.

Please copy this
To ensure 3 fast

Copy

After your req Yy eceie your
reqgistration ke 21 y tion key and paste it into
the appropriate box b

Step 5: When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You
should receive a reply within an hour. Copy the registration key from the reply and transfer it to the computer with Movavi Video Suite.



mailto:reg@movavi.com

Movavi Video Suite Activation

regi@movavi.com

Movavi Video Suite Activation

To ensure a fast response, do not change the body of the message.

Activation Key: 000000-11111-22222-33333-44444- 55555656666
Hardware D: 1057-F257-9696-1844-DD34-0000-0000-2BD6

Step 6: Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you
used before. Then, paste the registration key into the box and click Activate.

Enter your registration key:

JFR-TEGHEUR-TRETRY-ERT45Y-TUII678-WER24R

Activate

Getting an activation key

To activate Movavi Video Suite, you will need an activation key. You can buy an activation key from our official website or from any of our
partners, and it will be delivered to you via e-mail.

1. On the Movavi Video Suite launcher, click the cogwheel button and choose Buy Activation Key from the menu, or use the button below.

Buy Activation Key

2. On the purchase page, click the Buy Now button next to the type of license that you need.
« If you're a home user, choose the Personal License.

« If you're planning to use Movavi Video Suite for work, business, or government organizations, choose the Business License.

3. Fill in your billing information and enter a valid e-mail address. IMPORTANT! We will send the activation key to this e-mail address, so
please make sure it is entered correctly.

4. After you've completed your payment and your request has been processed, you will receive a confirmation e-mail from
support@movavi.com with your activation key.

If you haven't received your activation key:
* Check the Spam folder of your mailbox
+ Contact support

Trial limitations

When you first start your copy of Movavi Video Suite, it will be running in LIMITED TRIAL MODE. In trial mode, you can try out all of the main
features, but the following trial restrictions will apply:

TRIAL VERSION FULL VERSION
£ Movavi Video Suite will stop working after 7 days Vv Lifetime license
& A watermark with the words ' trial version' will be added to all *" No annoying watermarks

output videos
& Capture time is limited to 2 minutes per video + Unlimited capture time

& You can only convert half of each audio file and half of each video " Unlimited video and audio conversion
if you use SuperSpeed mode

" Free updates
" Discounts on other Movavi products and upgrades

7


http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/support/contact.html

Edit video
Using the Video Editor, you can create your own movies using the media files you have on hand. To open the Video Editor app, click Edit
video on the Video tab.

Import

¥ o

& Movavi Video Suite 18

) Vides ’
Edit video

How to use the Editor?

Step 1: Add media Step 2: Edit video
Add videos, photos, and music to your video project. Edit and enhance the video clips to
Open captured videos in the Editor make your video just the way you like it.
Record video Cut and split video
Record audio Rotate clips
Arrange files chronologically Crop the frame

Apply cool filters

Step 3: Join clips with transitions Step 4: Annotate your video
Drag-and-drop transitions from the Video Editor's Get your thoughts across with sound and text.
extensive collection to join clips with fun animations. Record a voice-over
Add text titles

Step 5: Save your video
Export your project to a common video format.
Save for devices
Save for uploading online

Activating and installing packages
Expansion packages are the sets of additional content which include transitions, titles, stickers, backgrounds and music. The packages are
created to help you achieve your creative goals, broaden your freedom of expression and save your time choosing the right artistic tools.

Step 1: Acquiring the package
To use the content expansion packages, open Movavi Video Suite. Switch to the Transitions, Titles or Stickers tab. Then find and click the
Store button at the bottom of the categories list or find the More Effects element in any of the effects categories. You will be redirected to

the Movavi Effects Store web-page to choose and purchase the packages.

Transitions
ﬂ [ : o F :‘:‘ 2 - ;
EFFECTS E B yr
STORE k- :{‘;;:__. ‘- ; ?; :

Want more Barmn door «— Barn door 1
filters?

e ‘M .

< '_ - ‘.. b'
__; ,.:.._:-_-- . 4. ’.::". > .h_,..
B R LB

Blur in Elur in-out Blur out

Step 2: Making a purchase
On the website, choose and purchase the set you like. After the purchase is processed you will receive an e-mail with an activation key, a link

to download the package, and an instruction on how to install it.

Step 3: Installing a package



Click the link you received with the e-mail and download the package. When the downloading is finished, open the package as you normally
would open your project: double-click the file or drag and drop it in the Video Editor. The program will run the installation process. In the
Installing Package window click Install and follow the instructions on the screen.

INSTALLING PACKAGE

-~

[ e
Family Set

Cancel Install

Step 4: Activating a package
Copy the activation key from your e-mail and Paste it in the in the Activating Package window and click Activate.

ACTIVATING PACKAGE

-~
i
=11

Cancel Activate

Wait until the installation is finished. The new elements will appear in the corresponding categories of the Video Editor. The categories with
the new elements will have a blue dot on them and the elements will be marked with the NEW label.

ENJOY NEW CONTENT!

Family Set

Cannot install or activate the package? Make sure that:

* The Video Editor you have installed on your system supports the packages;

* You use the key that was sent to you after the purchase of a package and there are no additional symbols after the key;
* You have enough free disk space to install the package.

Quick Video mode
How to make a video using the Montage Wizard

In quick mode, you can use the Montage Wizard to automatically build a video for you in minutes. All you need to do is provide the wizard
with some video clips or photos, choose a music track, and let the Wizard cut and build the video for you. You can also use the Montage
Wizard to make slideshows.

Create a new slideshow
+ On the welcome screen, click Quick Video to open an automatic video montage wizard.
* Or open the File menu and choose New Montage.



MOVAVI VideoEditor

Step 1: Add files

On the Files tab of the Wizard, add the videos and photos that you want to see in your video.
* Click +Files to add several files from one folder,

* Click +Folders to add the entire contents of one or more folders,

+ Or drag and drop the files onto the Wizard window.

The files you've added will appear below. You may need to wait a couple minutes for all the files to load.
* To change the order of the files, simply drag their thumbnails with your mouse.

+ To remove files from the video, click the Eall in the upper right-hand corner of each file, or select the files you want to delete and click the
trash can button above the list.

"IIIIIIIIIIIIIIII

Step 2: Choose a theme

Click Next or the Theme tab at the top to proceed to the next step. You can choose a preset of transitions, titles and music on a number of
themes and jump straight to the Preview step. To add music and transitions of your choice, click No theme and then proceed to the next
step.

10
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Step 3: Add music

Click Next or the Music tab at the top to proceed to the next step. Here you can choose music to play along with the video. You can add your
own audio files or use any of the provided audio clips listed in the left-hand column. These audio tracks are royalty-free so you can upload
these videos to YouTube and other services.

* To use one of the built-in tracks, click the + button.
+ To add your own audio file, click the +Music button at the top and select the audio track, or simply drag the file onto the Wizard window.

Discovery

»

Step 4: Add transitions
Click Next or the Transitions tab to move to the next step. Choose among the given types of transitions.

Random ransitions

Simple transitions

f crossfades, gradients and push transitions fo

Geometric transitions

Artistic transitions

Step 5: Preview and adjust your video
You're almost done! Click Next or the Preview tab at the top to proceed. If you've added a lot of videos, you may have to wait up to a couple
minutes while the Wizard does its magic. You can then preview the video and make some adjustments to get it just right.

11
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Titles
Adding opening and closing titles will give context to your video. Add your text and click Apply to see the changes in the player.

Video length

By default, the video will be just as long as the background audio. To change the length, deselect the Fit to music length option and use the
slider to set how long you want the video to be. If you opt for a shorter video, some clips may not appear in the end result.

Black bars removal

If the resolution of a project and the files in your slideshow are different, black bars will appear. You can remove them by checking the Fit to
frame option — the image resolution will be automatically fitted to the frame size.

Learn more about frame size

Volume balance
The volume balance slider determines what kind of sounds you can hear in the video. Move the slider to the left side to hear more of

the video sounds (such as speech and ambient sounds), or move the slider to the right to make the video's sound quieter and raise the
background music volume.

Step 6: Save the finished video
Finally, click the Export tab at the top and decide what you want to do with your finished video.

Save the video

Continue editing

Share on the web

Save the video - choose this option to save the result as a video file.

Continue editing - this will close the wizard and let you add finishing touches in full mode. After you're finished, you can always click the
big green Export button at the bottom to save the result.

Share on the web - choose this option to save a video file and upload it to YouTube right away.

12



Choose format

iy ¥

Name your video

Start exporting

To save the video, choose a video format you want to use and pick a folder to save the video file. If you're uploading the video to YouTube,
sign in with your YouTube account and fill in the details about your video. Then, click Start to begin saving your video file.

Learn more: Exporting videos | Uploading to YouTube
New Project mode - quick start
How to make a movie from scratch

In full-feature mode you can use all the tools that the Video Editor has to offer and create professional-looking videos without complicated
software.

Step 1: Create a project
On the welcome screen, click New Project to begin making your movie.
Learn more: Creating and managing projects

MOVAVI VideoEditor

Step 2: Add files
Now it's time to add the files that'll make up your movie. On the Import tab, click Add Media Files and choose the files you want to use.

“RRN
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Tt Foreworks at night
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Learn more: Adding files | Recording video | Recording audio | Using built-in media
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Step 3: Cut clips

To split clips or cut out unwanted bits, use the scissors button on the toolbar:
1. On the Timeline, select the clip you want to cut.

2. Place the position marker where you want to split the clip.

3. Click the scissors button to cut in the current position.

To delete parts, repeat the steps to cut off the unwanted fragment so that it is a separate clip, then select it and click the trash can button.

Step 4: Add and edit music

You can add audio files the same way you add videos and photos: on the Import tab, click Add Media Files and choose the audio file you
want to use. The audio clip will appear as a blue ribbon at the bottom of the Timeline. To change the volume and edit the audio track, select it
on the Timeline and click the Audio properties button.

Step 5: Annotate your video

1. Click the Titles button on the left.

2. Pick a text style in the list and drag it onto the uppermost track of the Timeline. The text clip will appear as a purple ribbon.
3. Double-click the title clip and edit the text in the player. Here, you can change the font, color, and other properties of the text.
4. To change how long the text appears, drag the edges of the title clip on the Timeline.

:

Subtitle

Step 6: Save your movie
When you're finished with your video, it's time to save it in a format that can be viewed in any video player.

14



1. Click the Export button to open the exporting options.

2. In the Export window, choose a format you want to save the video in, and name your movie.
3. Finally, click Start to begin processing the video. Your video will be ready in a few minutes.
Learn more about saving your video

Choose format

iy v

Name your video

Start exporting

Tip: Make sure to save your work once in a while: choose Save from the File menu to save the project so that you can access it later.

Creating and managing projects
A Movavi Video Editor project is a file in the % mepx format that contains your work on creating a video. A project stores the locations of each
media file used in the project, as well as the edits, special effects, and settings that you use as you make your movie.

Creating a project

To create a new project, open the File menu and choose New Project. Then, choose New Project if you want to make a movie, or choose
Quick Video if you want to make a quick slideshow.

Creating projects

Saving projects

To avoid losing your editing progress, make sure to save your project every once in a while. To save a project, open the File menu and choose
Save Project.

Saving projects

Opening projects
To open a previous project, open the File menu and choose Open. Then, find the project file and continue working on your movie.
Learn how to open projects

Media use

When you add files to a project, Movavi Video Editor uses the original file for reference as you edit the movie. To save your disk space,
Movavi Video Editor does not make copies of the files, but rather remembers the /ocation and name of the original file, so if you move or
delete the files, they will also disappear from the project.

Because all of your editing work is done in the project, your original files are not edited in any way, and you do not need to make reserve
copies.

How can | play my project?

Project files cannot be viewed in a regular video player, but can only be opened with Movavi Video Editor, Movavi Screen Capture Studio, or
Movavi Video Suite. To view the finished work in a player, you need to first export your movie to a common video format.

Learn how to export your project

Saving projects
A project stores all the work on your movie or slideshow. You can save the project for finishing your work later, or restore your work if you
need to edit something after you've finished.

Saving the project

1. Open the File menu and choose Save Project.

2. You will be asked to enter a name for the project. Your project files should be stored in the "\My Videos\Movavi Video Suite\Projects" folder
of your user.

3. Click Save to confirm saving.

15



File Edit Playback

Add Media Files... Ctrl+0

Save Movie as a Media File...

New Project Ctrl+N

MNew Montage

Open Project... Ctri+F
Recent Projects 2
Save Project Ctrl+5

Save Project As._.. Ctrl+5Shift+5

Save Portable Project

Saving portable project

A portable project is a kind of project that contains all the media files that comprise it. Since the program does not create copies of the files
and only refers to their location on the disk, the project will only work properly on another computer if all the media files are present there

as well. You can copy the files manually or automatically. To automatically save the project together with the files, click the File menu and
choose Save Portable Project. Name your project and set the destination path. Then transfer the project folder to another computer with
Movavi Video Editor installed.

How to change where projects are saved

1. Open the Settings menu and choose Preferences.

2. Click the Files tab.

3. Find the Save project files to box and click the button next to it to choose a different folder for storing your projects.
4. Select the folder you want to use and click Select Folder.

See also:
Project settings
Exporting videos

Opening projects
Open a project to continue working on your video.

Where are my projects located?
By default, your projects are saved to "\My Videos\Movavi Video Suite\Projects”, but you can save your projects anywhere else you like.

How to open a project
A: Find your project in Explorer and drag it onto the Video Editor window.

B: Find your project in Explorer and double-click it to open it.

C: Click Open Project on the welcome screen. Then, locate the project file in the Explorer box and click Open.

D: Open the File menu and choose Open Project. Then, locate the project file in the Explorer box and click Open.
Restoring work from an autosave

If your computer malfunctions and you cannot save the project, some of your work may be restored using an autosave file. Simply rename
the "autosave.mepx”file and open it in the Video Editor to continue working on your project.

16



autosave.mepx

Media use

When you open a previously created project, you may see a message saying that a file is missing from the project. This may happen if one of
the files used in the project has been moved somewhere else or deleted from disk. In this case, click Browse in the message box to find the
file in its new location, or click Skip to open the project without the missing file. We recommend that you copy all the files to your hard drive

before editing.

Transferring the project to another computer

If you need to work on your project on another computer, you might want to transfer it. To make this transition easy and not to lose any
important files, collect the project file and all the files that you have used or only going to use in a separate folder on your computer. Then
move the folder to another computer that also has a copy of Movavi Video Suite. Open the project in the Video Editor and in the error window
set the new path to the files location.

Note: If you only transfer the project file and leave the media files out, the project will not contain any files.

Learn more:

Saving portable project

Project settings
You can adjust the parameters of your video, such as bitrate, video resolution and frame rate. These settings affect the quality and the size
of a final file. You can change them when saving your video or at any other time.

Opening project settings
In the Export window click the Advanced button.

Video

©)

Video settings
The video settings apply to all videos and photos used in the project.

Video codec
Codec is a program that encodes and decodes data. Codecs, as well as bitrate, use data compression and affect the size of a final media file,
so it is easier to store and manage the file.

Resolution

The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common
resolutions. For your convenience, each resolution is marked with its respective aspect ratio. Ideally, the frame size should match the
resolution of the videos and photos you plan to use in your project, and should not exceed the resolution of the largest video. Smaller
resolutions allow you to make the output video smaller and thus save your disc space, however, this will sacrifice some video quality due to
downscaling.

—Framesize | Aspect Ratio

320x240 4:3
640x480 4:3
1280x720 16:9
1280x960 4:3
1920x1080 16:9
1920x1440 4:3

Aspect ratio
The aspect ratiois the ratio of the video or photo's width to its height. The most commonly used aspect ratios are 4:3, used generally for
analog TV and in many old movies, and 16:9, the standard resolution for widescreen digital video.
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43 16:9

A relative comparison of aspect ratios
When you add videos and photos to the project, they will be scaled to fit the specified frame size. If you add media files with an aspect ratio
different from that of the project, you may see black bars appear on the sides of the video. Furthermore, if you add low-quality videos to a

project set up to a high resolution (frame size), the small video may be stretched to fit the frame and thus may appear pixellized. For best
results, we recommend setting the frame size and aspect ratio to match all or most of the videos and photos you are planning to use.

I
16:9 — 4:3

Examples of black bars appearing when importing videos with a different aspect ratio.

4:3—16:9

If you cannot find the necessary frame size in the list, you can manually enter the width and height into the respective boxes of the Project
Settings window. Note the button with the link icon to the right of the boxes. It allows you to maintain existing proportions when entering

new values: ﬂ - the proportions are constrained, allowing you to set a larger or smaller frame size without changing the aspect ratio; Kkl -
you can freely enter the width and height with any proportions. Simply click this button to toggle the two states.

FPS

The number of frames per second is the number of shots that a camera takes each second to make a video. Most cameras shoot video at
around 24 frames per second. However, some cameras can shoot high-speed video that you can use to make slow motion clips. If you plan
on using high-speed videos, choose the FPS that matches the video. If you're using regular videos, leave the default FPS.

Bitrate

Bitrate is the amount of digital information contained in one second of a media file. It is measured in kilobits per second (Kbps). You can
control the output file size by changing the bitrate value. There are three types of bitrate available in the video editor:

Auto bitrate (CBR) is a constant value set by the program and calculated according to other already set quality options such as video codec,
resolution and frame rate.

Constant bitrate (custom CBR) is a constant manually entered value which is then used to process the entire video. This type of bitrate
allows to predict the size of a final media file.

Variable bitrate (VBR)is an automatically picked value that is set within the set quality requirements for the video. VBR will adjust to the
image using the optimal values to save the quality: lower values for a static image and higher values for a more dynamic one. But in this case
it is impossible to predict the output file size.

Audio settings

Sample rate

The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default
sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music
tracks.

Channels

Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording
music; mono sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally
preferred number of channels, however, some mobile devices record sound only in mono mode. 5.1 surround sound comprises six audio
channels. It is one of the most popular to be used in home theater systems.

See also:
Saving projects
Opening projects

Adding media files

To begin working on your video project, you will first need to add some media files to the Editor.

Step 1: Open the Import tab
The Import tab is the first one you see when you start a new project. To open the Import tab, click the very first button in the upper left-hand
corner of the window.

Step 2: Go to the My files section

In the left part of the tab, you can switch between adding your own media files or using built-in clips. Click on My files to show file
import options.

18
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Media Files

Step 3: Open files
1. Click Add Media Files.
2. A Explorer dialog box will open. Locate your files or folders and click Open.

If you want to add the entire contents of one or several folders, click Add Folder, select the folder(s) you want to use and then click Select
Folder to add the files.

=20 =

@ + Competer b Locsl Dk () o Sampler o+ | Gusick sart vides

Add
Media Files

Step 4: Arrange the files

Once you've added the files, they will appear on the 7imeline at the bottom of the window. The Timeline allows you to arrange the clips in the
order you want. The clips' position relative to the time ruler at the top of the Timeline determines when it will appear in the finished video. To
reorder the clips, select the clips you want to move and then drag them to the new position on the Timeline.

Learn about using the Timeline

Moving a clip on the Timeline

See also:
Working with video
Working with audio

Using built-in media
Movavi Video Editor comes with an extensive collection of built-in royalty-free music, sounds, videos and backgrounds that you can use in
your videos.
Step 1: Open the Import tab
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Click the Import button in the upper left-hand corner to open the media options.

L

Intro videos

Media Files

Step 2: Choose a media type
On the left side of the Import tab, you can switch between using your own media files and adding clips from the stock collection.

* Sounds - fun sound effects and audio samples to make your videos more expressive.

+ Music — instrumental tracks for your background music.

+ Sample video — video clips that you can use as intros, overlays, and animated backgrounds.

+ Backgrounds - image backdrops for your titles and transparent clips.

« Intro videos —specifically designed video clips that use visual elements and text and can be edited and customized.

Step 3: Download media files

You need to download built-in media to use it. If a thumbnail has a download icon : , it means the file has not been yet installed to the
category. To download it point the cursor at the media thumbnail. The "Click here to download" message will appear. Click on the thumbnail.
The download will start and a progress bar will appear. When the download is finished, you can use the media file.

You can cancel the download by clicking the Stop icon ] .

P C
Download more! Bubbles Camera

Click here to download @

Candle Ciky Clock

_l e BT

i
You can also download the whole category at once. To do this, open the tab you need and click the download icon next to the category
name. All the files in the category will be downloaded.

Step 4: Add the clip to your project
To use a stock clip in your project, pick a clip you like and drag it onto the Timeline.

+ Drag sample video clips and backgrounds onto the video or overlay track,

+ Drag sounds and music onto the audio track. To link a sound clip to a video clip, select it on the Timeline and drag it up, towards the video
track until a line appears between the audio clip and the video clip. Now, when you move the video clip, the sound will stay in sync.

20



An error occured while downloading the media files
An error can occur in case if there is no internet access. Check your internet connection and restart the download by clicking on the files on

which the error occured. The clips will be downloaded and stored in your '<HE SAG6bITH>: 3agavite 3HadyeHne rnepemerHHoviMedia Content”
folder.

Recoding video
Follow the steps below to record video from a camera that's connected to your computer.

Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is
working correctly.

Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Impaort

=]

Record
Video

Start Caplure

Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and frame rate. A
larger resolution will be able to retain better quality, however, the video file size will be larger. A higher frame rate is necessary for recording
motion, while static scenes can be captured with a lower frame rate.

Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.

H & @

Caphure seltings
Video capture device:
Livel Cam Chat HD VFO790
Resolution: Frame rate:
1280 x 720

Audio capture device:

Live! Cam Chat HD VFO790

Start Capture
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Step 5: (Optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them somewhere else, click the

folder button under 'Save files to' and choose a different location.

Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file
name template.

Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button on the right.
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.

Step 9: When you're done, click Back to editing at the bottom of the window. The captured files will be added to your project's Timeline.
Also, they are saved to disk in case you want to use them later.

e e

Capure settings

Start Capture

Recording audio
After you've added some videos and photos to the Timeline, you can record audio from a microphone or any other recording device.

Step 1: Open audio recording options
On the toolbar, click the microphone button to open audio recording options.

Record audio
Audio device: FrontMic (Realtek High Definit «
Audio quality: 44.1 kHz, stereo, 16-bit r
Violume: I 100%

Enable voice-over mode

Step 2: Set up recording
1. In the Audio device box, choose the device you want to use.

To record from a microphone: choose your preferred microphone or webcam microphone. If you don't see the device in the list, try
reconnecting it to your computer.

To record audio from the computer: select Stereo Mix from the list. This will allow you to record any music, alerts, or other sounds playing
on your computer. If you don't see "Stereo Mix" in the list, it may be disabled on your computer.

2. (Advanced) In the Audio quality box, choose the sample rate and number of channels that you need.
3. Set the volume level you want to use in your project.

4. (Optional) Enable voice-over mode if you want to record an audio commentary.
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Record audio

Audio device: FrontMic (Realtek High Definition Audic v @
Audio quality: 44.1 kHz, stereo, 16-bit v @

Violume: 0% I 100% @
Enable voice-over mode @

REc Start Recording

5. On the Timeline, place the progress marker to where you want the recording to begin. You will be able to move the clip later.

Step 3: Record sound
1. When you're ready, click Start Recording. You will be given a three-second countdown.

2. The recording will start immediately. The recorded audio will appear on the independent audio track, so it can be moved to any position in

the project. If you have enabled the voice-over mode, you will be given a three-second countdown. The video will start playing simultaneously
with the recording. This way you will be able to use your video as a visual aid as you speak. This recorded audio clip will appear on the linked
audio track.

3. When you're done, click Stop Recording.

Record audio
Audio device: FrontMic (Realtek High Definition Audic
Audio quality: 44.1 kHz, stereo, 16-bit
Volume:
Enable voice-over mode

REC Start Recording

Importing AVCHD video

Follow the steps below to import previously recorded videos from an AVCHD camera.

Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera. Make sure that
the system recognizes the device and that it is working correctly.

Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Impaort
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Add files to the Editor

Step 3: In the Video capture device box, select your AVCHD camera.
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Video capture device:

Sony Camcorder

Msers frest_user_3Monies 'Movavl Libirary E

A files to the Editor

Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't need.

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere else, click the

folder button under 'Save files to' and choose a different location.

Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file
name template.

Step 7: Click Add files to the Editor to start copying the files. This may take a while depending on the size of the videos.

Saving captured files

Add files to the Editor

File information
Find the file's location
To find the location of the clip's original file, right-click on the clip on the Timeline and choose Show in Folder from the menu.

24



Play / Pause
Hide Clip
Tools

Import

= Split Ctrl+B
Insert Freeze Frame Ctrl+E

Detach audio

Copy Ctrl+C
Cut Ctrl+%
Paste Ctrl+\v

Delete

Show in Folder

;- el * k File Information
Femaedrky -||-I__ el bl

See a clip's media information
To see a clip's media properties, right-click it on the clip Timeline and choose File Information from the menu.

File format: MP4 Play / Pause
Video stream Hide Clip

Tools

Ctrl+B
Ctrl+E

Split
Insert Freeze Frame

Du ) . Detach audio
Bitra D

Copy
Cut
Paste
Delete
Show in Folder

Duration: ) sec, : :
Bitrate: 1 i | File Information

A small File Information window will appear. Here, you can find the resolution, aspect ratio, and other properties of the original file. Knowing
certain information about a clip will allow you to better understand which settings are best for your videos.

Preview and organize clips
Use the player in the upper right-hand part of the window to preview your project.

Current position
Your current playback position can be controlled using the position marker under the player and on the Timeline.

Player's
position marker

O
M es [F 32 )

00:02:00

Timeline's
position

turtleinflowers.mp4

Waterfall.rp4

For precise positioning:

+ To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds (Shift+Ctrl+Right) or Skip Backward
by 0.5 Seconds (Shift+Ctrl+Left).

* To move precisely from frame to frame, use the Previous frame (Ctrl+Left) and Next frame (Ctrl+Right) buttons in the player. This will move
the position marker exactly one frame backward or forward.

* Use the Scale slider to zoom in on the Timeline to make positioning easier.

Scale: | | i H

Playing the video
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1. Move the position marker to where you want to start playback.
2. Click Play or press the Space Bar key.
3. Click the Pause button or press the Space Bar again to pause playback.

4 > P e [] 52 W)

3 4 5 6 7 8 9

1 — player position marker 6 — aspect ratio of the project
2 - current time 7 — unpin player

3 - previous frame 8 - view in full screen mode
4 - play/pause 9 - player volume

5 — next frame

Arranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your
mouse and drop them onto the desired position. To select multiple clips, use Ctr/+click or click and drag to draw a selection on the Timeline.

Working with two monitors
If you have more than one monitor, you might want to detach the player into a separate window to have more room for editing. To do that,

click the Unpin player button under the player:

The player will then open in a separate window. When you want to return the player back into the main window, click the Pin player button in
the detached player or close the player window.

Timeline tracks
The Timeline at the bottom of the window is your working area where you can organize and edit the clips that make up your video project.
The Timeline consists of several tracks for different types of media, that are all synchronized against the time scale at the top. You can
imagine the tracks as layers: the uppermost layer appears on top of all others. With the exception of the video track, you can layer several
clips on each of the tracks to make your video more dynamic.
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Firewarks.mp4

Discovery.mp3

Adding tracks

With the Timeline that allow work with multiple tracks, you have only three tracks available at the start. To work with several video, audio and
title tracks at the same time, find a Plus button at the upper left-hand corner of the Timeline. Select the track you want to add and click it. You
can then customize the Timeline: change the order of the tracks, hide the content of a track and link tracks to the video track or detach them.

H+l§ Addvideo Track
J’* Add Music Track

TT Add Title Track

Video track

The video track holds videos, pictures, and the transitions between them. You can also place titles, callouts and stickers on the video track if
you want them to appear against a black background.

Overlay track

You can use the overlay track to show videos and images on top of the main video track. Simply drag the clips from the main video track up
onto the overlay track. Overlay clips are linked to a corresponding clip on the main video track. This way, they will stay in sync even of you
move or cut the video clip.

Learn more: Creating overlays
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Title track

The title track holds all of your text clips, as well as callouts and stickers. Clips on this track are linked to a corresponding clip on the main
video track. You can't use transitions or effects on any of these clips, but you can animate them.

Learn more: Titles | Callouts | Stickers

o - —~ - .
Tltle cllp T"_[' TITLE CLIF Oh Gradient Ca"nut cllp

Independent audio track

The independent audio track is the very last track of the Timeline and it contains audio that is notlinked to any clips on the video track. This
track is most suitable for background music and clips that don't need to be synchronized to videos. Both audio tracks show waveforms that
visualize the volume throughout the clip, so that you can easily find the quietest and loudest parts. You can also fine-tune the volume using
volume curves.

Learn more: Volume curves

Volume curve
w3

Audio track with waveform

Linked audio track

The linked audio track allows you to link audio clips to videos and images on the video track so that the audio clips stay in sync as you edit
your project. The linked audio clip is hidden by default, but you can link clips by dragging them a little but up, towards the video track until a
blue line appears, connecting the audio and video tracks. If you record audio, the audio clip will also appear on this track.

Rec-1-2017.09.12-13/56.23, wav Linked audio {:Iip

I
| Applause.m|

Drag audio clip up to link

Linking and detaching tracks

Tracks can be linked to the video track or detached from it. Linking tracks allow synchronized editing and provide overall control and
comfortable work with the many clips you might have on the Timeline. Moving a clip on the video track will also move all the clips on the
linked overlay, title, and audio tracks and your composition of the files will remain intact. Clips on the detached tracks are independent of

each other.

To link or detach a track, click the chain icon at the beginning of a track.

Problem: My audio clip appears on the video track
Solution: Some audio files contain album art, which may sometimes be recognized as the video stream. Therefore, these files may be placed
on the video track. In that case, drag the audio clip down onto the audio track, and delete the album art from the video track if you do not
need it.

Hiding and muting tracks
If you want to see how your project looks without some clips, you can disable separate clips or entire tracks.

Hiding clips

To hide a clip from view, right-click the clip and choose Hide Clip from the pop-up menu. The clip will not appear in the player or on the
finished video until you re-enable it.
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Play / Pause
Hide Clip

Tools r

Riree ok

Split Ctrl+B
Insert Freeze Frame Ctrl+E

Detach audio

Muting clips
To disable a clip's sound, right-click the clip you want to mute and select Mute Clip from the pop-up menu. The clip will not play in the player
or on the finished video.

Split Ctrl+B

Disabling tracks
« To hide an entire track from view, click the eye icon E& to the left of the track you want to hide.
» To disable the sound for an entire track, click the speaker icon EBl to the left of the track.

exploding-fireworks-§

Mute track

Firewarks.mpd

Zooming the Timeline
To change the zoom level of the Timeline, drag the Scale slider at the bottom of the window. Move the slider left to zoom out, and move the
slider right to zoom in on the Timeline.
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How to undo actions
It's okay if you make a mistake or change your mind while editing videos because almost any action can be reversed!

* Click the Undo button on the toolbar or press Ctrl+Z to cancel an action.
« If you've cancelled an action but want to return to it, click the Redo button or press Ctrl+Y.

i
i Bright_Futurs mad

Cutting video
Use the scissors button on the toolbar to cut video and audio clips into parts. To delete a clip you don't need, click the trash can button.

i
i Bright_eburs mad

Splitting clips into parts

Step 1: Select the clip that you want to split.

Step 2: Move the position marker to the moment where you want to cut the clip.
Step 3: Click the Split button on the toolbar.
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Cutting out fragments
Step 1: Cut the clip at the beginning of the unwanted fragment
1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch
the moment precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

Step 2: Cut the clip at the end of the fragment
1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.

Step 3: Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the
Timeline will move to close the gap.

3. Delete

a T XC U O & & il

00:00:00 00:00:15 00:00:30 00:00:45 00:01:00

1. Cut off the beginning
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2. Cut off the end
Montage.mp#d Montage. mps ’ ATTA L Rkt |
Trimming clips

If you only need to cut off some parts at the beginning or at the end of a video or audio clip:
Step 1: Place your mouse pointer over the edge of the clip.
Step 2: Click and drag the edge towards the center of the clip to trim the clip to the desired length.

Montagalimpd

For more precise navigation:

* Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second
forward or back.

* Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+Left and
Shift+Ctrl+Right.

* Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+Left and Ctrl+Right

keyboard shortcuts.
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Edit and enhance clips
After you've added some videos and images to your project, they will appear on the video track of the Timeline, where you can move and
arrange them into a movie. Next, it's time to edit and enhance the clips.

Edit videos and images
Photos and videos aren't always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.

Learn more: Rotating video | Cropping video | Color adjustments | Volume

| Speed | Reversing video | Image duration | Fades | Video properties

~C
=B

Picture in picture and overlays

To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to
create an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.

Learn more about overlays

Picture and picture, side by side overlay modes.

Removing black bars

Some videos and photos may have black bars around them in the player. This can happen because the clip's proportions are different from
the project, for example, if you add a vertical video. To fix this, you can crop the video or use the special Vertical video fill filter.

Learn more about removing black bars

Creating freeze frames

A freeze frame is a still shot inserted in the middle of a video for dramatic effect. You can use the freeze frame to emphasize a very fast
movement or pause the action while you give additional information.

Learn more about freeze frames

” Rally Drift.mp4

# Rally Drift |

Rally Dniftembd

Fally Diniftem md Rally Dwpiftmpd

Before and after adding a freeze frame

Rotating videos and images
Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any photo or video around without having to crane your neck.

Rotating by 90 degrees

1. On the Timeline, select the clip you want to rotate
2. Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.
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Fixing the horizon level
1. On the Timeline, select the clip you want to rotate.

2. Click the Crop button on the toolbar to open the Crop tool above.
3. In the Crop tab, use the Angle slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.

Tools

@ Crop and Rotate

Angle:

Cropping video

Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object inside the frame.

Step 1: On the Timeline, select the clip you want to crop.

Step 2: Click the Crop button on the toolbar. The Crop tool will open, and a cropping frame will appear inside the player.

Tools

@ Crop and Rotate

Angle:

Step 3: In the player, set the frame so that the parts you don't want are outside it. Drag by the corners of the frame to change its size, and
drag by the center of the frame to move it.
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Tools
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Use the options in the Crop tool on the left to modify the frame:

Angle: use the Angle slider to rotate the crop frame. This way, you can fix the horizon level.

Tools

@ Crop and Rotate
Angle: | 0,0° :

Straighten
or rotate
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Apply

Step 4: Click Apply. A star kafl icon will appear on the clip once you've applied cropping.

Removing crop

To remove Crop or any other effect, click the star Rafl icon on the clip to show the list of applied effects and filters. In the list, select Crop and
click the Remove button to discard the effect.

1. Click the star

2. Select Crop

Blur - intense

Remove

3. Click Remove

Color adjustments
If the original videos look bleak and not vibrant enough, you can use the automatic adjustments to make the colors look more vivid. If that
isn't enough, you can always use manual adjustments to correct the colors.

Step 1: Select clip
On the Timeline, select the clip that you want to adjust.

Step 2: Open color adjustments
On the toolbar, click the color adjustments button to open the adjustments tool.
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Tools

@ Color Adjustments

Auto saturation Magic Enhance
Auto contrast Auto white balance

Manual Adjustments

Step 3: Use auto adjustments
Select the adjustment options that make the selected clip look nicer. The changes will be applied instantly. The Magic Enhance option will
automatically determine the best brightness and contrast balance.

@ Color Adjustments
~ Auto saturation
Auto contrast

Magic Enhance

Auto white balance

Manual Adjustments

Step 4: (Optional) Use manual adjustments
Click the Manual Adjustments button to show more color control options. Here, drag the sliders to fix the brightness, saturation, hue, and
other properties. To go back to the simple options, click the Auto Adjustments button underneath the sliders.

@ Color Adjustments

Brightness
Contrast
Saturation

Highlights

Gamma

Video properties
To open the clip properties for a video or image, select the clip on the Timeline and click the Clip Properties button on the toolbar.
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The Tools panel will open on the Video tab, where you can edit the following:

Volume — Sets the volume of the clip's built-in audio.
Only for video clips with built-in audio.

Normalize — Makes the quiet parts of the built-in audio louder.
Only for video clips with built-in audio.

Speed — Makes the video play faster or slower.
Only for video clips.

Reverse — Plays the video backwards.
Only for video clips.

Opacity — Affects the visibility of videos and images on the overlay track. Reduce the clip's opacity to make it more transparent.
Only for cljps on the overlay track.

Duration — Sets the precise length of the image clip.
Only for images.

Fade in — The video fades in from black in the time you set. Any built-in audio will also fade in.
For any clips.

Fade out — The video fades out to black in the time you set. Any built-in audio will also fade out.
For any clips.

See also:

Audio properties

Video volume

Video speed

Reversing video
Changing image duration

Fading video

Video speed
With the Speed tool, you can speed up or slow down a video or audio clip. This can be useful if you're working on a music video and you want
the video to match the tempo of the music.

Step 1: On the Timeline, select the clip you want to edit.
* Note that slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and above.

* You can also change the speed of any audio clip.
« If you modify the speed of a video with built-in audio, the audio speed will also be changed.

Step 2: Click the Clip Properties button to open the editing tools for the selected clip.
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Step 3: Drag the Speed slider to set the necessary video speed, where 100% is the video's original speed.

Volume:
Mormalize:
Speed:

Reverse:

The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with a
star icon:

A8 Waterfall. mp4

Reversing video
Reversing the video will play the clip and its audio backwards. You can combine reversing the video with increasing speed and the VHS filter
to create a cool rewinding effect.
Step 1: On the Timeline, select the clip that you want to reverse. You can reverse both video and audio clips.

Step 2: On the toolbar, click the Clip Properties button to open the properties for the selected clip.

Step 3: In clip properties, select the Reverse option.
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Volume:

Normalize:

Speed:

Reverse:

When you apply reverse, the clip will appear with a reverse icon on top of it:

veaterfalimpd

Image duration

You can change how long each image appears in your video or slideshow either using the clip properties or you can set all images to the
same length.

Changing one image's length
Step 1: On the Timeline, select the image clip that you want to edit.

Step 2: Click the Clip Properties button to open the properties for the selected clip.

I._o & i
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Step 3: In the Duration box, enter the new length of the image. Use the following format: Aours. minutes.seconds.milliseconds. Changes will
be applied instantly.

Duration: 00:00:18.400
Fade in:

Fade out:

O Color Adjustments
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You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip
appears on the Timeline, the longer it will play in your movie or slideshow.

00:04:44 00:04:46 00:04:48 00:04:50 00:04:52

photo-1416: 7o |  gengez, © - | photo-1417¢
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Setting the same length for all images
To set all of the project's images to the same length:

Step 1: Click the Transition Wizard button on the toolbar.

Step 2: In the Transition Wizard window, enter the preferred length into the Image slide duration box. If you don't want to use transitions to
join your clips, select No transitions in the box at the top.

Step 3: Click OK to set all the images to the selected length.

Toals

Use this transition style for all clips:

Mo transitions

¢3| Image slide duration:

Fading video
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading
simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
Step 1: On the Timeline, select the clip that you want to fade.

Step 2: Click the Clip Properties button on the toolbar. The clip properties will open in the Tools panel above.

L_.D & i

i

Step 3: Set the fade length using the sliders on the Video tab.
Fade in — how long in seconds it will take to fade in to full opacity at the beginning of the clip.

Fade out — how long in seconds it will take to fade out from full opacity at the end of the clip.
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Reverse:

Duration: 00:00:04.000

Fade in:

Fade out:

See also:
Adding transitions

Fading audio

Creating overlays
How to create picture in picture and split screen effects

Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect,
add a logo or watermark, create a Chroma Key effect, or insert a short clip without cutting the main video.

Before you start:
You'll need to add both the main video (the video that will be the bottom layer) and the overlay video or image to your project. You can use
images in PNG format to add transparent logos.

Step 1: Place the overlay clip

1. Select the clip that you want to make an overlay and drag it up, towards the top of the Timeline.

2. Drop the clip onto the over/ay track, where you want it to be shown relative to the main video track.

Note that a blue line now connects the overlay clip to the main clip. This means that the overlay clip is linked to the main clip: if you move,
cut, or delete the main clip, the overlay clip will also be edited.

Hint: you can also layer several overlays at once!

Flames.mov

Flames.mov h‘ - Volcano.mp
T o '

Step 2: Edit the overlay

1. Double-click the overlay clip to set it up. An options panel will appear in the player.

2. Open the drop-down box on the overlay panel and choose how you want it to appear on the video: Picture in picture, Side by side, or
Cover.
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Tools Picture in picture
Side by side
Cover

Picture in picture

This is the default overlay mode. Using picture in picture mode, you can show the overlay video over any part of the screen. This also works
for logos.

1. Choose Picture in picture mode from the drop-down box.

2. In the player, move the overlay to where you want it to appear in the frame.

3. To resize the overlay, drag at its corners.

4. Deselecting the Constrain proportions option will allow you to resize the overlay to any proportions, but a drastic change in proportions
may make the overlay look distorted.

Picture in picture overlay

Side by side
Side by side mode works best for creating split screens.
1. Choose Side by side mode from the drop-down box.

2. Use the buttons on the panel to choose how you want to align the two videos:
Hint: for best results, place BOTH sides on the overlay track.

Side by side overlay
Cover

In Cover mode, the video on the overlay track will cover the main video completely. This can be used for a whole bunch of things:
* For videos with transparent areas

+ Cutting out the background with the Chroma key effect Learn more: Chroma key

* Inserting a short clip over the main video without having to cut it.

Cover overlay: left - the main clip is hidden;, right - Cover with the Chroma Key effect

Step 3: Apply the changes
After you've set up the overlay, click the Apply button on the overlay options panel.

Step 4: Overlay clip properties
In the Tools panel on the left, set up the overlay's properties:

Volume: if you have several video clips playing simultaneously, you might want to mute one of the clips. To do that, click the mute m button,
or use the slider to lower the volume.

Opacity: if you want to make the overlay more transparent, lower its opacity, and the main video track will be seen through it.
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Fade in / Fade out: while you can't use transitions on the overlay track, you can fade in the clip to make it appear smoothly. Set the slider to
the time it should take for the clip to appear.

Tools

Volume:

Opacity:
| Fade in: 1

Fade out: 1

Awesome, right?

Adding a watermark
Adding a watermark to your videos will protect your ownership even if it's shared all over the Internet. You can add an image overlay with

your own watermark or logo, or make a new one using text.

Image watermark

Step 1: On the Import tab, click Add Media Files and add the image or video that you want to use as the watermark. For the best look, use
images with transparent areas.

Step 2: Drag the watermark clip up to the overlay track to make it appear on top of other videos.

@ -
Add

Media Files
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Step 3: Double-click the watermark clip to edit the overlay. Move and resize the overlay in the player and then click Apply when you're done.
Step 4: To change the opacity, click the Clip Properties button and use the Opacity slider.

Step 5: To make the watermark show over the whole length of the video, enter your project length into the Duration box, or drag the right
edge of the overlay clip until the end of the video track.

v Apply

Duration: 00:00:40.000

Opacity: @ S,
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Text watermark
Step 1: Click the Titles button on the left and pick a nice title style for your watermark.
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Step 2: Drag the titles you like onto the beginning of the Titles track at the top of the Timeline.
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Step 3: Double-click the titles and enter your watermark text. Pick a cool font and color on the panel above the player. Click Apply when
you're done.

Step 4: To make the watermark show over the whole length of the video, drag the right edge of the text clip until the end of the video track.
HINT: If your movie is long, zoom out on the Timeline to make changing clip length easier.

OR: Double-click the text clip to enter text editing mode and enter the length into the Duration field. You can find the length of your whole
project at the bottom of the window.
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Creating a freeze frame

A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to
emphasize a moment or create a pause to explain things to the viewer.

Step 1: Choose a frame

Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous
frame and Next frame buttons under the player.

o
i:{ Previous frame 4 » p| < Nextirame: 7 y))

00:00:40 00:00:45 00:00:50 00:00:55

Pick a time

slow-motion-car-drifting-through-grass-2_wikfiglbwb__C

Step 2: Create freeze frame
Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.
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Play / Pause
Hide Clip

Tools k

Split Ctri+B
Insert Freeze Frame Ctrl+E
Detach audio

Step 3: Set duration

By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.
Learn about changing image duration

Rally Driftim @ Ralby Eirift. mipd

Removing black bars

Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around
them. You can remove black bars from videos using one of the ways below.

Fill empty spaces

Using a special filter, you can fill the black bars with blurred parts of the video. This allows you to keep the entire video on screen and make it
more pleasant to view.

1. On the Timeline, select the clip with black bars around it.

2. Click the Filters button to open the Filters tab.

3. Find the Vertical video fill filter in the Adjustments group and drag it onto the clip.

Learn more about filters

Filters

@ - BB

Manual crop

If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars around it.

2. On the toolbar, click the Crop button.

3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut
off.

4. In the Tools tab on the left, click Apply to accept the changes.
Learn more about crop
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Tranle

@ Crop and Rotate

Angle:

Fading effects
Making effects and filters fade in smoothly is possible using the overlay track.

Step 1: Copy the clip and paste it onto the Timeline.

Step 2: Drag the copy of the clip onto the overlay track above so that it's right above the original. Now you have two identical clips right on
top of each other.

h0:00:00 00:00:07 00:00:14 00:00:21 00:00:28

Step 3: Double-click the clip on the overlay track and choose Cover mode in the panel above the player. Click Apply and the clip will cover
the entire frame.

Picture in picture v Apply
Side by side =3
Cowver

Step 4: Now, apply the effects or filters you want to use onto the upper, visible clip.
Learn more: Applying filters
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Step 5: With the overlay clip selected, click the Clip Properties button. There, use the Fade in and Fade out sliders to set the fading time.
Here you can also set Opacity if you want to reduce the effect's strength for the whole clip.

O
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pacity:
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-| Fade in:

' Fade out:
'.“

The clip with the effect will gradually appear and disappear, exposing the underlying original clip.

Editing audio
Add audio

To add music or other sounds to your project, open the Import tab and click Add Media Files. Or you can use one of the built-in music tracks:
click the Music category and take your pick from our royalty-free music collection.
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Learn more about adding audio:
Adding audio files | Recording audio | Extracting audio from video | Using built-in sounds

Volume

To change a video or audio clip's volume, click the Audio Properties button on the toolbar and set the necessary volume in the audio tools
section above.
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; Volume: 1005 =15 |

Learn more:
Volume levels | Volume curves | Muting clips

Playing audio synchronously

If you want two audio clips to play at the same time, simply drag one clip underneath the other. This way, you can have as many sub-tracks
as you want. With music, you can use this to create a crossfade effect when you join songs: align the beginning of the second song with the
end of the first song to make them joined almost seamlessly.

Ethnic.mp3

The end of the first audio clijp will be played with the beginning of the second clip.

Fairy Tale.mp3

Audio properties and adjustments
To enhance and adjust the audio, click the Audio Properties button on the toolbar and scroll down in the audio tools section above.

Tools

Video
(O Equalizer
(O Noise Removal
(O Audio Effects
(O Beat Detection

Learn more:
Audio properties | Fading audio | Equalizer | Noise removal | Audio effects | Beat detection

Adding audio

You can add audio files in much the same way as you add video files.

Add files from your hard drive

1. On the Import tab, click Add Media Files to browse for audio files on your computer.
2. A Explorer dialog box will open. Choose the files that you want to use.

3. Click Open. The files will be added onto the audio track of the Timeline.
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Use sample audio clips

If you don't have any suitable audio files, you can use free music tracks and sounds from the Movavi Video Suite audio collection.
1. On the Import tab, click Music if you need a background music track, or click Sounds if you need short audio samples.

2. Click on a clip to play it. When you've picked a clip, drag it onto the audio track of the Timeline.

Learn more about sounds

m Import
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Record audio

1. Connect a microphone to your computer.

2. On the Timeline, place the position marker to where you want the recording to start.

3. Click the microphone button on the toolbar to open recording options.

4. Set up your recording device and volume.

5. Click Start Recording and record the audio. When you're finished, click Stop Recording. You'll find your new recording on the Timeline.
Learn more about audio recording

Record audio

Audio device: FrontMic (Realtek High Definit

Audio quality: 44.1 kHz, stereo, 16-bit @

Volume 0% I 100%
Enable voice-over mode

Start Recording

Set start time for audio clips

After you've added the audio files, they will appear on the audio track of the Timeline as blue ribbons. To change when the audio clip starts
playing, drag it along the Timeline, using the ruler at the top for time reference.

Learn about audio tracks

48



applause.mp3 i

Autumn.mp3

Extracting audio from videos
If you want to use a soundtrack from a movie, you can extract it from a video file and use it in your project.

Step 1: Open video file
On the Import tab, click Add Media Files and choose the video that contains the music you want. The file will be added to the video track of

the Timeline.

Step 2: Trim video
If you don't need the whole video's soundtrack, you can trim away the parts of the video you won't need. It's easier to do this with the video

file, as the video can help you visually find the beginning and end of the fragment you need.

1. Select the video you want to trim.
2. Move the position marker to the beginning of the fragment you want to keep and click the Split button on the toolbar (scissors). You've just

cut off the beginning of the video.
3. Now, select the second clip and move the position marker to the end of the fragment you need. Click the Split button again, and the

fragment will now be in a separate clip.
4. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.
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Step 3: Extract the audio
The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down

onto the audio track. If you don't need the video clip anymore, go ahead and delete it.
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You can now work with the extracted audio clip separately.

Step 4: Save the audio (optional)

If you want to save the audio clip for later use, you can export it as an audio file:

1. Click the Export button. The export window will open.

2. In the Export window, switch to the Save Only Audio tab.

3. Select an audio format that you want to save the audio file in.

4. The Save to field shows where on the disk the file will be saved. To change that folder, click Browse and select a new folder.
5. Finally, click Start to save the audio file.

Learn more about saving audio

Please respect copyright laws and stay within the boundaries of fair use of copyrighted materials.
Looping audio
If the music file you've selected doesn't go all the way until the end of your movie, you can loop the audio and have the file play over again
until the end of the video.

Step 1: Copy the audio clip. To do that, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu, or use the Ctrl+C
keys.

Step 2: Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until
the audio length is greater or equal to the video length.

Step 3: Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip,
and drag the edge to the left, until the end of the audio clip is right under the end of the video clip.

00:00:00 00:00:03 00:00:06 00:00:09

Using sounds
You can make your movies more expressive using the built-in sound samples.

Step 1: Click the Import button to open the Import tab.

Step 2: On the left part of the Import tab, click Sounds to open the sound collection.
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Step 4: (optional) To synchronize the sound with a video clip:

1. Select the sound on the Timeline and drag it up towards the video track.

2. The linked audio track will appear, and a blue line will connect the sound clip to the video track.

3. Adjust the position of the sound clip on the linked audio track so that the line points to where the sound should begin.
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Rain_and_thunder.mp3

Audio properties
To open the properties for any audio, including built-in audio on the video track, select the clip on the Timeline and click the Audio Properties
button on the toolbar.
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The Tools panel will open on the Audio tab, where you can edit the following:
Volume — Sets the volume of the clip.
Normalize — Makes the quiet parts louder.

Speed — Makes the audio play faster or slower.
Changing the speed of built-in audio will also affect its video.

Reverse — Plays the audio backwards.
Reversing built-in audio will also reverse the video.

Fade in — The audio fades in from complete silence to full volume in the time you set.
Fadling built-in audio will also fade the video.

Fade out — The audio fades out from full volume to complete silence in the time you set.
Fading built-in audio will also fade the video.

See also:
Video properties

Equalizer
Volume curves

Volume levels
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an audio clip on any track.

Step 2: Click the Audio Properties button to open the tools for the selected clip.

Step 3: Drag the Volume slider to set the necessary level, where 100% is the original volume.

* To mute the clip, click the Mute m button on the right.
- If parts of the audio clip are too quiet, select the Normalize option to increase their volume.
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Playback volume
Only for previewing
If you need to temporarily change the volume of playback in the editor, without changing the project's volume, click the speaker icon in the
preview area and set the necessary volume level. Please note that this will only affect the volume while previewing the project in the Video

Editor, and will not affect the output file.
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If you need more advanced volume control, you can use volume curves on the Timeline to set the volume for precise parts of any audio clip.
Learn more about volume curves

Rain_and_thundermp3

Audio clip with a volume curve

Volume curves
With volume curves, you can control the volume for each part of the clip and smoothly increase or decrease the volume.

Rain_and_thundermp3

Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The
white line on the image below is the volume curve before you add any points.

Rain_and_thundermp3

Step 1: Set the base level
Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

Rain_and_thundermp3

Step 2: Add a volume point

Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume Point
from the pop-up menu. Next, drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move with the
point to make the transition smoother.

Make as many points as you need for each part of the clip where you'd like a peak or a drop in volume.

Rain_and_thundermp3

Step 3: Manage the volume for a part of the clip
To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment:

Click and drag the white line between two points to change the volume level for this fragment.

Step 4: Transitions
When you drag a volume point or a fragment, the parts of the curve to the left and right will also move with it.

Rain_and-t

However, this affects only the closest parts of the curve. To get more control over the behavior of the curve, create more volume points. This
way, only the adjacent parts will be adjusted, leaving the rest of the curve as it was.

Linking audio
You can link audio clips to videos or images on the main video track so that they stay in sync as you edit your project. To link an audio clip:

1. Select an audio clip on the audio track at the bottom of the Timeline.
2. Drag it up, towards the video clip you want to link it with.

3. You'll see that a new audio track has appeared, and a blue line now connects the video and audio clips. Drop the audio clip onto this new
track. The audio clip is now linked to the video clip with the blue line.
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Drag audio clip up to link

Fading audio
In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between songs.

Step 1: On the Timeline, select the clip that you want to fade.

Step 2: Click the Audio Properties button on the toolbar. The clip properties will open in the Tools panel above.

i
Bl

Step 3: Set the fade length using the sliders on the Audio tab.

Fade in — how long in seconds it will take to fade in from silence to full volume at the beginning of the clip.

Fade out — how long in seconds it will take to fade out from full volume to silence at the end of the clip.

Video
Mormalize:
Speed: 1005

Reverse:

Fade in:

Fade out:

(O Equalizer

Equalizer
Using the equalizer, you can boost or reduce the levels of specific frequencies.

Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.

Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Equalizer.
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Tools

You can save your own equalizer presets to use them in other projects. Set the volume bars to the right levels and click Save. In the new
window enter a preset name and click OK. The created preset will appear in the presets list.

Noise removal
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.

Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Noise
Removal.
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Step 3: Use the Noise suppression slider to set the amount of noise you want to remove.
« Start with low levels and listen to the audio to check if the noise is gone.
+ Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.

Tools
@ Noise Removal

Move the slider to the right to remove more noise. High levels
may cause distortions.

Noise suppression: 50 %

Apply

Audio effects
Audio effects can transform the sound of an audio clip.

Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.

Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Audio

Effects.

Tools

(O Audio Effects

Step 3: Click the box in the Audio Effects section and choose an audio effect you like.
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Removing effects
When you've applied an audio effect to a clip, a star icon will appear on it:

ﬁemrding 1.mp3

Click on the star to show a list of applied effects. Then, select the effect you don't want and click Remove.

Remove

See also:
Using sounds
Audio properties

Beat detection
To make your movie or slideshow more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and
then adjust your movie to the beat of the music.
Step 1: On the Timeline, select the music that you want to detect beats for.

Step 2: Click the Audio Properties button to open the audio tools. Then, scroll down and click Beat Detection.

Selected clip

beats - Other beats

l Autumn.mp3
o3

=

Step 4: (optional) After the beat markers have been placed, you can modify their tempo. Use the Min time between beat markers slider to
make the beat slower or faster.
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@ Beat Detection

Min time between beat markers:

Step 5: Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.

Removing beat markers
+ To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select Remove Beats from the pop-up menu.

+ To remove all beat markers from your project, right-click the Timeline ruler and select Remove All Beats from the pop-up menu.

Filters
Using filters you can alter the mood of the video, make an old movie, overlay cool flying objects, and more.

Step 1: Open the Filters tab
Click the Filters button to open the filters collection. Click on a filter's thumbnail to see its preview in the player.

Filters

rial-highwiny-creerpasi-traiie._ridiefgrh__ D mps

Step 2: Find a filter you like

+ On the left, you will see groups of filters. Click on a group to see the relevant filters.

« If you're looking for a specific filter, enter its name into the search box under the group list.
« If you really like a filter, click the heart icon to add it to the Favorites group.

Search by name Filters
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F L ,r Click on a filter to
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collections

Step 3: Apply the filter
When you've found a filter you like, drag its thumbnail onto the clip you want to apply the filter to.
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Clip with an applied filter
Removing filters
1. Click on the star kafl icon on the clip to see the list of applied filters and tools.

2. In the list, select the filter that you don't want.
3. Click Remove.
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Whistler

Transitions
Jump to: changing transition length | add a transitions to all clips | removing a transition

Transitions are short animations that use geometric shapes and transparency to connect two clips in a creative way.

Add a transition
1. Click the Transitions button on the left sidebar to open the list of all transitions. Click on a transition to preview it in the player.

lransitions

‘l.r e

2. In the list of transitions, pick a style you like and drag-and-drop its icon between two clips on the Timeline. If you really like a transition

style, you can click the heart icon E to add it to your favorites list.
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Transitions

A transition icon will appear between the two clips.
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Change transition length

By default, each transition will be set at 2 seconds long. To change the transition length:

1. Double-click a transition on the Timeline to open transition properties.

2. In the Transition Properties window, enter the new transition length in the Duration field. The format is seconds.milliseconds. If you want
all transitions that are currently in the project to have the same length, select the Apply to all transitions option.

3. Click OK to apply the changes.

Blur in-out X
Transition duration: 0 : sec.
Apply to all transitions
Fill transition with: Trimmed content 7
Freeze frame

Slow motion

Restore Defaults oK

Transition mode

In the Transition Properties window you can choose mode of transition. This setting affects what media is used to fill in the missing parts of
the transition:

Trimmed content - if you've trimmed the video, the trimmed bits will appear during the transition. If the videos haven't been trimmed, a
freeze frame is shown.

Freeze frame — a static frame is shown during the transition.

Slow motion - the part of the video overlapped by the transition is stretched to fill the entire duration.

The default mode is set to Trimmed content. The change of transition mode is more obvious when applied to a video clip rather than to an
image.

Add transitions to all clips
Using the Transition Wizard
You can automatically add transitions between all clips in your movie in just a few steps:

1. Click the slideshow button on the toolbar. The Create Slideshow dialog box will open.

2. In the Create Slideshow dialog box, select a transition style that you want to use for all clips. If you want to use different transitions,
choose the Use random transitions option in the list of transitions.

60



3. In the Transition duration box, enter the length that you want to set for all transitions. A transition cannot be longer than the shortest clip
in your project.

4. Click OK to accept the changes.

Transitions aeab,

Use this transition style for all clips:

Use random transitions

| Transition duration: 00:00:02.000 :

Image slide duration:

Using the right-click menu
To add one transition to all the clips in your project, right-click the transition's thumbnail and choose Add to All Clips from the pop-up menu.

Remove a transition

To remove a transition from your movie or slideshow, right-click the transition on the Timeline and choose Remove Transition from the pop-
up menu. If you want to delete all the transitions in your project, choose Remove All Transitions.

Transitions

Transition Properties
Play / Pause

Remove Transition

Remove All Transitio

Adding titles
How to add text to your videos

Adding text titles to your movie allows you to express your thoughts and supplement the audio with subtitles.

Step 1: Go to the Titles tab
On the left-hand side of the window, click the Titles button to view the titles collection.
* Click on a title style's thumbnail to preview its looks in the player and choose the titles you want to use.

« If you really like a title style, click the heart icon E on its thumbnail to add it to your favorites list.

Titles

Step 2: Add a title clip
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To add titles to your project, pick a title style you like and drag its thumbnail onto the title track of the Timeline, right above the video track,
onto the time where you want them to appear. The title clip will appear as a purple ribbon on the Timeline.

Note the purple line connecting the beginning of each title clip to a corresponding video clip on the video track. This way, whenever you move
or edit the video clip, its titles will always stay in sync.

Titl] = ﬁ
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To make several text clips appear simultaneously, simply place them one on top of another on the titles track.

Step 3: Edit titles

When you've added a title clip, it will start out with the default text and looks. Double-click the title's ribbon on the Timeline to show editing
options in the player.

Title clip properties

Click the cogwheel icon E at the top of the editing panel to see title clip properties. Here, you can change the duration of the titles and
animation speed (how fast they will appear or disappear).

Editing text
1. In the preview, double-click on the text box you want to edit.

2. Enter the new text.

3. Click the Font properties button and select the font style, size, and alignment options for the selected text.
4. Click the Color properties button and choose a color for the text, and the outline's width and color.

5. Drag the text box to where you want to see it on the video.

Editing decoration elements
Some titles come with frames, ribbons, and other decorations. To change their color, select the decoration element you want to edit and click

the Color properties button. Then, click the Decorations color palette and choose the new color.

Finally, click Apply to exit editing mode.

More options

T # 1

Duration: 0:00:06:000 % 7\ 0.1x =]

Accept changes

Animation speed

Move and rotate titles
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Hint: you can move several title elements by selecting them with the cursor or holding the Ctrl key and clicking on the elements you need.

See also:

Adding callouts
Adding a timer
Timeline tracks

Adding a timer

Step 1: Open the Titles tab
Click the Titles button on the left sidebar to open the list of available text styles.

Titles

Step 2: Add Timer titles

1. Find the "Timer" title style. Use the search bar or click the Basic group to filter the styles.

2. Drag the Timer titles onto the title track of the Timeline. Move the clip along the Timeline until its beginning is where the titles should
appear. To change the length of the timer, drag at the edges of the clip.
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Step 3: Edit the timer
1. Double-click the timer clip on the Timeline to edit it. A properties panel will appear over the player.

2. On the Clip properties tab E set the duration and the format of the timer. The format determines which units of time are visible on the
timer: hours (hh), minutes (mm), seconds (ss), and milliseconds (zzz).

3. On the Font properties tab , choose the font and style of the numbers.

4. On the Color properties tab , set the color of the numbers and the background color. To make the background transparent, click the
background color square and set Opacity to 0%.

5. On the Timer tab E enter the starting time into the From box. If you want the timer to count backwards, select the Countdown option.
6. In the player, drag the Timer to the necessary location on screen.

7. Finally, click Apply to exit editing mode.
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Saving custom titles
After you've set up titles to look the way you want, you can save that style and use it in your projects.

Step 1: Just like you usually edit titles, double-click the title clip and choose the font, color, and other options.
Step 2: Click the Save icon at the top of the title editing panel on top of the player.
Step 3: Enter a name for your titles and click Save.

The new title style will appear under the My titles group.

‘1};} T ,,"r 2

New titles: Yellow Ribbon|

Stickers
You can decorate your video and make it more fun by adding stickers on top of it.

Step 1: Open the Sticker collection
Click the Stickers button in the sidebar to open the list of stickers.
* Click on a sticker's thumbnail to preview it in the player
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« If you really like a sticker, you can click the heart icon E on its thumbnail to add it to your favorites list.
Hint: if you don't see the Stickers button in the sidebar, click the More button at the bottom of the sidebar and select Stickers from the pop-up
list.

Stickers
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Step 2: Add the sticker
Select the sticker's thumbnail and drag it onto the title track of the Timeline. All titles, callouts, and stickers go on the title track.

Stickers

[TLITTE0 1]

= g

Step 3: Edit the sticker

Change length
To change how long a sticker appears on the video, drag the edges of the sticker clip on the Timeline.

00:00:12 00:00:16 00:00:20 00:00:24
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Move the sticker

To change the sticker's position on your video, double-click the sticker clip to go into editing mode. In the player, drag by the corner of the
frame around the sticker to change its size, and drag by the center of the frame to move the sticker. To rotate the sticker, click and drag the
white dot at the top of the frame. Click Apply above the player when you're finished.
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Stickers

Double-click clip
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Frequently asked questions
Can | apply transitions to stickers?
No, you can't. Stickers always appear instantly on top of the video.

Can | animate stickers?
Sure! You can animate them like any other clip. Learn more: Animation

Adding callouts
Using callouts, you can annotate your video with arrows, icons, and other shapes.

Step 1: Open the Callouts tab

Click the Callouts button on the left sidebar to open the shape collection. To preview a callout style, click on its thumbnail.
+ Callouts are grouped into categories on the left. Use these to find the shapes you need.

« If you're looking for a specific callout, type its name into the search box under the list of groups.

« If you really like a callout style, click the heart icon E on its thumbnail to add it to your favorites list.
Hint: if you can't see the Callouts button, click the More button at the bottom of the sidebar and choose Callouts from the pop-up list.

Callouts

Step 2: Add callout clip
When you find a style you like, drag it onto the title track at the very top of the Timeline. Place the beginning of the clip where you want the

callout to start appearing. Drag the edges of the callout clip to change its duration.
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Callouts
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Note that the clip is linked to the corresponding clip on the main video track with a purple line. This means that the callout clip is
synchronized with the video: when you move or cut the video clip, the callout clip will follow without losing sync.

Step 3: Edit the callout
Double-click the callout clip. An editing panel will appear in the player. If the callout consists of several elements, for example, text and a
shape or two shapes, make sure to select the one you want to edit.

Position
In the player, drag the callout to where you want it to appear on screen.

Clip properties

+ On the editing panel, set the animation speed for the element to change how fast it appears on screen.

+ To change the callout's duration, enter it into the Duration box or drag the edge of the callout clip on the Timeline.
Colors

Click the Color properties icon and choose the color and outline for the selected element.

Text
« If the callout has text, double-click on the text box and enter the new text.

* Click the Text properties icon and choose the new font, size and style for the callout text.

When you're done, click Apply to accept the changes and exit editing mode.

o, Switch tabs for more options

Fill color: ] Outline: none * B Apply

Drag to rotate Finish editing

See also:
Title and callout track

Adding titles

Animation
With Movavi Video Editor, animating objects is simple and doesn't need any additional software. You can move or spin objects any way you
want, and make creative appearances.

Before you start:

+ Add the background onto the main video track.

+ Add the object you want to animate. This can be a video or image, text titles, callouts, or stickers. Place the videos or images to the overlay
track, and add the titles, callouts, and stickers onto the title track of the Timeline. Make the clip as long as you want the animation to last.
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Step 1: Open the Animation tool
In the left sidebar, click the Animation button. If you don't see it there, click the More button, and choose Animation from the pop-up list.

Step 2: Add Animation
1. Select the clip you want to animate and place the position marker to where you want the animation to begin.

2. In the Animation panel, click Add Animation.

Add Animation

+ In the player, you will see a frame appear around the object. You'll be using this frame to set the position of the object.

+ On the Timeline, two points will appear on the clip. These are called keyframes. The firstpoint is the original position of the object. The
second point will be its end position after the animation. The distance between the two points determines how fast the object needs to travel
between these two positions.

Beginning keyframe

Z @ Airplane

Ending keyframe

Step 3: Edit the keyframes
1. On the Timeline, double-click a keyframe to edit it.

2. In the player, use the frame to move the object to where you want it to go.

+ Drag by the corners of the frame to change the object's size.

* To rotate the object, drag by the white dot at the top of the frame or use the Angle box in the Animation panel. Note that if you want to
make the object spin, you can rotate it to a maximum of 180 degrees in a single keyframe.

+ To make the object fade in or out, use the Opacity slider in the Animation panel.
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Keyframe options
@ Animation

Angle: 37,1°

Opacity: .
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keyframe to edit

3. To change how fast the object moves, move the keyframe point on the clip:
* Move the points closer together to make the animation go faster.
* Move the points farther away from each other to make it go slower.

Step 4: Add more keyframes (optional)
To add another keyframe, move the position marker to where you want to place it in the clip and click Add Keyframe on the Animation panel.
If you add it between two existing keyframes, it will create an intermediate position.

Add Keyframe Add a new keyframe
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Set time for the
next keyframe

Resetting a keyframe
To make a keyframe go back to its original position, right-click the keyframe point on the clip and choose Reset Keyframe in the pop-up
menu.

Removing keyframes
+ To remove one keyframe, right-click the keyframe point on the clip and choose Remove Keyframe in the pop-up menu.
+ To remove all keyframes and delete the animation, right-click any of the keyframe points and choose Remove All Keyframes.

Pan and zoom

Using the Pan and Zoom tool, you can control camera movement using two keyframes. Set the beginning zoom and the end zoom using the
frames in the player, and the camera will smoothly move from one frame to the other.

Step 1: Open the Pan and Zoom tool

1. On the Timeline, select the clip that you want to zoom.

2. On the left sidebar, click the Pan and Zoom button.

Tip: If you can't see Pan and Zoom button, maximize the window, or click the More button at the bottom and select Pan and Zoom from the

pop-up list.
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Step 2: Add pan or zoom keyframes
1. On the Timeline, place the position marker to where you want the zooming to begin.
2. Select one of the zooming methods: Zoom in, Zoom out, or Pan.

Tip: To see how an effect works, select it and click Preview.
3. Click Add.

@ Pan and Zoom O

| 1. Choose one of the zoom effects

2. Add the selected effect

This will add two zoom keyframes to the clip. Using these keyframes, you can set up when the camera moves from one point to the other.
The camera will move between these two keyframes.

Step 3: Set up the zoom frames
Now, you can set the zoom level for each keyframe using the frame in the player, and the camera will smoothly move from one frame to the
other.

1. To change the starting keyframe, double-click the first point on the clip. Then, use the frame in the player to set the zoom level for the
starting point of the camera movement.

2. To change the ending keyframe, double-click the second point on the clip. Then, use the frame in the player to set the zoom level for the
ending point of the camera movement.
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2. Edit zoom level
with the frame
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1. Double-click
on a keyframe

Step 4: Change the keyframe time
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+ To change the length of the zoom effect, hold your mouse pointer over a keyframe and move it left or right.

+ To move the zooming effect without changing its length or other settings, hold your mouse pointer over the arrow and move it along the
clip.

Step 5: Add more zooming (optional)
If you want to add more camera movements, repeat steps 2-4 to combine other camera movements in one clip. For example, you can zoom
in on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

Removing zoom
To remove a pan or zoom effect, right-click a keyframe and select Remove All Keyframes to clear all zoom effects from the clip. To remove
just the selected keyframe, select Remove Keyframe.

Edit Keyframe
Reset Keyframe
Remove Keyframe

Remove All Keyframes

Stabilizing video
If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video, especially if you
walk or move while filming.

Step 1: On the Timeline, select the clip you need to stabilize. Longer videos take more time to stabilize, so you may want to first cut the
video into smaller segments.

Step 2: On the left sidebar, click the Stabilization button.
Tip: if you don't see the Stabilization button, click the More button and select Stabilization from the pop-up list.

Tools

Stabilize...

I -
i b

a
L e

Step 4: Set up stabilization with the following parameters depending on the video and the amount of shaking:

Accuracy: affects the analysis precision of the video. Higher accuracy yields the best results, but also takes more time.

71



Shaking: set how strongly the shaking is visible on the video.
If you need more advanced settings, click the arrow under the sliders.

Radius: when a video is stabilized, each object is adjusted using the pixels from the surrounding area. The radius affects how large that area
will be. Use a smaller value for more dynamic videos to avoid mixing objects together and to preserve more detail.

Smoothing: limits camera acceleration. Higher values work best for more or less static videos. Excessive smoothing may limit panning.

Edge Cropping: after compensating for motion, some distortion artefacts like blurred areas may appear around the edges.
* None: the edges will remain as they are. Best results if there is little shaking on the video.
* Fixed: the video is cropped to one size to cut off some of the edges.
- Adaptive: whenever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown.

Stabilization Original

Click to show advanced

Stabllize

Step 5: Click Stabilize to start processing the video. This may take a while depending on the length of your video and the selected
parameters.

Stabilization

Stabilize

Step 6: After the video has been stabilized, you will see its preview in the player. If you're satisfied with the result, click Apply to replace the
clip on the Timeline with the stabilized video. If you didn't like the results, repeat steps 4 and 5.

Stabilized copies
A stabilized copy of the file will be created under " \My Videos|Movavi Video Suite\Stabilized'. This copy will be used in the project instead of
the original video. If you delete the stabilized copy, it will be replaced with the original video, and you will need to stabilize the clip again.

Filming tips

* When shooting videos, try to rest the camera on something.

« If possible, use a tripod. Some tripods are really small and can fit into your bag.

« If you can't put down the camera, hold it with both hands and close to your body. This will minimize the shaking.
* Try to move around less. If you have to move the camera, do it slowly.

* Check your camera's settings to see if it has built-in stabilization.

Troubleshooting

Not enough disk space error

When a video is stabilized, Movavi Video Editor creates a stabilized copy of the video in a folder on your disk. By default, this folder is " |My
Videos\Movavi Video Suite\Stabilized' on your main disk drive. If you are running out of space on that drive, you can either free more space
and try again, or tell the program to save stabilized copies on another disk:

1. Open the Settings menu and choose Preferences.

2. Switch to the Files tab.

3. Find the "Store stabilized videos in" box and click the button ! on the right to choose a different folder on a drive where you have more
space.
4. Click OK to accept the changes. Now, try stabilizing the video again.

Cannot access folder error
This error means that you've changed the folder where stabilized files are stored, and that folder's permissions prevent Movavi Video Editor
from creating files inside it. Try using a different folder for storing stabilized videos.
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Highlight and conceal
Using the Highlight and Conceal tool, you can control the focus in the frame, and blur or darken parts of the video.

Step 1: Open the Highlight and Conceal tool
1. On the Timeline, select the clip that you want to edit.
2. On the left sidebar, click the Highlight and Conceal button. The tool's options will open, and a frame will appear in the player.

Tip: If you don't see Highlight and Conceal button, click the More button at the bottom, and choose Highlight and Conceal from the pop-up
list.

Tools

Step 2: Set up the mask

1. In the Highlight and Conceal tool, open the box and choose Conceal if you want to hide an object, and Highlight if you want to bring
attention to the object.

™|

7 @ Highlight and Conceal

Conceal

Highlight
SiZe: mmsl

n Outline:

Tools

2. Choose a shape for the mask: you can use a rectangle or an ellipse.

3. Choose a masking effect: blur, matte (black cover-up) or pixels. Use the options below to fine-tune the mask:
« Opacity — makes the mask more transparent (for matte and blur)

- Feathering — makes the edges of the mask softer (for matte and blur)

- Size — changes the size of the pixels (for pixel masks only)

* Outline — adds a white outline around the mask.

@ Highlight and Conce

1. Highlight

Conceal O O 3. Effect
or conceal

Opacity:

Feathering: 1

Qutline:

Apply

4. In the player, drag the corners of the mask to change its size and shape, and drag by the center of the mask to move it on top of the object.
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Step 3: Add more masks (optional)
If you want to cover up or highlight more than one object, click Add Mask above the player to create another mask, and you can now set it up
the same way as the first. The selected mask is highlighted orange in the player.

Add Mask Delete Mask

Step 4: Apply the changes
When you're done, click Apply on the Highlight and Conceal panel to finalize the changes.

O Tools
@ Highlight and Conceal

Conceal v
Size: | 10%

Outline: Apply

Chroma key
How to replace a video's background

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.

Step 1: Add the foreground and background clips
Add the video or image clips that you want to use as the foreground and the background. For the foreground (the clip that you want to
remove the background from), use a clip with a bright, solid background that contrasts with the foreground objects.

Step 2: Create an overlay

1. Select the foreground video and move it up, onto the Overlay track.

2. Double-click the foreground video on the Overlay track. The overlay options will appear above the player.

3. To make the foreground video completely cover the background video, select the Cover overlay mode from the list above the player.
4. Click Apply.
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Step 3: Open the Chroma Key tool

1. Select the foreground video on the Overlay track.

2. On the left sidebar, click the Chroma Key button. The Chroma Key options will appear.

Tip: If you don't see the Chroma Key button, click the More button and select Chroma Key in the pop-up list.

Step 4: Set up Chroma Key

1. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color
you've picked will be made transparent, and the underlying video will now be visible.

Tip: if nothing happens when you click on the player, click the color swatch in the Chroma Key options and then try again.

2. Use the Tolerance slider to set how many similar shades of the selected color should also be removed. Higher values will remove similar
colors to the one you've selected.

3. Use the Noise slider to determine how sharp the object's edges should be.

4. Use the Edges slider to determine how thick the object's edges should be.

5. Use the Opacity slider to set the transparency of the background.

6. Finally, click Apply to accept the changes.
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Tolerance:
Moise:
Edges:
Opacity:

Apply

11

Cropping the video

If the videos you're using for the foreground and background have different aspect ratios, you may end up with black bars or empty areas
along the edges after applying Chroma key. To fix this, crop the videos to the project's aspect ratio.

How to remove black bars

Cropping videos

Exporting videos
When you're done with your project, you'll need to export it as a media file to be able to play it back in media players, mobile devices, and so
on. This section will guide you through the process of exporting your project to a popular video format. If you want to find out more about
other ways of saving videos, see the following guides:
Saving only audio
Saving videos for devices
Saving videos for TVs
Uploading videos online

Step 1: Open the Export window
To start saving the video, click the Export button in the bottom right-hand corner of the Editor. The export settings window will open.

Step 2: Choose a format

In the new window choose a format for saving the video in. Some formats allow you to choose between video codecs. If you don't know
which format to choose, try using MP4 with the H.264 codec. The MP4 format is supported by most platforms and operating systems.

The Estimated File Size field shows how much disc space your file will require after saving. If the file size is too large, you can set a lower
resolution in the Project Settings. At lower resolutions, the file will be significantly smaller, however, the video will lose some quality due to
the limitations of digital data compression. When changing resolutions, we recommend that you keep the same aspect ratio to avoid black
bars around the video or other unwanted distortions.

The GIF format is different from other formats in the list. It allows saving video as a mute animated image, which can then be played in some
image viewing programs or in any web browser.

Learn more about project settings
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Step 3: Check your project settings

When saving standard video, the video will be exported with the same settings that were set for the project. This way, the output video will
appear exactly as you've seen it in the preview area. If you want to change the resolution, aspect ratio, or other settings, click the Advanced
button to view and edit the project settings. In the settings you can also choose to save a 60 FPS video*.

*The video file will have a frame rate of 60 FPS only if the original video files used in the projects had a frame rate of 60 FPS and above.

£ Advanced

Step 4: Select quality (optional)

If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate.

This will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small
file size.

®* Good High Highest

Step 5: Choose a destination folder
Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos

specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Explorer window, or enter the path
manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.
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Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.

Export only audio
This section will guide you through exporting just the audio track of your project.

Step 1: Open the Export window
Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

Step 2: Switch to the Save Audio File tab
In the left hand part of the Export window you will find a number of tabs. Click on the Save Audio File tab.
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£F Advanced

Step 3: Choose a format
Select the format you'd like to save the audio in.

While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high
audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the
original files: due to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC
audio, and vice versa — high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.

When saving audio from your project, the audio file will retain the same sample rate and channel settings as you have set for your project.
The audio bitrate will be determined from the quality of the original files and from the maximum bitrate for the selected format (for example,
MP3 is limited to 320 Kbps, while FLAC bitrate is not limited).

Step 4: Name your file and choose a destination folder

In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Explorer window, or enter the path
manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.

Step 5: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.

Export for devices
This guide will help you export your video project for playing on mobile phones, tablets, and other devices.

Step 1: Open the Export window
In the bottom right hand corner of the Editor, click the Export button to open the export settings window.
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Step 2: Switch to the Save for Devices tab
In the left hand part of the Export window click on the Save for Devices tab.

Step 3: Choose a format

On this tab you will find a number of different types of devices for which you can choose a format. You can choose between devices running
iOS (iPhone, iPad, iPad mini) or Android, Samsung Galaxy S6 and Galaxy S7, Google Nexus 6 and Google Pixel, as well as Playstation and
Xbox consoles. If your device is not on the list, choose Other.

Step 4: Set export quality (optional)

If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate.
This will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small
file size.

In the Advanced section you can view the properties for the output file. Due to the limitations of some devices, the video resolution, audio
quality, and other properties may be changed to adhere to the requirements of the selected device. Estimated File Size will give you a rough
estimate of how much disk space the file will occupy, which may be important if your device is running out of memory.
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®  Good

Step 5: Name your file and choose a destination folder

In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Explorer window, or enter the path
manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.

Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.

Export for TVs

This guide will help you export your video project for playing on Smart TVs.

Step 1: Open the Export window
In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Step 2: Switch to the Save for TVs tab
In the left hand part of the Export window click on the Save for TVs tab.
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£ Advanced

Step 3: Choose a format
Choose your TV brand and the necessary resolution. If your TV is not on the list, choose Other 1080p TVs or Other 4K TVs.

Step 4: Set export quality (optional)
Project settings: If you've been using the default project settings, your video's resolution is now 720p. To avoid losing quality when saving to

a larger resolution, open the Advanced window and edit the project settings. There, choose the 1920x1080 resolution for 1080p HDTVs, and
the 3840x2160 resolution for 4K Ultra HD TVs.

Quality: If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher
bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at
a small file size.

{:l‘ Advanced

]

Toaluhe

Step 5: Name your file and choose a destination folder

In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Explorer window, or enter the path
manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.

Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.
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Uploading online
After you finish your video, you can share it to YouTube and Google Drive right from the export window.

Step 1: Open the Export window
Click the Export button to open the exporting window.

Step 2: Switch to the Upload online tab
In the left hand part of the Export window click on the Upload to Youtube tab.

Step 3: Choose a service to upload to
On the Upload online tab select the service you would like to upload your videos to: YouTube or Google Drive.
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Step 4: Sign in to your account
1. Click Sign in. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Video Editor upload videos.

Google

Hi gy bwsrya
i

This will allow Movawl Video Suite to:

B Manage your YouTub=s account 6]

B Manage your YouTube videos I:ZJ

Make sure you trust Movavl Video Suite

e m

Step 5: Choose a resolution

In the Export window, open the Resolution list and choose a resolution that suits your project.

* For best results, choose a resolution that is equal to or less than the height of your project. You can find the resolution of the project at the
bottom of the main window, next to Project settings. For example, if your project is 1280x720, choose the 720p resolution.

* This resolution will be the highest quality available for your video. Lower resolutions will be generated automatically by the website.

Step 6: Fill in the details (YouTube)

1. Fill in the title and description for your video.

2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (#) before each one.
3. Choose a category to help viewers find relevant content.

4. Open the Privacy box and choose who you want to see the video:

* Private — videos can only be seen by you and the users you choose.

* Public — videos can be seen by and shared with anyone.

* Unlisted - videos can be seen and shared by anyone with the link.
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Step 6: Fill in the details (Google Drive)

1. Fill in the title for your video.

2. Select a Google Drive folder where you want your video to be uploaded. You can create new folders in your Google Drive storage straight in
the export window.

3. Open the Privacy box and choose who you want to see the video:

* Private — videos can only be seen by you and the users you choose.

* Unlisted — videos can be seen and shared by anyone with the link.

* & GoogleDrive

- My videos

Create folder %
<

Step 7: Save and upload the video

1. Before uploading, the video will be saved as a file on your computer. To change where the video file is stored, click Browse and select a
folder.

2. Click Start to begin saving and uploading the video.

*YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to verify your account.
YouTube help — increasing your upload limit &

ame\Videos\Movavi Library ¥

See also:
Sharing preferences

Editor preferences
To open the preferences:
1. Click the Settings menu
2. Select Preferences.

The Preferences window will open. The preferences are organized into tabs. Click on a tab to open the relevant options.
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General Sharing Acceleration

Interface language:

English

' Automatically check for updates

+ Show startup window when creating new project

Send anonymous usage stats to Movavi

Use software OpenGL implementation

Play notification sound when exporting is finished

When you're done, click OK to close the window and apply the preferences.

See also:

General preferences

File preferences
Acceleration preferences
Sharing preferences

General preferences
Interface Language - to change the interface language, simply select the necessary language from the list and click OK to apply the
changes.

Automatically check for updates — select this option and you'll be notified whenever a new version is available. Updates within your version
are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.

Show startup window when creating new project — with this option enabled, you will be prompted to select settings for the new project on
startup and when creating new projects. You can choose the project's aspect ratio and other settings, as well as open an existing project.

Send anonymous usage stats to Movavi — checking this box will allow the program to send usage statistics to our development team,
enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no
personal information, will not be disclosed to third parties and will be used for software improvement purposes only.

Learn more about how we use the statistics

Read our Privacy Policy

Use software OpenGL implementation — this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

If the Video Editor runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting

Play notification sound when exporting is finished — when saving a project as a media file, you'll be notified as soon as the process is
completed.
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Sharing Acceleration

English
' Automatically check for updates
Show startup window when creating new project

Send anonymous usage stats to Movavi

oftware OpenGL implementation

Play notification sound when exporting is finished

File preferences
On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different
location.

Save project files to - this folder will by offered by default when saving and opening projects. This folder will also store any autosave files
for new projects. You can use the autosave file to restore your work in case of an error or force close.

Save output videos to — this folder will be offered by default when exporting media files.

Store audio recordings in - the audio clips that you record in the Editor will be stored as audio files in this folder. 7ip. /f you delete these
audio files, the audio recordings in the project will also be unavailable.

Store stabilized videos in — when you stabilize a video, a stabilized copy of the original will be created in this folder and used instead of the
original. 7ip: don't delete these files while you are working on the project, or you'll have to stabilize the files again.

Files Sharing Acceleration
ave project files to:

Store audio recordings in:

arnameyMusiciMovavi Video Suite\Recorded Audio

Store stabilized videos in:

deo Suite\Stabilized

Cancel

Changing where the files are stored
Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in
another way.

1. Click the button with three dots - next to the folder you want to change.
2. A Explorer dialog box will open. Choose the folder you want to save the files to.

3. Click Select Folder to use this folder.

Acceleration preferences
If your computer is equipped with the necessary hardware, these options can help speed up encoding and decoding of media files, allowing
you to save your movies much faster and enjoy smoother performance.
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Files Sharing Acceleration

intel® HD
Graphics

Enable Intel® hardware acceleration

= NVIDI&
Cr
S NVENE

v Optimize HD clips

ore temporary optimization files in:

ina‘\Wideos\Movavi Video Editor\Preview Fi

Enable Intel hardware acceleration
+ Accelerates video processing by up to 400% when working with H.264 and MPEG-2 video codecs.
* This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics ™technology.

Enable NVENC hardware acceleration

+ With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50%
faster.

+ Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.

« This option is only available if your computer is equipped with an NVIDIA graphics card that supports this technology.

Fast Track HD Acceleration

Fast Track HD Acceleration provides smooth and fast program running. By enabling HD clips optimization in the Preferences menu you allow
the video editor to create copies of the project files in a smaller size and then use them in the project instead of the original ones. To enable
this feature you need to have free disk space, so the Editor can store and use the copies. Once you finish editing and begin export, high-
quality files will replace all the temporary optimization copies.

Troubleshooting

If acceleration options are unavailable:

* Your computer might not have the right hardware.

« If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: Intel Download Center | NVIDIA Driver Downloads

Intel HD Graphics is a trademark of Intel Corporation.
NVENC is a trademark of NVIDIA Corporation.

Sharing preferences
On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.

To signin:
1. Click Sign In. The authentication page will open in the browser.
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General Sharing Acceleration

(11| Tube

L‘ Google Drive

2. Sign in to your account.
3. On the next page, allow Movavi Video Editor to upload videos to your account.

Google
Hi el
0

Mowvavi Video Suite wants to

) anage your YouTube account

© ©

) Manage your YouTube videos

Allow Movavi Video Suite to do this?

4. Return to Movavi Video Editor. Your name will be shown in the Preferences window.

To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.

Sharing Acceleration

Y[]I] TUI]E Sign Out._.

™ Google Drive Sign Out...

You are signed in as

Convert files
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Using the Converter application, you can change the format of video, audio and image files, convert files to play on devices or prepare files
for uploading online.

@ Movavi Video Suite 18

. - Edit wideo
Convert video

N Capture from cameras, VHS, TV

apil video E t‘

7y CONVERT

What can | do with the converter?
Convert video files to a different format
Convert videos for watching on devices

Convert videos for uploading online
Convert audio files
Change image format
Create a GIF from a video

How to use the converter?

Step 1: Open the Converter app Step 2: Add files
Use the buttons at the top to open the files you want to convert.
Step 3: Choose an output format Step 4: Edit and choose conversion options
Select the format you want to convert the files to. Make changes to the files before conversion.
Audio tracks
Subtitle tracks

Reduce size

Step 5: Choose the output folder Step 6: Convert!
Select the folder where the newly converted videos will be stored. Click the Convert button to start processing the files.

Open the converter
To open the conversion app:

In the Movavi Video Suite launcher, click Convert video on the Video tab.

& Movavi Video Suite 18

® video

Edit video
Audio
Convert video

Photo

Record computer screen

Extras N Capture from cameras, VHS, TV

User Guides B
Split video

Watch video

In the Movavi Video Suite launcher, click Convert audio on the Audio tab.
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& Movavi Video Suite 18

Video

g Audio Convert audio

Photo
|

Record sound

Extras : -
Burmn audio to CD

User Guides

Play music

In the Movavi Video Suite launcher, click Convert images on the Photo tab.

& Movavi Video Suite 18
Video
Audio

Convert images

Photo

Create slideshows

Extras

User Guides

Share photos online

Converting video

Step 1: Open the converter app
In the Movavi Video Suite launcher, click Convert video in the Video tab. The Movavi Video Converter application will open.
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& Movavi Video Suite 18

(® video

Edit video
Audio

Convert video
Phaoto

Record computer screen
Extras T Capture from cameras, VHS, TV
User Guides

Split video

Watch video

Step 2: Open the videos

Before you start, you will need to open the videos in Movavi Video Converter.

1. Click the Add Media button at the top and choose Add Video from the pop-up menu.
2. A Explorer dialog box will open. Select the files you want to convert.

3. Click Open. The files will now be added to the file list.

+ Add Media
E Add Video

"',' Add Audio...
E Add Images

& add DvD

= Add Felder...

) CONVERT

Step 3: Choose output format

In the lower half of the window, you will find a list of output formats.

1. Click the Video tab.

2. Click the format you want to use. For example, MOV.

3. Choose the preset with the codec and resolution that you want to use. To convert without changing the resolution, click the line marked
"Same as input'. For example: '"MOV', or "AVI MPEG-4 - Original size”

Customizing presets
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Step 4: Edit and trim video

If you want to edit one of the videos, click the Edit button next to it to open the Editor window.
Choosing audio tracks

Choosing subtitle tracks

Trimming files

Fretd.mpd ubkities
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W SuserSpeed comverssn supsored
taght Shoympd
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) CONVERT

Step 5: Check output folder
At the bottom of the window, check the Save to box. This is where the output files will be saved. To use a different folder, click the folder icon

E and select the new output folder.
Changing output folder

Frold mgd f Q Mo subatles
*-::- D 20 Ml - LOF MD (regh guality) [- Y Kbpd Sterec

] Iréeh secsberation i in use
Hight Sky.mp4 # B no subtities
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) iraniey sccmderation e e 0 Low

mpr4 AVI .g Q DVD HEVC JA4K

m' tput format: Custom * 4 Save to... ripe fiees ) CONVERT

Finally, click the CONVERT button to start processing the videos. This may take anywhere from a few seconds to several hours, depending
on the size and number of video files.
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Converting for social networks
Social networks like YouTube or Facebook don't accept all video formats. Follow the steps below to convert your videos to a format
compatible with the social networks.

Step 1: Open the videos
1. Click Add Media and choose Add Video from the pop-up menu.
2. A Explorer window will open. Choose the videos you want to convert and click Open. The videos will be added to the file list.

=+ Add Media

E Add video

:: Add Audio.,..

E Add Images
(& add pvp
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Step 2: Choose a social network preset

1. In the lower half of the window, click the Video tab to show all video formats.

2. Use the arrow on the right to scroll through the list and click the Online Video group.

3. Choose the social network and resolution that you want to use. This will set the optimal format and codec settings for uploading to this
social network.
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Step 3: Convert and share

1. Click the folder icon E next to the Save to box to choose where the output files will be stored.

2. To share the videos right away, click the Upload to button and choose the services that you want to upload videos to.

Note: to upload videos, you will need Movavi Share Online, a free add-on that you can use for batch uploading. If Share Online is not installed,
you will be prompted to download and install it .

Pexjriar v A

E YouTube - HD Frop O

3. Finally, click CONVERT to start converting the videos.

4. If you've selected sharing options, the files will open in Share Online as soon as conversion has finished. There, log in to the services,
provide a title and description for each video and click Upload.

E.' Add File I-' Add Falder Clagr List “ﬂ Prafarances ? Helg

B | Fie Name Size File Info
B Japan.mp4 6957 MB Not uploaded X
[+ E Summer.avi 12.24 MB Not uploaded 4

Title: summer

Length: 0i:30
Size: 12.24 MB

Description: | My amazing summer!

Tags: vacation, nature, summer, fun
(™ — YouTube

Film & Animation |:|

Upload to

Converting for the web
To upload a video online, whether to a personal website or to a video hosting service, you will need to do two things: convert it into a suitable
format and upload it onto the web.

Step 1: Open videos

1. Click the Add Media button and choose Add Video from the pop-up list.

2. A Explorer box will open. Select the files you want to convert and click Open.
How to open videos
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Step 2: Choose a web preset
1. Click the Video tab for video output formats and presets.

2. Use the arrow on the right to scroll through the list and click the Web-Compatible Video group.
3. In the pop-up list, choose the format and resolution that you want to use.

Fradel s # O Nosubtitles

. D AT Ml [(Good auakty] BM ALC 125 KBpa Stereo

[l it W meeelers
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Output format: FLV = 640x480 ©F

Step 3: CONVERT and upload

Check the Save to box to see where your web-ready files will be saved. To change the folder, click the folder icon E When you're ready,
click CONVERT to start processing your videos. When conversion is finished, you can start uploading your files to your blog or website.

Converting DVDs

The era of the DVD disc is coming to an end, and not all homes now have a DVD drive. Make your favorite movies future-proof by backing
them up to your computer.

Step 1: Open DVD

1. Insert the disc into your DVD drive. If you have an external DVD drive, connect it to the computer.
2. Click Add Media in the upper left-hand corner of the window.
3. Hold your mouse pointer over Add DVD.

4. Click the disc name in the menu that appears. If you don't see the DVD in the list, click Open DVD and find the DVD location.
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Tip: some DVDs are protected from illegal copying and cannot be converted. Movavi Video Suite is not intended for copying protected media.

Step 2: Choose video format

1. In the lower part of the window, click the Video tab to see a list of video formats.

2. Choose the group with the format you like.

3. Click that format and pick a video resolution. To convert with the original resolution, choose the line marked with ‘Same as input’.

# D o subtitles
B AAC 125 Kbps Sterea
by
MP4 H.264 - 640%480 Hht St 2| @ v sibities
NP BDoAB0 H264 Acto B 7me (original) &M AAC 125 Kbps Storeo

0 Low

MP4 H. 254 - I:lr'u_'||r|._=|l Sire VBR

L] Sama & input H._ 264 Auto

MP4 H.264 - Original SiFe

) CONVERT

Step 3: Choose files and streams (optional)
Many DVDs come with bonus clips, as well as a number of subtitle tracks. Select just the files you need to save disk space:

Bonus files
To remove bonus files that you don't need, click the ® icon to the right of the video.

Audio tracks

1. Find the audio information in the right-hand part of the file list and click on it to open the list of audio tracks.
2. Deselect the audio tracks that you don't want to keep.

Learn more about audio tracks

Subtitles

1. Find the subtitle information in the right-hand part of the file list and click on it to open a list of available subtitles.
2. Choose the subtitle track that you want to keep.

Learn more about subtitles
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Step 4: Convert

The Save to box at the bottom shows where the DVD movies will be saved after conversion. To save the files to a different location, click the
folder icon and choose the new destination folder. When you're ready, click CONVERT start processing the videos.

¥ ool
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Pight Sy gl
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Creating GIFs from videos
Step 1: Open a video

1. Click Add Media in the upper left-hand corner of the window and choose Add Video from the pop-up menu.
2. Find the video you want to turn into a GIF and click Open.

=+ Add Media

& add video

J3 Add Audio...

[E] add Images

& add DvD

i Add Folder..

7y CONVERT

Step 2: Trim the video

Usually, GIFs are pretty short, which means you'll need to trim the video to show just the important part.
1. Click the Edit button next to the video in the file list to open the Editor window.
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2. In the player, place the position marker to the beginning of the fragment you want to keep and click the scissors icon. This will cut the
video into two parts.

3. Move the position marker to the end of the fragment and click the scissors again.

4. Select the part you don't want to keep and click the trash can icon to delete it. Do the same for the other part you want to cut off.

5. Click Done to finish trimming and close the editor.

Learn more about trimming files
[

] (%

Step 3: Choose GIF format

1. In the lower half of the window, click the Images tab to see image formats.

2. Click GIF to see GIF conversion options.

3. Choose a size for your animated GIF. For example, "Medium GIF".

4. (Advanced) To change the frame rate, click the Customize button next to the output format at the bottom to customize the selected
preset. In the settings window, choose the frame rate you need and click OK. Higher frame rates will make the movements seem smoother,
but will increase the GIF's file size.

# T No subtities
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Step 4: Save the GIF
Take a look at the Save to box at the bottom of the window: this is where the finished file will be created. To choose a different location, click

the folder icon E and select the new output folder. Click CONVERT to save your animated GIF.

Convert for devices
How to convert video for devices

Each device has specific requirements to the type of video it can play, with some older devices supporting only a handful of video formats.
To make sure you'll be able to watch the videos on your device, convert them using the output preset created specifically for your device, and
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all the necessary output settings will be selected automatically. This way, you don't have to look for what formats your phone supports, as it's
all selected for you.

Find your device automatically

If you're converting for a smartphone or tablet, connect the device via USB, and the converter will automatically detect it and recommend the
best output format.

Learn more

Step 1: Add files
Open the files you want to convert.

Step 2: Open the Devices tab
In the lower half of the window, click the Devices tab so see a list of device presets.

Field.mpd

o> [ 23 M8 (Original)

b
Faght Sky.mpd

> [ 7 M (Cnginal)
Y SuserSpeed soveruen uzparted

HLUAWE]

) CONVERT

Step 3: Find your brand

In the Devices list, use the arrows on the left and right to scroll through the list and find your device's manufacturer and click on it to see a list
of device models.

If you don't see the device's brand in the list, try the search bar, or use a general category, such as Android, TVs, or Tablets.

Android - 1920x1080

MPd 1970w I0BD  H.Z64  ARC

Android - 2560x1440

MEs 2380 L 480 H_ZE4 A

Andrgid - 3840x2 160

iz 160 H.T64 AAC

HLIAWEI

) CONVERT

Step 4: Find your device

Choose your device from the selected brand's list and click on it to select it as the output format. Now, the format, codec, and resolution is
automatically selected to be optimal for your device.

Step 5: Convert

Click the folder icon E next to Save to to select where you want to save the videos, and then click CONVERT to start processing the files.
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After the videos are ready, all you need is to upload them to the device.

* A preset is a pre-made configuration for a specific device that contains all necessary media properties required by this device.

Device recognition
Converting videos for devices such as smartphones and tablets is quick and easy: all you need to do is connect the device and the program
will suggest the recommended format and resolution for it.

Step 1: Add files
Drag the files you want to convert onto the converter window.
How to open files

Step 2: Connect the device
Connect the smartphone or tablet to your computer using a USB cord.

Step 3: Confirm the device

1. Once the device is recognized, a dialog box will appear with the device name and the recommended preset. Check that the device name
matches your device. If the dialog box doesn't appear, click the Device Detection button to the right of the search bar.

2. If the device is correct, click Use These Settings to use the recommended output format, resolution, and other parameters.

Frold mgd # D hosubutias

o D 20 Ml (el B ASC 135 KBhpa Stered

Android - 1280x720
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Several devices are listed

Sometimes, the device detection box shows a list of several devices. This can happen if you have more than one connected device, or with
some devices that are very similar and can't be identified precisely. In this case, open the Choose your device list and select the device
model that you want to convert for. Then, click Use These Settings to use the recommended format, resolution, and other settings.

Device was not detected

« If the dialog box does not appear, try clicking the Device Detection button to the right of the search bar.

* Try reconnecting the device and wait for the system to detect it.

« If that doesn't help, you can still find a preset for your device manually on the Devices tab. Detailed instructions

The wrong device was detected

If the dialog box shows the wrong device, and that device isn't also connected to your computer, you can still find it manually on the Devices
tab of the preset list. If you want to report this mistake, write to us at support@movavi.com and tell us your device model, and which device
was shown instead.

Detailed instructions
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Step 4: Convert!

1. Click the folder icon E next to the Save to box and choose where to store the files after converting.
2. Click CONVERT to start converting the videos for your device.
3. After conversion has finished, upload the videos to your device and enjoy.

ra Q) Mo subbies
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Disabling device detection

If you don't want to use device detection for any devices:

1. Click the Settings button and choose Preferences.

2. In the Preferences window, disable the "Recommend output format for connected devices" option.
3. Click OK to apply the changes.

General Conversion Acceleration
Language:
English
Automatically check for updates

ats to Movavi

Recommend output format for connected devices

se software OpenGL implementation

|
|
|

Save extended logs for troubleshooting

Disabling detection for one device

If you don't want the device detection window to appear whenever you connect a specific device:
1. Connect the device and wait for the Device Detection window to appear.

2. Select the "Don't show when | connect this device" option and close the window.
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It looks like you've connected a device. Do you want to
use the recommended settings to convert for this device?

Device: Google Galaxy Nexus

Android - 1280x720

B Don't show when I connect this device

Uze These Settings

Converting audio
Even though MP3 is the most commonly used format, you may also encounter other formats, such as AAC or FLAC, which can preserve
audio quality better, but aren't supported by all devices. Converting audio will not only let you play music on any device or player, but also
organize and compress your media library.

Step 1: Open music

1. Click Add Media in the upper left-hand corner.

2. Click Add Audio in the pop-up list.

3. A Explorer dialog box will appear. Choose the audio files you want to convert.
Or simply drag the audio files onto the converter window.

EI Add Video
J3 add audio...
[E] add Images
(® add DvD

i Add Folder...

Audio
G @G P A fac e (@)
m Owtput farmat Save to., ~ Merge fbes ) CONVERT

Step 2: Choose audio format

1. In the lower part of the window, click the Audio tab to see the list of audio formats.

2. Click the format you want to convert the audio to.

3. Choose the bitrate that you want to use. To convert without changing the bitrate, choose the preset marked with “Original bitrate'.

Bitrate — the bitrate reflects the amount of data in kilobits that is played back each second (measured in kbps). Higher bitrate usually means
higher audio quality as well as larger file size, as extra data needs to be stored within the file. For audio presets, the bitrate is listed next to
the format. When you convert a file to lower bitrate, the extra bits of data are irretrievably lost, meaning that you cannot increase quality by
converting audjo to a higher bitrate, because the file no longer contains the data that can be used to restore higher quality.
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Step 3: Edit audio (optional)

Rename file

Renaming media files helps keep the music library in order.
1. Click the pencil icon Ed next to the file you want to rename.
2. Enter the file's new name.

3. Click OK.

Renaming files

Normalize and manage volume

If some of your music files are quieter than others, you can normalize their sound so you don't have to adjust the volume every time you
listen to them.

1. Click the Edit button next to the file you want to normalize.

2. The Editor window will open. There, switch to the Audio tab.

3. Adjust the volume level or select the Normalize volume option.

4. Click Done.

Adjusting volume

Step 4: Convert and upload
1. To change where the files are stored, click the folder icon E next to the Save to box and choose the output folder.
2. If you want to upload the music to iTunes after converting, click the sharing button H at the top of the window and select iTunes from

the pop-up window.
3. When you're ready, click CONVERT to start the audio processing. Your files will be ready in a few minutes at most.
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Converting images
Most applications and web services are limited to just a few image formats, and working with rare formats usually requires expensive
software. Convert images to be able to use them wherever you like!

Step 1: Open images
1. Click Add Media in the upper left-hand corner of the window.

2. Click Add Images in the pop-up menu.
3. Choose the images you want to convert and click Open.

] add video
J1 Add Audio...
E! Add Images
Add DVD

B Add Folder..

Images

GIF PNG BMP TiFF g

) CONVERT

Step 2: Choose format
1. In the lower half of the window, click the Images tab to see a list of image formats.

Chouds. g
mp> [ 77 KB [Good quality)

Kitten. jog

mp> [ 80 KB [Good quality)

Tt ipg
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% CONVERT

2. Click the format you want to use.
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Hint: not all formats support transparency. If the images have transparent areas, choose the PNG or BMP format.
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Step 3: Edit image (optional)
You can quickly fix or improve any images before converting. To do that, click the Edit button next to the image you want to adjust.

Kitten. jpg

> [ 80 kB (Good quality

GIF PNG

) CONVERT

Learn more: Applying a watermark | Enhancing colors | Cropping videos and images

Step 4: Resize images (optional)
To batch resize the images:

1. At the bottom of the window, click the cogwheel icon E] next to Output format.

2. Click the box under Frame size and choose a size that you want to use for all images, or choose any of the following and enter the size
into the width and height boxes on the right:
Custom: scales the images to exactly the size you specify.
Smart fit: scales the images up or down as close as possible to the specified size without changing the proportions.
Up to size: scales the images down as close as possible to the specified size without changing the proportions. Images smaller than
this size will remain unchanged.

To allow changing the image proportions, click the link icon next to the width and height boxes: H - locked, H- unlocked.
3. If the new size is different from the original image proportions, choose a resize method for your images:

Letter box — unused space will be filled with black.

Stretch — the image will stretch to fill the entire area.

Crop - the image will be resized to fill the entire area, and overflowing edges will be cut off.

4. Click OK to accept the changes. If you want to preview the result, click the Edit button next to an image.
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Step 5: Convert

1. Check the output folder in the Save to box. To change where the files are saved, click the folder icon E next to it.
2. Click CONVERT to start processing the images.
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Opening media
To begin converting media files, you will first need to open them in Movavi Video Converter.

1. Click Add Media at the top of the window.
2. Click one of the buttons to open files of that media type.

3. A Explorer window will open. Find the files you want to convert and click Open to add them to the queue.

&1 Add video
"': Add Audig...

[=] Add Images
Add DVD

B Add Folder...

MO e 1

) CONVERT
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Drag and drop from Explorer
Or simply drag the files from any Explorer window onto Movavi Video Converter to add them to the queue.

File list
After you have opened the files, they will all appear in the file list. Here, you can view information about the files, choose audio and subtitle

tracks, and manage the output file.

On the left, you can see the file's media information, and on the right you can manage the output file's name, media streams, and edit the file.
To remove a file from the list, click the X button on the right: x

Frakd. jig

wp> [ 24 K0 (Good quakty)

Might Skoy.jog

ap> [ 24 KB (Good quakty)

Media streams

Every media file is made up of streams for each data type. A video can contain a video stream, a couple of audio streams, and several
subtitle streams. When converting files, you can find the information about these streams in two columns on the right. Here, you can manage

the streams that end up in the output file.
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Compress video

You can compress a video to reduce its output file size by sacrificing some of the quality. To do that, click the output file size and move the
slider to the necessary file size while keeping an eye on the quality.

Compressing videos

Choose audio tracks

If a file comes with a number of audio tracks for different languages, you can keep just the ones you need. To do that, click the audio stream
and deselect the audio tracks that you don't want to keep.

Choosing audio tracks

Choose a subtitle track

When you convert videos, you can permanently overlay subtitles on top of the video. To do that, click the subtitle stream and choose or add
the subtitle track that you want to use.

Choosing a subtitle track

Information about the original file

To find detailed information about the video and audio streams of the original file, right-click anywhere on the file and choose File
Information from the pop-up menu.

Media information

Choosing audio tracks
It isn't uncommon to find videos with several audio tracks, whether it's a different language or a director's commentary. Removing tracks you
don't need will reduce the output file size.

Step 1: Open audio track list
In the rightmost column of the file list, click the audio track information box. The audio track list will appear.
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Step 2: Choose audio tracks

In the box with the audio tracks, deselect the audio tracks that you don't want to appear in the output video. If you want to completely remove
audio from the file, select the No Audio option. You can remove audio from all the files in the list by checking the Apply to all files box. You
can also apply an audio track to all files.
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Note: not all formats support multiple audio tracks. The table below shows the maximum number of audio tracks for each format:

o Fomat " Numberof audio racks supported

3GP 1
AVI 16
DVD 8
FLV, SWF 1
MKV 16
MOV 16
MP4 16
MPEG-1, MPEG-2 16
oGV 1
WebM 16
WMV 16

Choosing a subtitle track
When you convert videos, you can permanently overlay any subtitle track onto the original video. This can be useful if you're watching videos
on a device, or your player doesn't support subtitles.

Step 1: Open the subtitle list
In the rightmost column of the file list, you can see the subtitle and audio track information for each file. Click the information next to the

subtitle balloon = to open the list of subtitles.
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Step 2: Choose a subtitle track
In the subtitle list, click the subtitle track that you want to use. You can choose soft or hard subtitles.

Softsubs are stored as a separate track and you can add several subtitle tracks to one file. All the subtitle tracks will be saved if you choose
this option.

Not all formats support softsubs. There are also less editing options: you can't change position and synchronize them with video.

Hardsubs are permanently drawn on top of the video and cannot be turned off, but they are guaranteed to be visible in any player.
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Adding subtitles from file
To add your own subtitles that aren't stored inside the original file, click the Add button above the subtitle list and then open the subtitle file
that you want to add. You can use *srt, *ass, or *ssa subtitle files.

Subtitle encoding
If the subtitle text looks scrambled, open the Subtitle encoding box and try setting the encoding with the right language.

Applying a subtitle track to all files
Choose a subtitle track and select Apply to all files. This function works only in case you have files with the same quantity of subtitle tracks,
for example, it is a series.

Q English [English] (S54)
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Step 3: Preview the subtitles

Click the Edit button to see how the subtitles appear on the output video. For more subtitle editing options, click the Subtitles tab, where you
can edit the subtitle position and timing.

Editing subtitles

Extract audio from video
You can quickly save your favorite song from any movie by converting the video to an audio format.

Step 1: Open the video
Open the video file that you want to extract the soundtrack from.
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Step 2: Trim the file

If you only need a short part of the soundtrack, you can cut off the rest of the file:
1. Click the Edit button next to the file to open the editor.
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2. On the Trim tab, use the scissors button to cut before and after the fragment you want to keep.
3. Select the fragments you don't want and click the trash can icon to delete them.

4. Click Done to accept the changes and close the editing window.

Learn more about trimming

Now, the output file will only contain the part you've selected.

Step 3: Choose an audio format
1. Click the Audio tab in the lower half of the window.
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2. Click the audio format you want to use.

« If you're not sure, use the MP3 format: it is supported by most players and allows for a decent quality.

« If you want to convert audio with multichannel sound, you can use WAV, OGG, or FLAC formats.

3. Choose the necessary bitrate (quality) from the pop-up list. Choose Original bitrate if you want to keep the original quality.
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Step 4: Convert
Click CONVERT to save the selected audio fragment.

Compressing videos
Compressing videos can help reduce the size of the output file by reducing their bitrate. When you compress a video, it loses some of its
original quality, but even a small bitrate reduction can make the file significantly smaller.

Step 1: Add files
Open the files you want to compress.

Step 2: Choose the output format
The video's format and resolution play a very important role in the output file size.

1. Click the Video tab to see a list of video formats.
2. Click the format you want to convert the videos to.
Hint: Some formats and codecs compress video better than others. If you're not sure which format to choose, use the MP4 format with the

H.264 codec for the best size to quality ratio.

3. From the format list, choose the resolution that you want to use.
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Choosing the resolution

A video's resolution is the number of pixels in every frame. A higher resolution can preserve more information and quality, but it also requires
more disk space. Select a slightly lower resolution if the video is very large. For example, you can convert 1080p videos to 720p.

Learn more

Step 3: Compress video
1. In the file list, check the file's output size in the second column from the left.

2. Click the file size information to show compression options. There, drag the file size slider to the necessary file size while keeping an eye
on the quality below.

3. Click Apply bitrate to all files in the compression box if you want to unify quality of the files.
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Step 4: Convert
Click CONVERT to start processing the compressed file.

Media information
In the leftmost column of the file list, you can see the general information about the file, including its original size, video codec, resolution,
and bitrate.
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To get more details, right-click the file and choose File Information from the pop-up menu. Here, you can see all the information about the
original file's video and audio streams.
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Choosing output format

After you've added media files, it's time to choose the output format for converting all of the files in the list. Follow the steps below to choose
a video output format.

Step 1: In the lower half of the window, click the Video tab to see a list of video formats.
Step 2: Click the video format that you want to convert the files to. A list of presets for this format will appear.

Step 3: Choose the video codec and resolution that you want to use.
To convert without changing the resolution, choose the preset marked with "Original size" or 'Same as input’.
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Choosing the right resolution

A video's resolution is its size in pixels, horizontally and vertically. It is usually listed as the width times height: 1920x1080, or just the height:
1080p. This means that the video is 1920 pixels long and 1080 pixels tall. The higher a video's resolution, and the more pixels it has, the more
detail it can preserve.

First of all, you need to know the original file's resolution. To do that, check the video information next to the file's preview. When you choose
the output resolution, select the same resolution to preserve the original quality, or choose a lower resolution to reduce the file size.

Advanced settings

If you can't find a suitable preset, you can select the necessary properties manually. Click the Customize button next to the 'Outout format
box to modify the video and audio properties of the currently selected preset.

Learn more

Choosing a format for devices
If you are planning to watch some videos on your device, convert them first to save space and make sure that they can be opened with the
built-in player.

Step 1: Click the Devices tab in the lower half of the window.
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Step 2: Use the arrows to scroll through the list and find your device's manufacturer.

Step 3: Click on the manufacturer to open the list of devices. Choose your device model from the list. Now, the output format, resolution and
other parameters have been set to what's best for this device.
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If you cannot find your device in the list, try choosing a preset for a similar model.
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See also:
Automatic device recognition

Choosing an image format
If you come across a rare image format, you can batch convert images to a more popular format.

Step 1: Click the Images tab to see a list of image formats.

) CONVERT

Step 2: Click the format you want to use and then click the preset for that format.

Social networking
Websites often have limits on the maximum image size you can upload. If you're planning to upload the photos to a social network or make

an avatar, click the Social Networking group and select where you want to upload the files. The image size and format will be set to those
accepted by the selected website.

GIF images

Using the image presets in the GIF format group, you can create both static and animated GIFs. Simply choose the GIF size that you want:
smaller GIFs will load much faster, but larger GIFs let you see all the detail.

How to create animated GIFs

See also:
How to convert images

Choosing an audio format

Follow the steps below to set an audio format for the output files. You can convert files with the original bitrate, or save space by converting
FLAC to MP3.

Step 1: In the lower part of the window, click the Audio tab to see the list of audio formats.
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Step 2: Click the format you want to convert the audio to.

Step 3: Choose the bitrate that you want to use. To convert without changing the bitrate, choose the preset marked with “Original bitrate'.

Bitrate — the bitrate reflects the amount of data in kilobits that is played back each second (measured in kbps). Higher bitrate usually means
higher audio quality as well as larger file size, as extra data needs to be stored within the file. For audio presets, the bitrate is listed next to
the format. When you convert a file to lower bitrate, the extra bits of data are irretrievably lost, meaning that you cannot increase quality by
converting audjo to a higher bitrate, because the file no longer contains the data that can be used to restore higher quality.c

Customizing presets

After selecting a preset, you can manually modify it to change any output properties. To do that, click the cogwheel button next to the Output
format box to open the settings for the selected preset.

m Output format: Custoem * @

To see more settings, click Show Advanced at the bottom of the settings window.

Two Pass Encoding

Encoding videos in two passes means that the encoder will go over the media file twice: first, to analyze the file and then to convert it using
the collected data. This takes extra conversion time, however it allows for a higher output quality and possibly a slight reduction in file size.

To enable two pass encoding:

1. Inside the Settings window, click Show Advanced to show the encoding settings.
2. Under Encoding type, choose Two Pass.
3. Click OK to accept the changes.

Editing media files
If you need to make some quick edits to the file before converting, click the Edit button next to the file that needs editing, and then apply the
necessary adjustments in the editing window.

118



# T No subkities

B ASC 135 Kbps Stereo

# T No subkities
eH A 125 khps Stereo

) CONVERT

Trimming videos
If you only want to convert a part of the video, you can trim off the parts you don't want from the beginning and end of the file.
Learn more about trimming videos

3 N O RS
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Original video - 5 min. Trimmed video - 30 sec.

Joining videos
If your video footage is in several different files, you don't need to use a full-function video editor to join them together.
Learn more about joining files

Joined videos

Flipping and rotating videos
Nobody likes videos with the wrong orientation! This can be easily fixed with the Transform Video tool which lets you rotate and flip videos

or images.
Learn more about transforming videos

L L

Left to right: original image, rotated 90° clockwise, rotated and fljpped horizontally
Cropping videos
Cropping a video can change the video's aspect ratio to remove any black bars around it; you'll be able to use the entire screen when
watching the video. Cropping a video or image can also help to remove unwanted images from the edges of the screen (for example, if
there's a dumpster at the edge of an otherwise beautiful video!) or draw attention to the center of the frame.
Learn more about cropping

Cropping a video N

Changing the aspect ratio
Changing the video's aspect ratio also lets you to make full use of available screen real estate without black bars. This is particularly useful if

you want to watch old TV-format videos on a new 16:9 screen, or vice versa.
Learn more about aspect ratios
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4.3 video turned into 16:9
Adding a watermark
Adding your name or logo on top of the video will make sure nobody else can take credit for your videos.
Learn more about watermarking

Original video, image watermark, text watermark.
Adjusting colors
Using Movavi Video Converter, you can make quick color adjustments to your videos and photos. Use automatic adjustments for fast
enhancement, or adjust the hue, brightness, and saturation manually.
Learn more about video adjustments

Before and after adjustment
Stabilizing video
If your videos have a lot of camera shake, you can reduce the effects using video stabilization.
Learn how to stabilize video

Enhancing audio

Many movies have problems with volume, where the dialogue is too quiet and action scenes blast at full volume. To combat this, you can
normalize the file's audio track using Movavi Video Converter, or adjust the volume level manually.

Learn more about audio enhancements

Adding effects
You can add effects to your video! Video Converter has some simple effects as removing fish eye, sharpening, vignette, and more.
Learn how to add effects

.

Before and after effects

Trimming files
Trim and cut files before converting to save disk space and keep just the parts that you want.

Step 1: Click the Edit button next to the file you want to trim.
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Step 2: To cut out a part of the video:

1. Move the position marker to the beginning of the fragment and click the scissors button.
If you're trimming the file from the beginning, skip to the next step.

2. Move the position marker to the end of the fragment and click the scissors button again.
If you're trimming the file from the end, skip to the next step.

3. Click on the fragment to select it and click the trash can button to remove it.
Repeat this for all other fragments that you want to remove. When you remove fragments, the rest of the video will seamlessly snap together.
Step 3: When you've removed all the parts you don't need, click Done to close the editing window.

Cancel trimming
If you want to remove the trimming and go back to the original length, click Reset on the Trim tab in the editing window.

Precise positioning

To set a cut marker more precisely:

+ Click on a cut marker to select it and move it along the seek bar to change the cut position.

+ Click on a cut marker and then enter the precise time into the box below it.

* Click the skip forward or skip backward button to move the position marker or a selected cut marker by exactly one frame.

B =

You can trim a file and save it without conversion. The Trim without conversion option is available only for videos with H.264 codec and

Saving without conversion

audio with no applied tools except for trimming.
To do this, take the steps above to rotate a file and then click Save without conversion button.
When the saving finished, click Done.
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Rotating video
Use the Rotate tool in the editing window to rotate or flip videos and images.

Step 1: Click the Edit button next to the file you want to rotate. The editing window will open.
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Step 2: Click the Rotate tab at the top of the editing window to show rotation options.

Step 3: Click one of the buttons to rotate or flip the file. The rotation buttons will rotate the file by 90 degrees with each click.
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Finally, click Done to close the editing window. Now, you can proceed to converting the files.

Saving without conversion

You can rotate a file and save it without conversion. The Rotate without conversion option is available only for MP4, MOV, M4V-files with no
applied tools.

To do this, take the steps above to rotate a file and then click Save without conversion button.

When the saving finished, click Done.
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Cropping video

Cropping a video can help you remove parts around the edges or fix the video's aspect ratio.

Step 1: Click the Edit button next to the file you want to crop. The editing window will open.
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Step 2: At the top of the editing window, click the Crop tab.
Step 3: Set the crop frame to the necessary size and position:

+ Drag the edges of the frame to change its size, and drag by the center of the frame to move it relative to the entire video.
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« If you want a specific size, enter it into the width and height boxes.

« If you want to crop the video to a specific aspect ratio, make sure that the Maintain aspect ratio option is enabled and choose the
proportions from the box below.

Step 4: Click Apply to accept the changes.

Click Done to close the editing window, and then convert the files for the changes to take effect.

Adding effects

You can add effects to your video. There are seven simple effects in Movavi Video Converter.
Step 1: Click the Edit button next to the file you want to add effects. The editing window will open.

Step 2: In the editing window, click the Effects tab.

) CONVERT

Step 3: Click the preview icon to add an effect. You can apply several effects simultaneously.

Step 4: Click Apply to accept the changes. If you want to batch-process your files, select Apply to all files to apply the same effcets to other
files in the list.

Finally, click Done to close the editing window.
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Adding a watermark
Use the watermarking tool to overlay any text or image over your videos and images.

Step 1: Click the Edit button next to the file you want to watermark.
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Step 2: In the editing window, click the Watermark tab.

Watermark

Taxt

Step 3: Apply the watermark:

Text watermark
1. On the Watermark tab, click the Text button.
2. Enter the watermark text into the box.
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3. Click the buttons under the text box to change the font, text color, and outline color.
4. Move the Transparency slider to make the text more see-though.

Watermark

Image watermark
1. On the Watermark tab, click the Image button.

2. Click the folder icon E and choose the watermark image you want to use.
3. Move the Transparency slider to make the image see-through and less distracting.
4. By default, the image will keep its original proportions. To change the proportions, deselect the Maintain aspect ratio option.

Watermark

Transparency

Maintamn aspect rabio

Step 4: In the player, move the watermark to the necessary position.
+ Drag at the corners to change the size of the watermark.
* Drag at the center to move the watermark.

Step 5: Click Apply to accept the changes. If you want to batch-process your files, select Apply to all files to apply the same watermark to
other files in the list.
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Watermark

Editing subtitles
Using the subtitle tool of the converter, you can permanently overlay a subtitle stream onto a video (also called 'hardsub). This can be helpful
if you're planning to watch the videos on a mobile device or using a player that does not support separate subtitle tracks.
Step 1: Click the Edit button next to the video you want to add subtitles to. The editing window will open.

Step 2: In the editing window, switch to the Subtitles tab.

% CONVERT

Step 3: Choose the subtitles that you want to use:
You can choose soft or hard subtitles.

Softsubs are stored as a separate track and you can add several subtitle tracks to one file. All the subtitle tracks will be saved if you choose
this option.

Note: Not all formats support softsubs. There are also less editing options: you can't change position and synchronize them with video. They
are also not displayed in the preview window.

Hardsubs are permanently drawn on top of the video and cannot be turned off, but they are guaranteed to be visible in any player.

« If the subtitles are built into the file, select the necessary subtitles from the list.
« If the subtitles are stored as an external file, click Add and open the subtitle file. You can use *srt, *.ass, or % ssa subtitle files.
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Step 4: Set up the subtitles:

Subtitle encoding

If the subtitle text looks scrambled, try changing the subtitle encoding: open the list and choose the language or character set the subtitles
should be in.

Position

Use the Position box to change where the subtitles appear on the screen:

1. Open the Position box and choose which edge the subtitles should snap to (e.g. top or bottom).
2. Use the slider below to move the subtitles relative to the selected position.

Synchronization

If the subtitles are out of sync with the video, use the synchronization box to advance or delay subtitles by a specific time in seconds and
milliseconds. Positive values make the subtitles appear later, and negative values make them appear earlier.

Example:

-0.700 - the subtitles will appear 100 milliseconds sooner.

1.200 - the subtitles will appear 1 second and 200 milliseconds later.

Step 5: Click Done to apply the changes. When you convert the video, the selected subtitles will be permanently shown over the video.

Extracting subtitles
Step 1: Click on the subtitles field next to the video you want to extract subtitles from.

Make sure to choose the video format.
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Step 2: In the pop-up meny, click the Extract subtitles into a separate file button.
Now, the file with the extracted subtitles will be saved by default in Movavi Library folder.

The file will be automatically shown in folder at the end of the extracting process.
Adjusting colors
Not all videos turn out perfect: some may be slightly darker or less saturated than we want them to be. Luckily, you can adjust your videos'
brightness, contrast, hue, and saturation right from the converter!
Step 1: Click the Edit button next to the video or photo you want to adjust. The editing window will open.

Step 2: In the editing window, switch to the Adjustments tab.

Step 3: Adjust the colors:

* Drag the sliders to change the brightness, contrast, hue, and saturation of the photo and video.

+ Use the Magic Enhance option the automatically fix the brightness, contrast, and saturation of the video or photo.
« If the colors look unnatural, try the Auto white balance option.

130



Adjustments
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Step 4: When you're satisfied with what you see in the preview, click Apply. To batch-process other files in the list with the same
adjustments, select Apply to all files.

Finally, click Done to close the editing window. All that's left is to select an output format and click CONVERT to start video processing.

After you've edited the file, its thumbnail will now be marked with a magic wand icon. You can click it to see a list of applied effects. To
remove adjustments, select it in the list and click Remove.

A, | Applied effects:
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See also:
Noise removal

Rotating files

Video noise removal
Noise can appear on photos and videos if they were taken in poor lighting conditions. Follow these instructions to remove noise from any
videos or photos.
Step 1: Click the Edit button next to the video with noise. The editing window will open.

Step 2: Click the Adjustments tab in the editing window to show photo and video adjustment options.

Step 3: Select the Noise removal option.
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Step 4: Move the Noise level slider to reflect the amount of noise you can see in the preview. The more noise you need to remove, the higher
the Noise level.

Adjustments

Step 5: When you're satisfied with the result, click Apply. If you need to remove noise from several similar files, select Apply to all files to
use the same noise level on all the files in the list.

Click Done to close the editing window.

Enhancing audio
Using the audio tools in the converter, you can quickly fix quiet files or remove noise from the audio.

Step 1: Click the Edit button next to the file that needs audio correction. The editing window will open.

Step 2: At the top of the editing window, click the Audio tab.

Step 3: Adjust the volume:
* To change the volume of the whole file, drag the Volume slider to the necessary level, where 100% is the original volume.
« If parts of the file are too quiet, select the Normalize volume option to make them louder.

Step 4: If you hear hissing or other noise in the file:

1. Select the Remove noise option.
2. Drag the Noise level slider to set the amount of noise you can hear in the file.
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Audio Adjustmants

Step 5: When you're finished, click Apply to accept the changes. To fix the volume for all the files in the list, select Apply to all files.

If you don't need any further editing, click Done to close the editing window.

Low volume detection
When you add files to the converter, it will check the volume of the files and recommend steps if the volume is too low.

Step 1: Find low volume files
The converter will mark quiet files with the "Low volume" tag. Click the tag to see the recommended course of action.

Step 2: Boost volume
A message will appear, recommending volume adjustment. Click Boost Volume in the message to open the audio adjustments.
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Step 3: Apply volume boost
The Normalize volume option will already be selected for you. Play the file to check the new volume level. If you need more volume
adjustment, use the Volume slider to set the necessary volume level. Click Apply once you're satisfied with the new volume.
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When you're finished, click Done to return to the main window.

Stabilizing video
Videos shot on handheld cameras often look shaky and unstable, no matter how hard you try to keep the camera level, especially if you're
filming sports using a portative action camera such as a GoPro®. To remove camera shake from your videos:

Step 1: Open the video files and click the Edit button next to the file that needs stabilization.

Step 2: The editing window will open. There, switch to the Stabilization tab.

Step 3: Set up stabilization with the following parameters depending on the video and the amount of shaking:
Accuracy: affects the analysis precision of the video. Higher accuracy yields the best results, but also takes more time.
Shaking: set how strongly the shaking is visible on the video.

If you need more advanced settings, click the arrow under the sliders.

Radius: when a video is stabilized, each object is adjusted using the pixels from the surrounding area. The radius affects how large that area
will be. Use a smaller value for more dynamic videos to avoid mixing objects together and to preserve more detail.

Smoothing: limits camera acceleration. Higher values work best for more or less static videos. Excessive smoothing may limit panning.
Edge Cropping: after compensating for motion, some distortion artefacts like blurred areas may appear around the edges.
* None: the edges will remain as they are. Best results if there is little shaking on the video.

* Fixed: the video is cropped to one size to cut off some of the edges.
« Adaptive: whenever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown.
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Video Stabilization

Step 4: Click Apply to accept the changes. If you have several similar files, select Apply to all files to stabilize them in the same way.

If you're finished editing the file, click Done to go back to the main window. Stabilization will only take effect after you convert the videos.

Merging files
Step 1: Add the files you want to join
Click Add Media in the upper left-hand corner and choose Add Video from the pop-up menu. Open the files you want to join.

+ Add Media

E Add Video

"'.' Add Audio...
E Add Images
& add DvD

E Add Folder...

%y CONVERT

Step 2: Reorder files
The files will appear in the joined video in the same order as they are shown in the list. Drag the files with your mouse to the right order.

Step 3: Join files
Select the Merge files option at the bottom of the window. All the files in the list will now be queued for joining.
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Step 4: Rename the output file

The output file will have the same name as the first file in the list. To change the name:
1. Click the pencil icon Ed at the top of the file list.

2. Enter the new name in the Output file name box.

3. Click OK.

|
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Step 5: Convert
1. Select an output format for the new video. See also: Choosing output format

2. Click the folder icon E next to the Save to box and choose where to save the output video.
3. Click CONVERT to start joining the files.

Troubleshooting
If you see an error after selecting the Join files option, make sure that all of the files in the list have the same number of audio tracks. Click
the audio information and disable the extra audio tracks. See also: Choosing audio tracks

Renaming files
Before you convert files, you can change the name of each output file.

Step 1: Click the pencil icon E4 next to the output file name in the second column of the file list.
Step 2: Enter the new name into the Output file name box.

Step 3: Click OK to accept the changes.
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Now, the output file will be converted with this name.

Fixing the aspect ratio
Sometimes, when you watch videos on a display with different proportions, you may experience stretching or black bars around the edges.
To prevent that, you can change the video's proportions to adapt it to the display beforehand.

Black bars and stretching when watching a 4:3 video on a 16:9 screen.

What is the aspect ratio?
A video's aspect ratio is the ratio between its width and height. The two most commonly used aspect ratios are 4:3 and 16:9, the former used
by most analog television broadcasts, while the latter, also referred to as widescreen - in films, DVDs, and modern HD video.

43 |16:9 I

A visual comparison of two popular aspect ratios.
Step 1: Click the Edit button next to the file that you want to fix.
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Step 2: In the editing window, switch to the Crop tab.

Step 3: Make sure that the Maintain aspect ratio option is selected and choose your display's aspect ratio. This will set the crop frame to
these proportions.
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Step 4: In the player, drag the frame's edges so that it covers as much of the video as possible. Drag the frame to the center of the video.

Step 5: Click Apply to accept the aspect ratio changes, and then click Done to close the editing window.

Now, after you convert the video, it will have the same aspect ratio as your display.

Before/After modes
You can apply tools and compare an original video and a changed one. To do this, apply any tool and use the After and Before buttons under
the player window.
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Changing the output folder

When your files are converted, the new files will be created in the folder listed in the Save to box at the bottom of the window:
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To change where new files are stored, click the folder icon E next to the Save to box and choose the folder you want to use.

If you want to save the new files in the same folder as the original files, click the arrow on the Save to box and choose Save converted files
next to the originals.

B Merge files:

converted files next to the onginals

Sharing and exporting
After the files are converted, you can easily share them with your friends and family on the Internet.

Before you start

To upload files online, you will need the free Share Online application installed on your computer.
Download Share Online

Step 1: Prepare the files
1. Open the files you want to convert. Opening media

2. Choose an output format. Choosing output format
3. Edit the files. Editing media files

Step 2: Select services for uploading

1. Click the the sharing button H at the top of the window.
2. Click YouTube, Facebook in the pop-up list.
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3. Another list will appear. Select the services or websites where you want to upload your files.

|
]
]
|

Step 3: Convert files

Click CONVERT to start processing your files. When conversion is finished, the Share Online window will open with the new files, ready to
upload.
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Step 4: Upload files

If you haven't used Share Online before, you will be asked to log in to the websites you've selected.
Share Online uses the services’ own authentification and does not store your login data to keep your privacy safe.

1. In the Share Online window, click a file in the list. Information about this file will appear on the right. Fill in the title, description, and privacy
settings for the selected websites. Repeat this for all files in the list.

2. Click Upload to start uploading the files to the selected services.

e T —
e ot S
B addrile B> Add Folder Clear List 99 Preferences ™M Halp

Fie Name Sire File Infa

= Music Video (1).mp+ 22.02 ME Not uploaded XNl _
— Tithe: =41 ar 2016
= Summer (1).mp4 11.75 MB Net upleaded Xf| ™ mener 201
& Japan (1).mp4 32.63 MB Not uploaded X Length:  00:30
Size: 11.75 MB

Description: | Our summer trip.

WouT ube

Travel & Events

Uploading files to iTunes

Adding converted videos and music to your iTunes library will allow you to play them on any of your devices connected to the same iTunes
account.

Before you start
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To upload files to iTunes, you will need iTunes 6.0 or higher installed on your computer.
Download iTunes

Step 1: Prepare the files

1. Open the files you want to convert. Opening media
2. Choose an output format. Choosing output format
3. Edit the files. Editing media files

Step 2: Choose iTunes uploading

1. Click the the sharing button H at the top of the window.
2. Select iTunes from the pop-up list.
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Step 3: Convert files
Click CONVERT to start processing your files. After conversion is completed, the files will be uploaded to your iTunes cloud storage.

iTunes® js a trademark of Apple Inc.

Energy-saving options
If you are running a batch conversion for very large files, the process may take a while even on fast computers. The energy-saving options
allow you to shut down or hibernate your computer after it is done converting the files.

1. Click the Settings button in the upper right-hand corner of the window.
2. Click the When finished menu to see the energy-saving options.

3. Select one of the following:

* Do nothing — the conversion will run as usual, and your computer will stay on.

* Hibernate — your computer will hibernate after conversion is completed.

+ Shut down — your computer will turn off after conversion is completed. We recommend that you close any other applications that may
prevent your computer from shutting down.

If you change your mind, you will be able to disable shutdown or hibernation during conversion. Please note that if you use any of the energy-
saving options, iTunes and web uploading will be temporarily disabled. The next time you start the converter, the energy-saving options will
be automatically turned off.

Watch Folder
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The Watch Folder option can monitor a folder for changes and convert any new files to the format of your choice. If you frequently convert
videos to one format, you will only need to set it up once and then simply take the converted videos whenever you need them.

Setting up automatic conversion:

Step 1: Choose a format

Before you set up a Watch Folder, select the format that you want to convert the files to.
Choosing output format

Step 2: Open Watch Folder options
Click the Tools button at the top of the window and select Watch Folder to see folder monitoring options.

W - HD 1080p

it: M H.264 - Original Size O Save To... Herge fikes ) CONVERT

Step 3: Choose a folder

In the Watch Folder window, click the Browse button next to the 'Monitor folder' box and choose the folder you want to monitor and convert
files from.

For example, this can be your downloads folder if you want to convert any new videos you download.

it in the mam

In Watch Folder made, the program will be minimized to the system tray.

Monitor folder:

C:\videos

il ipul H.264 Auta

B Launch at system startup

Show conversion notifications

Start Watch Made

Step 4: Set up conversion options

In the After conversion option, choose what you want to happen to the original files after they've been converted:
Delete original files: the files will be deleted as soon as they are finished converting.
Move original files to a subfolder: the original files will be moved to the 'Originals' folder inside the monitored folder. These files will
not be converted a second time.

Launch at system startup: enable this option if you want the folder monitoring to resume after you restart the computer.

Show conversion notifications: select this option if you want to be notified every time a file has finished conversion or if there's an error.

Step 5: Start monitoring
142



Finally, click Start Watch Mode to begin monitoring the selected folder. The converter window will be minimized to tray and keep working in
background mode.

w files and automatic m o tha
format. To use a differer it in the main

In Watch Folder made, the program will be minimized to the system tray.

Monitor folder:

C:\WVideos

Current output propear ties:

MOV - Original Size
MO Sarma Bl inpuk H. 264 Auto

After conversion:
@ Delete original files

0 Move or ginal files to a subfolder

B Launch at system startup

Show conversion notifications

Start Watch Mode

Conversion log:

If you've already used Watch Folder, you can see a detailed list of all conversion events that occurred in Watch Folder mode. To do that, open
the Watch Folder window and click View Log at the bottom. Here, you can see whether all files were converted correctly.

If you want to keep this log as a text file for future reference, click Save Log and choose a location for saving the log file. To delete all
previous entries, click Clear Log.

Accelerating conversion
Here are some things you can do to convert videos even faster.

Use SuperSpeed mode

When converting to a format with the same video codec as the original, SuperSpeed mode can convert videos up to 79x faster. To accelerate
conversion, use formats and presets marked with the SuperSPEED badge.

Learn more about SuperSpeed

») b

Take advantage of your hardware
Movavi Video Suite is optimized for the latest hardware, allowing you to use your computer's full potential when converting videos.

NVIDIA hardware acceleration

If you have one of the latest NVIDIA graphics card that support the CUDA™ or NVENC™ technologies, you can enjoy faster conversion and
smoother performance by using the graphics card for video processing. When choosing an output format, look for presets with the NVIDIA
CUDA or NVIDIA NVENC badge.

Learn more about NVIDIA acceleration

~  WVIDIAS o~ HVIDIA®
@d cupa SA e

Intel hardware acceleration

If you have one of the latest Intel® processors, you can use the built-in graphics chip to accelerate conversion of H.264 and MPEG-2 video.
When choosing an output format, use presets with the Intel HD Graphics™ badge to accelerate conversion.

Learn more about Intel acceleration

Intel* HD

k!“_'g!) GRAPHICS

AMD hardware acceleration

If you have one of the latest AMD graphics card that support the Video Coding Engine technologies, you can enjoy faster conversion up to
2,5x faster to H.264 and H.265. When choosing an output format, look for presets with the AMD Video Coding Engine badge.

Learn more about AMD acceleration

o videoCoding

AMD Erngine

Enabling acceleration
To enable these acceleration options, click the Settings button in the converter window, and choose Preferences from the pop-up menu. In
the preferences, switch to the Acceleration tab and select the available acceleration options.
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Intel HD Graphics is a trademark of Intel Corporation.
NVENC and CUDA is a trademark of NVIDIA Corporation.

SuperSpeed conversion
SuperSpeed mode allows you to convert video files much faster than usual without losing any quality. When you convert videos, encoding the
video from one codec to another takes the most time. If you don't need to change the video codec or resolution, the video data can simply be
copied to the new file, without having to convert it. This is also sometimes called remultiplexing or remuxing.

When can it be used?

SuperSpeed mode can be used any time when the video stream in the output file is the same as the original:

* The output codec is the same as the video codec in the original file (e.g. when converting MKV files with the H.264 codec to MP4 files with
the H.264 codec)

* The output resolution is the same as the original

* No video adjustments are used. 7//s includes stabilization, video adjustments, denoising, subtitles, watermark, crop, and rotation.

* No video compression is used.

* You can still enjoy SuperSpeed conversion when trimming files.

How to use SuperSpeed conversion
To use SuperSpeed conversion mode, choose output presets marked with the SuperSpeed badge:
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This can be a video format or a device preset that has the same codec and resolution as your original files.

Intel® Hardware acceleration
If you have one of the latest Intel processors, you can use the built-in graphics chip to accelerate conversion of H.264 and MPEG-2 video.

Compatible processors
Intel hardware acceleration is available on Intel® Core™ i3, i5, and i7 processor series. For a full list of processors that support integrated
graphics, please consult the Intel support center.

How to use Intel acceleration
You can enjoy Intel acceleration when converting videos to H.264 and MPEG-2 codecs. When selecting an output format, choose formats
and presets marked with the Intel® HD GRAPHICS badge. Conversion to these output formats will be accelerated.
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Troubleshooting:

Can't enable Intel hardware acceleration

If the Intel hardware acceleration option in Movavi Video Converter preferences is unavailable:

+ Check that your processor is compatible with Intel hardware acceleration. To do that, open the Control Panel, go to System and
Maintenance, and choose System. Find the processor information and make sure that you have an i3, i5, or i7 Intel processor.

+ Update the Intel processor drivers. You can find the newest version at Intel's official website here. We recommend only downloading drivers
and other software from trusted sources.

* In order for the graphics acceleration to work properly, there needs to be a monitor connected to the graphics card port. Connect the
monitor and make sure it is functioning properly, then try enabling Intel® hardware acceleration again.

Problems while converting using Intel® hardware acceleration

If the video conversion process is taking longer than expected, or there are defects in the output video file:
« Try updating the processor drivers. You can find the newest version at Intel's official website here.

« Try disabling Intel acceleration in the preferences.

Intel HD Graphics is a trademark of Intel Corporation.

NVIDIA® Hardware acceleration
If you have one of the latest NVIDIA® graphics cards, you can use its graphics processing power for converting videos. Using the graphics
card instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting
videos.

How to use NVIDIA acceleration
NVIDIA acceleration works when converting any videos to AVI, MP4, FLV, MOV, or MPEG-2 TS formats with the H.264 codec. To accelerate
conversion, choose one of these output formats marked with the NVIDIA CUDA or NVIDIA NVENC badge.
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Compatible graphics cards

NVIDIA acceleration supports GeForce, Tesla and Quadro graphics card series. You can find the full list of supported GPUs on NVIDIA®'s
official site: NVIDIA CUDA supported GPUs | NVIDIA NVENC supported GPUs

Note: NVIDIA acceleration does not support mobile graphics cards.

Troubleshooting

How do I find out which GPU my computer has?

1. Right-click on your desktop and choose Display settings

2. In the Display settings window that appears, click Advanced display settings. This will open your GPU's properties.
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The Enable NVIDIA GPU Acceleration option is unavailable
If you can't enable NVIDIA acceleration, try updating your graphics card drivers.
NVIDIA Download Center | Detailed Instructions

Problems while converting video with NVIDIA GPU acceleration

If the video conversion process is taking longer than expected, or there are defects in the output video file:
« Try updating the graphics card driver. Detailed instructions

« Try disabling NVIDIA GPU acceleration on the Acceleration tab of the preferences.

AMD Hardware acceleration
If you have one of the latest AMD graphics cards, you can use its graphics processing power for converting videos. Using the graphics card
instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting videos.

How to use AMD acceleration

AMD acceleration works when converting any videos to H.264 and H.265 codecs. It To accelerate conversion, choose one of these output
formats marked with the AMD Video Coding Engine badge.
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Compatible graphics cards
When using the H.264 codec, acceleration will work with graphics cards released after April 2014. When using H.265, it will work
with graphics cards released after May 2015.

Troubleshooting

How do I find out which GPU my computer has?

1. Right-click on your desktop and choose Display settings

2. In the Display settings window that appears, click Advanced display settings. This will open your GPU's properties.

The Enable NVIDIA GPU Acceleration option is unavailable
If you can't enable NVIDIA acceleration, try updating your graphics card drivers.
AMD Driver Download Center | Detailed Instructions

Problems while converting video with AMD acceleration

If the video conversion process is taking longer than expected, or there are defects in the output video file:
* Try updating the graphics card driver. Detailed instructions

* Try disabling AMD acceleration on the Acceleration tab of the preferences.

Saving a snapshot
To save a single frame from the video:

Step 1: Click the Play button on the video's thumbnail in the list to view the original file.
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Step 2: In the player window, move to the frame you want to save and click the Take a Snapshot button.
Step 3: A Explorer window will open. Choose where you want to save the snapshot and click Save.

The snapshot will be saved with the original video's size and quality.

Movavi Video Converter Settings and Preferences
To open the converter preferences, click the Settings button at the top of the window to open the settings menu. There, click Preferences.

< I <

< <

B Output format: HOV - Original Siee £ save to... ~ % CONVERT

The preferences are organized into tabs at the top: General, Conversion, and Acceleration. Click the related tab to find the preferences you
need.

General preferences

Conversion preferences

Acceleration preferences

General preferences
On the General tab of the preferences, you can choose the interface language and control how the application behaves.

Automatically check for updates — select this option and you'll be notified whenever a new version is available. Updates within your version
are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.

Send anonymous usage stats to Movavi — checking this box will allow the program to send usage statistics to our development team,
enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no
personal information, will not be disclosed to third parties and will be used for software improvement purposes only.

Learn more about how we use the statistics

Read our Privacy Policy

Recommend output format for connected devices — when you connect a smartphone or tablet, the program will detect the device and
recommend the optimal format for watching videos on it. Learn more

Use software OpenGL implementation — this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.
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OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

If the program works without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting

Minimize to Watch Folder mode instead of closing — if you have enabled Watch Folder, closing the converter window will minimize the
program to the notification area, where it will still be monitoring the folder and converting files. Learn more

General Conversion Acceleration

Language:

English

Automatically check for updates

I give consent to send anonymous usage stats to Movavi

Learn more

Detect low volume in files

Recommend output format for connected devices
Use software OpenGL implementation

ave extended logs for troubleshooting

Cancel

Conversion preferences
On the Conversion tab of the preferences, you can manage how files are converted.

Under Output file name, you can choose what happens if a file with the same name already exists in the output folder:

+ Overwrite existing file: the old file will be permanently replaced with the newly converted file.
+ Automatically rename files: new files will be automatically renamed, and both files will be preserved.

Under After conversion, you can choose what happens when conversion is finished:

+ Open output folder: shows the converted files in the output folder.
* Play notification sound: the program will notify you when it has finished converting your files.

General Conversion Acceleration

Output file name:
@ Overwrite existing file

© Automatically rename files

After conversion:

Open output folder

Play notification sound

Cancel

Acceleration preferences
On the Acceleration tab of the Preferences, you can accelerate conversion using the latest technologies. You can find out more about each
acceleration method in the Accelerating Conversion section.
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General Conversion

Enable SuperSpeed conversion

Enable Intel® hardware acceleration

Enable SuperSpeed conversion

+ SuperSpeed is an express conversion mode that converts compatible formats over 50x faster than regular conversion.

+ SuperSpeed works if the output codec is the same as the original codec, and no effects have been applied to the video.

* When choosing an output format, look for presets with the SuperSPEED badge. This means that converting to this format will be much
faster than others.

») b

Enable Intel hardware acceleration

+ Accelerates video processing by up to 400% when converting H.264 and MPEG-2 video codecs.

* This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics ™technology.
* When choosing an output format, look for presets marked with the Intel HD GRAPHICS badge.

1) Intel* HO

(Intel) maprics

Enable AMD hardware acceleration

* Accelerates video processing by up to 2,5x when converting to H.264 and H.265 video codecs for heavy files.

* This option is only available if your computer is equipped with AMD graphics card that supports the Video Coding Engine technology.
* When choosing an output format, look for presets marked with the AMD Video Coding Engine badge.

ol videoCoding

AMD Ergine

Convert using NVIDIA GPU

« With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50%
faster.

+ Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.

« This option is only available if your computer is equipped with an NVIDIA graphics card that supports CUDA™ or NVENC™.

* When choosing an output format, look for presets marked with the NVIDIA NVENC or NVIDIA CUDA badge, depending on the acceleration
technology supported by your graphics card.

: MNVIDIA® . MNVIDIA
@ NVEMC @ CUDA

Troubleshooting

If acceleration options are unavailable:

* Your computer might not have the right hardware.

« If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: Intel Download Center | NVIDIA Driver Downloads

Intel HD Graphics is a trademark of Intel Corporation.
NVENC and CUDA is a trademark of NVIDIA Corporation.

Record computer screen
With the screen capture module, you can record any part of your screen with audio and save the resulting video in any format you like. When
you open Movavi Screen Recorder, you will see a control panel window where you can set up your capture preferences and an orange frame
which allows you to select which part of the screen you want to record.
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What can | do with Screen Capture?
Record screen
Record online video
Capture a Skype call
Capture video from players
Record audio

How to use Screen Capture

Step 1: Set up the capture area Step 2: Set up sound

Choose a full screen capture mode or click Choose whether you want to record audio

the capture area button to select a window. from your speakers or the microphone.
Step 3: Extras Step 4: Record screen

Use extra options to enrich your recording. Start the recording by clicking the REC button.
Schedule events Press F8 to take a snapshot.
Highlight cursor Press F10 to start and stop the recording.

Record keystrokes Press F9 to pause the recording.

Step 5: Save the result
Learn how to save your recording to a common media format.
Edit captured videos

How to open the capture module
To open the screen capture module:

From launch module
In the Movavi Video Suite launcher, click Record computer screen on the Video tab.
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From Video Editor

If you want to add a captured video to your movie, click the Record screencast button on the Import tab in the video editing module. The
capture module will open. After capturing your screen, click the Open in Editor button in the saving window. The recording will be added to
your project in Video Editor.

Import

Recording video from screen

Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.
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Step 2: Set up the capture area

1. On the recording panel, click the Select capture area button.

2. Select the part of the screen that you want to record:

* Click and drag on the screen to select the capture area.

* To record a window or a window panel, hover your mouse pointer over it and click once a frame appears around it.
* To record the full screen, click on any empty space.

VAT = . =3 00: 00z 00
Capture Area Webcam System Audio Microphone = (O]

¢

Step 3: Set up the sound

Recording system audio

1. Click the System Audio button to enable recording sounds and audio playing on your computer.
2. Use the slider on the left to set the necessary recording volume.

Recording from a microphone

1. Make sure that a microphone is connected to your computer.

2. Click the Microphone button to enable recording sounds from external devices.

3. Click the arrow above the Microphone button and select the device you want to use for recording.

AT £ . =3 [00:00: 00
Capture Area Webcam Systermn Audio Microphone = (©)]

Step 4: Start recording
When you're ready to begin, click the REC button. You will be given a 3-second countdown before the recording begins.
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Use these keyboard shortcuts to control the recording process:

F9 - pause the recording

F8 - take a snapshot of the capture area

F10 - end capture and save the recording

Tip: these are the default hotkeys. You can change them in the Keyboard Shortcuts section of the preferences.

Duration: 00:00:13

Recorded: 1.3 MB

Left on Disk: 617.7 GB

When you're ready to finish your recording, click Stop on the recording panel or use the F10 keyboard shortcut .

Step 5: Edit the recording (optional)
When you finish recording, the capture editing window will open. Your video is ready and saved in MKV format, but you can preview it, edit, or
save it in a different format.

Cutting the recording

To cut out a fragment:

1. Place the position marker to the beginning of the unwanted fragment and click the scissors icon.
2. Move the position marker to the end of the fragment and click the scissors button again.

3. Move the position marker to the center of the fragment to select it and click the trash can button.

Open in
Editor

Saving the edited recording

To save the trimmed version, or to change the format of your recording:
1. Click the Save As button. The output options will open.

2. Choose a name and location for saving the video.

3. Click one of the squares to choose a format for saving your video.

4. Click Save to start processing your recording.
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Frequently asked questions

/ get a codec activation message when [ try to start recording

When you first start using Movavi Video Suite, you need to activate the codecs you are using. Simply click Activate in the message box to
start using these codecs and continue with your capture. This process is free of charge and does not collect any personal information.

Recording online video
This manual describes how to capture videos from YouTube. You can also follow the same steps to capture video from other video sharing
websites (webinars, sports broadcasts and any other online video).

Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

& Movavi Video Suite 18

® video
|_ -»  Edit video
Audio

Convert video

Record computer screen

Extras ‘Bt Capture from cameras, VHS, TV

User Guides B
Split video

Watch video

Step 1: Select capture area

1. On the recording panel, click the Select capture area button.

2. The screen will dim and a magnifying glass will appear.

« For high-quality videos, we recommend recording in full screen mode. To select the entire screen, click on any empty area of the desktop.
* For low-quality videos, draw the capture area on top of the web player.
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Step 2: Enable system sound
1. Click the System Audio button to enable sound recording.
2. Use the slider to the left to set the necessary system audio volume.
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Step 3: Record the video
1. To ensure the best recording quality, set the online video player to the highest quality and wait for the video to load.
2. Click the REC button to begin recording.
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Custom i
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3. You will be given a 3-second countdown before recording starts. Use this time to enable full screen mode and click Play to start the video.
4. When the video ends, use the F10 keyboard shortcut to finish recording, or click Stop on the recording panel.

Step 4: Cut and convert the video (optional)
Your video is now ready. When you end the recording, you can play the finished video, cut out unwanted parts, or save it in a different format.

Trimming the video

If you've recorded extra bits at the beginning or at the end of the video:
1. Place the position marker to where you want to cut the video.

2. Click the scissors button to cut at the selected time.

3. Select the fragment you've cut and click the trash can icon to delete it.

Saving the edited video
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After you finish capture, your recording is already saved in MKV format. If you've cut the video or want to change the format, you will need to
save a copy of the video.
1. Click the Save As button in the editing window. The output options will appear.

2. Name your file and click the button in the Save to ! box to choose where to save the video.
3. Choose the format for saving the new video.
4. Click Save to begin processing your recording.
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Recording with webcam
How to add a simultaneous webcam overlay to your videos
Step 1: Select capture area

1. On the recording panel, click the Select capture area button.
2. With the crosshair, select the part of the screen that you want to record.
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Step 2: Set up the webcam
1. Connect the webcam to your computer and wait until the system installs the necessary drivers.
2. Click the cogwheel icon on top of the Webcam button. The webcam preferences will open.

: gy 00z 00: 00
Capture Area Webcam GE'

Custom
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3. Under Use this webcam, choose the webcam device that you want to use and check that its preview appears on the right.
4. Set up the video options for this webcam:

+ Click the Settings button to set up your webcam's options such as brightness, contrast, and exposure. Nofe: webcam settings are different
for each model.

* Choose the resolution that you would like to use. The higher the resolution, the higher the webcam video quality will be. However, if the
webcam video is small, you may not need a very large resolution.

* For the best quality, use the highest frame rate that your webcam can provide for the best quality. If your webcam is mostly static or if you
want a smaller file size, you may want to use a lower frame rate.
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5. Set up the size and position for your webcam:
+ Use the Video size slider to set the size of the webcam picture relative to the entire video.
+ Choose one of the Position options to place your webcam picture inside the frame.

6. Click OK to save the webcam preferences.

Use this webcam:
. Microsoft LifeCam HD-3000

Resolution:

General

240 x 360

. Frame rate:

30

. Video size:

Video

Position:
Upper left Upper right

Lower left Lower right

Scheduler

Sharing 0K . Cancel

Now that you've set up the webcam, the next time you want to use it, simply click the Webcam button once to enable webcam recording.

Step 3: Set up sound
Next, choose the audio sources that you want to hear on your recording:

System sounds
To record music and other sounds playing on your computer, click the System Audio button. The button appears green when enabled.

Microphone
You can record audio from your webcam's built-in microphone, or use an external microphone for better sound quality:

1. Click the Microphone button to enable recording from external devices.
2. Click the arrow above and choose the microphone you want to use from the list.
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Step 4: Record your video
When you're ready to begin, click REC to start recording. The recording panel will be minimized during recording.
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To finish the recording, press F10 or click Stop on the recording panel.

Step 5: Edit and save
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When the recording is finished, it will open in the capture editor, where you can play or trim the result.

ﬁ Open in
Editor

To cut or trim the video, use the scissors and trash can buttons on the toolbar. If you've trimmed the file or if you want to save your recording
in a different format, click Save As.
Recording video from players

Before you start:

Note the quality and resolution of your video. For best video quality, it is recommended that you record the video as close to its real
resolution as possible.

« If the video is larger than your screen, maximize the player window and record the full screen.

« If the video is smaller than your screen, set the player settings to display the actual size. In this case, stretching the video to the full screen
will decrease the quality.

Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

& Movavi Video Suite 18

(® video
Edit video

Audio

Convert video
Photo

Record computer screen

Extras N7 ' Capture from cameras, VHS, TV

User Guides B
Split video

Watch video

Step 2: Select capture area
1. On the recording panel, click the Select capture area button.
2. With the crosshair, select the part of the screen that you want to record.
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Step 3: Set up the sound

1. To enable recording sounds from the player, click the speaker button under System Audio. The button will appear green when enabled.

2. Use the slider to the left of the speaker button to set the volume of the player's recording.

3. To make sure that other sounds don't interfere with your recording, check that the Microphone button is disabled (black), and close other
windows or browser tabs that might play sounds during your recording.
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Step 4: Record video

When you're ready, click the REC button on the recording panel and start playback in the player. The recording panel will hide
Tip: You can trim the beginning later, so don't worry if you start playback after recording has begun.
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To end the recording, press F10 or click Stop on the recording panel.

Step 5: Edit and convert (optional)
Your recording is ready and saved in MKV format, and you can view the result in the capture editor. Now, you can trim the video or convert it
to a different format.

1. To trim the video from the beginning or from the end, move the position marker to where you want to trim the video and click the scissors
button to cut off the fragment. Then, select the unwanted fragment and click the trash can button to delete the fragment.

Open in
Editor

2. Click the Save As button to open output options.
3. Under File name, enter a name for the new video. Then, click the button under Save to and choose where you want to save the video.
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4. Select the format you want to save the recording in.

5. Click Save to start processing the new file.
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Troubleshooting
Some video player programs have video output settings that prevent capturing video and taking screenshots. If you are having trouble
recording video from any of the following players, follow the steps to change the player's settings and enable video capturing.

Capturing video from VLC (VideoLan Media Player)

(for Windows XP users)

1. In VLC player, open the Tools menu and choose Preferences.

2. Switch to the Video tab (in Simple mode)

3. In the Display section, find the Output list. If DirectX (DirectDraw) video output is selected, try using a different output mode.

Capturing video from Media Player Classic

(for Windows XP users)

1. In Media Player Classic, open the View menu and select Options.

2. Go to the Playback > Output section in the tree on the left.

3. Find the DirectShow Video option. Here, you can choose from a list of video renderers that will affect how the player displays video on
your screen. If the Overlay Mixer Renderer is selected, select any other renderer from this list.

4. Click OK to accept the changes.

Capturing video from Windows Media Player

(for Windows XP users)

1. In the main player menu, open the Tools menu and select Options.

2. In the Options window, switch to the Performance tab.

3. Click the Advanced button.

4. In the Video Acceleration section, find the Use overlays option and deselect it.
5. Click OK to accept the changes.

Recording Skype calls
When you record audio or video calls using Skype or a similar program, it is important that you record both ends of the conversation. To do
that, you will need to record input from your microphone or webcam, as well as the audio from your speakers. Follow the steps below to
record Skype calls with audio.

Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.
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& Movavi Video Suite 18
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Watch video

Step 2: Select capture area

1. Launch the Skype application and make sure it is on screen.

2. On the recording panel, click the Select capture area button.

3. Your cursor will turn into a crosshair. Draw a rectangle inside the Skype window where your call video will be.

VAT = . =3 00: 00z 00
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Step 3: Set up the sound
1. Click the speaker button under System Audio to enable recording sounds on your computer, including the call from the other end. The
button appears green when enabled.

2. Click the Microphone button to enable recording from a microphone. If you have more than one microphone, click Microphone and choose
the one you want to use for the recording.

3. Use the sliders to the left of each button to set the necessary volume levels for the call and for your microphone.
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Custom
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Tip: if you're recording a video call, you do not need to enable webcam recording in Movavi Video Suite, because Skype is already recording
your webcam.

Step 4: Record your call

1. Start your call in the Skype window.
2. Click REC on the Movavi Video Suite panel to begin recording.
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3. When you finish your call, press F10 or click the Stop button on the recording panel to finish recording. The capture editor will appear,
where you can play the finished video, cut the recording, or save it in a different format.

Duration: 00:00:13

Recorded: 1.2 MB

Left on Disk: 617.7 GB

Step 5: Edit and convert (optional)
If your recording started before the call, you can trim off the extra bits using the scissors and trash can buttons.

1. Place the position marker to where you want the video to start and click the scissors button.

2. Select the unwanted fragment and click the trash can button to delete it.

Open in
Editor

3. Now that you've cut the video, you need to save the trimmed copy. To do that, click the Save As button.
4. The export options will open in a new window. There, select the format you want to use, name the file and choose where you want to save

it, and click Save to start processing the video.
Tip: If you want to save just the audio of the call without the video, go to the Audjo tab and select MPS3 .
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Making an animated GIF
To create a GIF, all you need to do is record an action or video on the screen and then save the animation in the GIF format.

Step 1: Select capture area
1. Click the Select capture area button on the recording panel. Your cursor will turn into a crosshair.
2. Draw a rectangle with your mouse to select the area that you want to record.

) ' & [00-:00:00
Capture Area Webcam ystem Audio Microphone

If you need to adjust the capture area, drag its edges to change the size and drag the circle 0 in the center to change its position.

Step 2: Record the action
Once everything is ready, click the orange REC button to begin recording your GIF.

Width: 941 Hesght: 606
-

Capture Area Webcam

Custom ¥

'R 041 &2 x 606 2
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When you've finished your recording, press F10 or click Stop on the control panel. Don't worry if you accidentally record more than you need,
you can trim the recording later.

Step 3: Trim and save your GIF
After capture is complete, you will see your recording in the capture editor window.

Trimming the GIF (optional)

If you've recorded extra bits, you can cut them off:

1. Place the position marker to where you want to cut the video.

2. Click the scissors button to make a cut.

3. Select the fragment you want to remove and click the trash can button.

Opan in
Edior

Saving the GIF

1. Click the Save As button to open output options.

2. Name your GIF file and choose where you want to store it.

3. Click the GIF square to choose GIF as the output format.

Advanced: If you need to edit the size and quality of the GIF, click the cogwheel button next to Output format.
4. Click Save to start turning the recording into an animated GIF.

Open R
Editor

ScreenRecorderProject?

E:\Temp\Videos
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Fun fact!
The creators of this format intended it to be pronounced as Jif, but it is now more
common to pronounce it with a hard g, so both pronunciations are accepted.

Record audio only
Besides screen activity, you can just as easily record online music, radio, podcasts, and voice input as standalone audio files.
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Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

& Movavi Video Suite 18

™ Video

Edit video
Audio

Convert video
Record computer screen
Extras N I Capture from cameras, VHS, TV
User Guides

Split video

Watch video

Note that you can also record audio using the Record sound button on the Audio tab.

Step 2: Set up the audio
On the recording panel, choose which audio sources you want to record from:

A - . g~ [0z 00: 00
Capture Area Webcam System Audio Microphone ¥ (0]

Custom

Recording system sounds
To record music, online videos, and any other sounds playing on your computer, click the System Audio button.

off on
Recording microphone audio

To record sound from a microphone or any other recording device connected to your computer, click the Microphone button. If you have
more than one recording device, click the arrow W above the button and select the device you want to record from.

.
off on
Volume levels

Use the sliders to the left of the System Audio and Microphone buttons to adjust the volume of each source.

Step 3: Record the audio
Click REC when you're ready to begin recording.
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Duration: 00:00:132

Recorded:

Left on Disk:

To end the recording, press F10 or click Stop on the recording panel.

Step 4: Save audio file
When the recording is finished, the capture editor window will appear, where you can play the audio you've recorded.

1. Click Save As to open the exporting options.
2. To save just the audio from your recording, go to the Audio tab and click MP3.

3. Click Save to turn your recording into an audio file.
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Troubleshooting audio
My device is not available in the list.
If you don't see the device you want to use in the list, it may be disconnected or disabled in system settings.

1. Try re-connecting the device.

2. If that didn't help, right-click the sound icon in the Windows notification area and choose Recording Devices from the pop-up menu. The
Sound settings window will open.

3. Look for your device in the list:

« If the device is working correctly, it should be marked with a green checkmark.

« If you cannot find the device in the list, right-click anywhere in the list and make sure that the options Show Disabled Devices and Show
Disconnected Devices are selected.

« If you still cannot find the device, download a driver for this device from the manufacturer's website and install it. This should help your
system detect the device.

4. Try enabling the device:
« If the device is listed as Not Plugged In, try plugging in the device again.
« If the device is listed as Disabled, right-click the device and choose Enable.

/ can't enable system audio
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If you're using Windows XP, system audio cannot be recorded simultaneously with microphone audio. To record system audio, open the list
of devices above the microphone button and choose Stereo Mix.
Setting up a screen recording

Recording panel
You can use the recording panel to set up your recording.

Webcam System Audio Microphone

Custom

% 1064 s X 615 =

Learn more: Capture area

Sound

You can record sound from two different sources on your video: from your speakers, or from an external device, such as a microphone.
* Click the speaker button to record system audio,

+ Click the microphone button to record from a microphone.

Learn more: Sound

Webcam

You can simultaneously record your webcam footage that will show up in the corner of the video. Connect the camera and click the Webcam
button on the recording panel.

Learn more: Webcam

Cursor recording

If you're making an instructional video, you can highlight the cursor and its clicks to help your viewers keep track of your mouse. You can
change the appearance of your cursor in the Effects section of the Preferences.

Learn more: Mouse cursor effects

Keystroke recording

If you're showing keyboard actions such as hotkeys on your video, you can enable keystroke recording, and the keys you press will
automatically appear at the bottom of the video. You can enable keystroke recording in the Effects section of the Preferences.
Learn more: Recording keystrokes

Scheduling recordings
When you've finished setting up your recording, you can start it right away or schedule it to begin or end automatically. You can schedule
your recordings in the Capture Time section of the Preferences.

Starting the recording

To start recording right away, click the REC button on the recording panel. You can pause and end capture using the buttons on the recording
panel:

Learn more: Starting the recording
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Duration: 00:00:132

Recorded: 1.3 MB

Left on Disk: 617.7 GB

Capture area
The orange frame defines which part of your screen will be visible in your screen recording.

Selecting the capture area
Step 1: Click the Select Capture Area button on the recording panel.

e~ 00: 00: 00
Capture Area Webcam System Audio Microphone @
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Step 2: Your cursor will turn into a crosshair. Use it to select the part of the screen that you want to record.

+ To record a window or a window panel, hold your mouse pointer over the window you want to record and click when a frame appears
around it.

Tip: if you select a window, the capture area will follow whenever you move the window.

* To record the entire screen, click on an empty part of the desktop, or

* To record a part of the screen, click and drag diagonally to draw the area where you want it to appear.

Fiers: Forwra colectaon: | Mg Wadid Edanr

Setting an exact size
After you've opened the recording panel, you can choose a preset size from the Capture Area section, or enter an exact size into the boxes:
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To set the capture area to full screen, open the preset list and choose DISPLAY from the list.

Editing the capture area
* To change the capture area size, drag the edge of the capture area with your mouse.

+ To move the capture area, drag the circle 9 in its center.

Width: 543 Height: 329

1|
1|

n

Sound
You can record sound from two separate sources: system audio and microphone audio. You can enable sound recording on the recording
panel.

Record Record
speaker audio microphone

Capture Area Webcam System Audio Microphone » B <

- |
Custom

. *© ¢

543 ¥ X 320 &

System audio )
volume Microphone

volume

System audio
System audio is the sound that you can hear from your speakers. It includes music, video sound, alerts, and all other sounds.

1. To enable recording system audio, click the speaker icon on the recording panel.

1. Record
speaker audio

Capture Area Webcam Microphone w B

|
Custom !

8
% 543 2 x| 2 System * =

audio volume

2. Use the slider to the left of the speaker button to change the system audio volume. This will also affect the volume that you hear.

Microphone audio
To record from a microphone or any other external recording device:

1. Connect the microphone to the computer. Make sure that it is recognized by the system and working correctly.
2. Click the microphone icon on the recording panel to enable microphone recording.

3. If you have more than one recording device connected, click the arrow ¥ next to Microphone and choose which microphone you want to
use.
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4. Use the slider to the left of the microphone button to change the volume.
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When enabled, the sound icons appear green.

.
off on

Troubleshooting

Capturing system sound on Windows XP

Windows XP does not support recording from multiple audio sources. You can either record microphone audio or system audio, but not both.
To record system sound on Windows XP:

1. Click the microphone button to enable recording from audio devices.

2. Click the triangle next to Microphone and choose Stereo Mix from the list of devices.

Please note that not all hardware allows stereo mix recording.
See also:

Recording only audio
Recording Skype calls

Webcam
You can record webcam video simultaneously with a screencast. The webcam video will appear in the corner of the main video.

Enable the webcam
To enable webcam recording, click the webcam icon on the recording panel:
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Webcam options

If this is your first time recording with a webcam, you may want to set up how the webcam looks on your video. To open the webcam options,
click the cogwheel icon on the webcam button.
Or open the Settings menu, choose Preferences, and then switch to the the Webcam tab.
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General Use this webcam:

Microsoft LifeCam HD-3000 L q
Resolution: 3
240 x 360 4
Frame rate: ‘J
30 Settings

Video
Video size:

Position:
Upper left Upper right

Lower left ® Lower right

Scheduler

Sharing Cancel

If you have more than one camera, choose the one you want to use under "Use this webcam".

Webcam properties

Click the Settings button to open your webcam's built-in properties. These can be different for each manufacturer, but usually you can set up
the brightness, white balance, exposure, and other color options.

Resolution

The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable
decrease in quality.

Frame rate

Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work
best for videos with a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is
20-30 frames per second.

Video size
Use the video size slider to change the size of the webcam video relative to the main video.

Position
You can place your webcam footage in any of the four corners of the main video. Choose where to place the webcam video under position.

See also: Webcam preferences

Mouse cursor effects
Using mouse effects, you can use the mouse as a pointer and show your viewers where to click.

Step 1: Open the mouse cursor options

1. Click the Settings menu and choose Preferences.

2. In the Preferences window, switch to the Effects tab.
Learn more: Effects options
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General Cursor options:

+"  Show cursor on recording

¥ Highlight cursor:

Size:
Highlight clicks:

Mouse click sound:

Webcam
Keystroke recording options:
Do not capture keystrokes
Keyboard shortcuts only

Schaduler ® Al keystrokes

Sharing

Step 2: Enable the cursor
Select Show cursor on recording. This will make the cursor visible on recordings. To make the cursor invisible, disable this option.

Cursor options:
Show cursor on recording
Highlight cursor:
Size:
Highlight clicks:

Mouse click sound:

Step 3: Highlight cursor actions (optional)
To make the cursor visible even better, you can highlight it or enable a special effect for clicks.

Highlight cursor
A semi-transparent circle will appear around the cursor, making it easier to track.

1. Select the Highlight cursor option.
2. (optional) The default highlight is yellow. To change the highlight color, click the square on the right and pick the new color.
3. (optional) Use the Size slider to make the highlight smaller or larger. The cursor itself will remain the standard size.

Hover your mouse over the square on the right to preview the highlight.

Cursor options:

¥ Show cursor on recording
" Highlight cursor:

Highlight clicks:

Mouse click sound:

Highlight clicks
Concentric circles will appear for every click, color-coded for two mouse buttons.

1. Select the Highlight clicks option.
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2. (optional) Click the left square to set the color for the left mouse button.

3. (optional) Click the right square to set the color for the right mouse button.

Cursor options:

¥ Show cursor on recording

ighlight cursor:

Highlight clicks:

ouse click sound:

Mouse click sound
A clicking sound will play whenever you click the mouse.

1. Enable the Mouse click sound option.

2. (optional) The default clicking sound has already been selected for you. If you want to use your own sound, open the drop-down box and
choose Add sound. Then, open the sound file that you want to use.
You can use WAV, MP3, AIFF, and AU files.

Recording keystrokes
If you're making a tutorial that uses keyboard shortcuts, it's helpful to display them on screen for your viewers. Enable keystroke recording to
show the keys you pressed at the bottom of the video.

1. Open the Settings menu.
2. Choose Preferences.
3. In the Preferences window, switch to the Effects tab.

4. To enable keystroke recording, select one of the options:
* Keyboard shortcuts only — only key combinations such as Ctr/+C or Shift+Control+Esc will show up on screen. Letters and keys that

do not cause an action will not be displayed.
« All keystrokes — each key you press will appear on screen, including letters and numbers.

General Cursor options:
v Show cursor on recording

Highlight cursor:

Keyboard Highlight clicks:

Video Mouse click sound:

Webcam

Keystroke recording options:

Effects Do not capture keystrokes
® Keyboard shortcuts only

All keystrokes

Scheduler

Sharing Cancel

To turn off keystroke recording, open the Effects preferences once again and select Do not capture keystrokes.

Tips:.
* Avoid entering any passwords or other sensitive information while you're recording a video with keystroke recording. if you share the video,
your viewers will be able to see each character you type.
* Keyboard shortcut recording does not work with the Windows key.
Scheduling

Any recording can be scheduled for a later time. You can use this to automate your recordings or capture late-night webinars.
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Step 1: Set up your recording
Scheduled recordings will start with the currently selected options (system sound, webcam, etc.) Before scheduling the recording:

1. (optional) Default capture area for scheduled recordings is full screen, so if you want to change it, click the Select Capture Area button on
the recording panel and select the part of the screen you want to see on your scheduled recording.

2. To enable system sound recording, click the speaker button on the recording panel and make sure it is enabled and highlighted green.
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Learn more: Capture area | Sound | Webcam

Step 2: Schedule recording

1. On the recording panel, click the alarm clock button . to open capture time settings.
Or open the Settings menu, choose Preferences and switch to the Scheduler tab.
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Custom 2
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2. Select Schedule recording and click the Add Task button.

General Do not schedule recording

Set time limit for recording

® Schedule recording .

Kevboard
Shortcuts

I + Add Task .

Webcam

Effects

Scheduler .

Sharing Cancel

4. A task template will appear. Fill in the details for the task:

* Title - the name of your recording

+ Date and time - the moment recording should start

« Duration - how long the recording should last (e.g if you want to record an hour long webinar, set this at 01:00:00)

« Capture area - by default, the program will record full screen. However, if you'd like to avoid recording extra parts of the screen, you can
select Current area. Be careful: the program will capture the area selected on screen at the moment your recording starts!

« After capture - you can set your computer to automatically sleep or shut down when the recording is over.
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Do not schedule recording

Set time limit for recording

® Schedule recording

New task
Title: Lesson 1

10/04/2018
19:00:00 + Duration: 01:00:00 =
Current area ‘ !
®  Full screen DISPLAY1
After capture: Do nothing
€ Back + Create

Scheduler

Sharing

5. Click Create to add the task to your recording schedule.

Step 3: Enable launching at startup (optional)

The screen recorder needs to be running at the scheduled start time to begin the recording. If you've scheduled the recording for a later date,
enable the program to start with your computer so that you don't miss the recording. To do that, open the General section of the Preferences,
click More and enable the Launch application at startup option.

General . Basic settings
More .

Launch application at startup

Use software OpenGL implementation
Save extended logs for troubleshooting
Autornatically check for updates

I give consent to send anonymous usage stats to Movavi

Webam Disable Aero theme during capture

Use Direct¥ for capturing

Scheduler

Sharing Cancel

Finally, click OK in the Preferences window to save the changes. After the recording is finished, the recording file will be stored in *mscproj
format in the output folder with your other screen recordings.

Please note that if you haven't yet activated the program, the maximum capture time is two minutes for each video. To learn more about
activating Movavi Video Suite, see the Activating Software section.

If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording files.

Time limit
When you record a long webinar or online video, you can limit the recording to a specific time and it will stop automatically once the time is
up. This way, you don't have to wait around for the video to end.

Step 1: Set a time limit

1. On the recording panel, click the alarm clock button . to open capture time settings.
Or open the Settings menu, choose Preferences and switch to the Capture Time tab.
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A 00:00:00

Capture Area Webcam Systemn Audio

Custom i

R 543 4 x 329 2

2. Select the Set time limit for recording option.
3. Set Duration by entering the time limit as hours:minutes:seconds.

4. Click OK to enable the time limit.
Note: the limit will work on all your next recordings in the current session only, until you restart the program.

General Do not schedule recording

® Set time limit for recording

Duration: 00:02:00 & .

After capture: Do nothing

Schedule recording

Webcam

Scheduler

Sharing

Step 2: Start the recording
Click the REC button on the recording panel to begin recording. After the specified time is up, the recording will end automatically.

Starting the recording

To begin recording:

To begin recording, do any of the following:

* Click the REC button on the control panel.

+ Use the start recording keyboard shortcut (F10 by default)

- In the system tray, right-click the Movavi Screen Recorder icon & and choose Start Recording.

You will be given a 3-second countdown before recording begins.

T - ) =3 [0 00: 00
LRI Webcam System Audio Microphone v | (2

Custom &

e

663 ¥ X

The recording panel will change during capture:
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Duration: 00:00:08
Recorded: 330.2 KB EI

Left on Disk: 617.1 GB . Cancel Pause Stop

On the left, you can see information about the recording:
Duration - the time recorded so far

Recorded - the recording size on disk

Left on Disk — how much free disk space you have left

In the middle, you can see which sound sources are being recorded and preview the webcam:
@ © - webcam off/on
# ' - System audio recording off/on

848 _ Microphone audio recording off/on

To pause recording:
To pause recording, do any of the following:
* Click the Pause button on the recording panel.

* Click the Pause button on the orange panel at the top of the capture frame: m
+ Use the pause capture keyboard shortcut (F9 by default)

- In the system tray, right-click the Movavi Screen Recorder icon &4 and choose Pause.

When you're ready to resume the recording, the Resume button will be in the same location as the Pause button.

To stop recording:
When you're ready to finish the recording, do any of the following:
* Click the Stop button on the control panel.

* Click the Stop button on the orange panel at the top of the capture frame: n
« Use the stop recording keyboard shortcut (F10 by default)

* In the system tray, right-click on the Movavi Screen Recorder icon B2 and choose Stop Recording.

The recording will end and the player window will open, where you can view and edit the video.

To cancel the recording:
If you want to terminate the recording without saving the video and delete the recording file, click Cancel on the recording panel.

Troubleshooting:

Windows style changes when | start recording

If you have a Windows Aero theme (Windows Vista, Windows 7), disabling the transparency effects will free more resources and your
computer will run faster during capture. The Aero theme will return once you have finished capture. To disable this, open the Preferences and
turn off the 'Disable Aero theme during capture' option in General preferences.

Capture doesn't start immediately
By default, you will see a three-second countdown after you press the REC button and before the recording begins. You can use this time to
prepare for recording. If you want the recording to start immediately, open the Preferences and enable the 'Disable countdown' option.

An orange panel appears on my recording

During recording, you can use the orange panel on top of the capture frame to take screenshots, pause or stop recording, and keep track of
the recording process. If you don't want this panel to appear on your videos, open the Preferences and disable the 'Show capture control
panel during recording' option.

Editing captured files
When you end a recording, the player window will open, where you can view the finished video, save videos to a different format, and edit
videos.
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S

Recent files 3 - - Save file |

Here's what you can do:

Cut recordings — trim videos from the beginning or the end, cut out fragments.

Change recording format — save the video in a different video format, as an audio file, or even as an animated GIF.
Publish online — upload the video straight to YouTube.

View previous recordings — all your earlier recordings and screenshots in one place on the history panel.

Opening the player
To open the capture player and editor:

+ Open the Media Files menu and select Preview Recorded Videos.

Capture Effects Media Files Settings Help

Open Recording File Crrl+0
Capture Area Open Recording File_ Ctri+0 tem Audio

Preview Recorded Videos k

Custom "

™ ogop 2 X 434

* Right-click the Movavi Screen Recorder icon in the notification area and select Preview Recorded Videos.

Show

Start Recording F10

Save a Screenshot Fa

Preview Recorded Videos *
= Alt+F4

10:51 AM

R D)
2 e 11/20/2017

Also, the capture editor will open after you finish recording a video.

Opening previous recordings
After you've finished a recording, it will open in the capture editor, where you can view and cut the file. If you want to edit the recording later,
you can open a recording file using any of the following:

Recent recordings

At the bottom of the capture editor, you can see a carousel of your previous recordings and screenshots. If you can't see the thumbnails,
click the Recent button in the bottom left to show the panel.

Tip: If you've changed the recording folder in File preferences, the Recent panel will only show recordings in the new folder.
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Open in

Show/hide
recent

Open afile
Open the Media Files menu and choose Open Recording File. Then, find the file in the Explorer dialog box and click Open.

Capture ffects Media Files Settings Help

Open Recording File... ki:trl+:]

termn Audio

)

Capture Area
Preview Recorded Videos

Custom "

®  oop A x 434 4

A Open Projec] x

"4_'-" o » My Videos » Movavi Screen Recorder b | Searnch Movaw Soreen fecoer o

Organize = MNew folder =« 0O &
¥ Favorites = Videos library
B Dezktop Mowvasi Screen Recorder
& Downloads
%# Dropbox I e e

i Recent Places E:Iﬂ EIB
@ Libranes

! Documents Screenshots ScreenflecordesPr  ScreenflecorderPr Select a file
o Music ojecth to preview,

&rrange by:  Folder =

=/ Pictures
=l Subversion
B videos

& Computer ScreenflecorderPr
& Loeal Disk [0 | ] oject3
ca Local Disk (E)

-

File name:  ScreenRecorderProjassh IMbovaw Sereen Recarder files [* =

Storage location
The default locations for saving output files are:
* "|Videos|Movavi Screen Recorder|” - for video recordings
* "\Videos\Movavi Screen Recorder\Screenshots” — for screenshots

To change where the files are stored:
1. Open the Settings menu and choose Preferences.
2. In the Preferences window, switch to the Files tab.

3. To change the video storage folder, click the ellipsis button ! next to Save output videos to and choose a new folder.
To change the screenshot storage folder, click the ellipsis button ! next to Save screenshots to and choose a new folder.
4. Click OK to accept the changes.

Cutting recordings
This guide will show you how to cut out parts from video recordings using the built-in capture editor.

Before you start:
* Open the recording you want to edit in the capture editor.
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Step 1: Cut fragments
1. Move the position marker to where you want to cut the video.

2. Click the scissors button. A cut marker will appear at the current position.

Repeat these two steps to cut at the beginning and and at the end of each fragment you want to delete.

ﬁ Opeh 7
Edror

Precise positioning

For more precise positioning, click on the cut marker on the seek bar and do any of the following:
* Click the previous frame and next frame buttons to move the cut marker by exactly one frame,
* Click the arrows next to the time to move the marker by a small interval.

+ With the cut marker selected, use the arrow keys to move it left or right by 100 milliseconds.

* Manually enter the necessary time.

Step 2: Delete fragments
1. On the seek bar, click a fragment to select it. The selected fragment appears as a darker shade.

2. To delete the selected fragment, click the trash can button.

A dotted line will appear on the seek bar where a fragment has been deleted: “
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Editor

How to undo cutting
To cancel a cutting action, click Undo at the top of the window or press Ctrl+Z. To repeat a cancelled action, click Redo.

Step 3: Save the edited video
If you've cut the video, you need to save it to apply the changes.

1. Click Save As. The window with saving options will appear.
2. At the top of the window, choose where to save the file and enter a file name.
3. Choose a format for the video. If you don't know which format to choose, leave MP4 selected. It will save faster and at no quality loss.

4. Click Save to start processing the video. This may take a while for longer videos.

Screen H.ecclrl:lerF'rl:lject:’-l

E:\Temp\Videos

JJ Audio

Good High ® Highest
Q86x652

695 KB

£} Advanced

Changing the format
New recordings are created in the MKV format which is supported by most players. This guide will show you how to save your video
recordings in a different format. You can also convert your video recordings to audio by saving them as an audio format.

Before you start:
* Open the recording that you want to change in the capture editor.

Step 1: Open the output options
Click Save As to open the output options.
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ScreenRecorderProjects

EN\Temp\Videos

J3 Audio

Good High #® Highest o
1064x614 .

706 KB

£} Advanced
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| Save As |
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Step 2: Name and location
Enter a name for your new file under File name. If you want to store the recording somewhere other than the default folder, click the ellipsis

button ! next to Save to and choose a different folder.

Step 3: Choose a new format

Select a format you want to use. The formats are organized into three groups:
* Video - MP4, AVI, GIF, MOV, MKV

* Audio - MP3

* Devices - iPhone, iPad, Android

ScreenRecorderProject8

E:\Temp\Videos

J3 Audio

Good
1064x614

706 KB

£} Advanced

Cancel

Step 4: Save the file
Finally, click Save to convert your recording to the selected format. This may take a while for large videos.

Advanced settings
There are some extra settings you can use to customize your recorded files before saving. To open the settings, click Advanced in the saving
window.
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ScreenRecorderProjects mp<

Resolution:

3840x2160 3840

Framing: FPS:

Auto Auto

Sample rate: Channels:

Auto Auto

£} Advanced

Cancel

Resolution

The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common
resolutions. Ideally, the frame size should not exceed the resolution of the recorded video, but match it instead. Smaller resolutions allow you
to make the output video smaller and thus save your disk space, however, this will sacrifice some video quality due to downscaling.

Framing
Choosing a resize method can help you manage how your video is resized to fit inside the frame size you've set. There are three resizing

options available:

Letterbox — the video will be resized to fit inside the frame entirely. This method allows you to keep the whole video inside the frame without
distortions, but may place black bars around the video.

Stretch — the video is fit entirely inside the frame and then stretched on one axis in such a way as to fill the entire frame without leaving black
bars. This allows you to cover the entire frame, however, the objects in the video may appear horizontally or vertically distorted.

Crop - the video will be resized to be slightly larger than the frame, cropping the parts that do not fit inside it. This allows to cover the entire
area of the frame without distorting any of the objects inside the video or without leaving black bars, however, this may not suit some clips
where important objects are near the edge of the frame.

FPS

The number of frames per second is the number of shots that a camera takes each second to make a video. Most cameras shoot video at
around 24 frames per second. However, some cameras can shoot high-speed video that you can use to make slow motion clips. If you plan
on using high-speed videos, choose the FPS that matches the video. If you're using regular videos, leave the default FPS.

Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default
sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music

tracks.
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Channels

Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording
music; mono sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally
preferred number of channels, however, some mobile devices record sound only in mono mode.

Publishing videos online
Once your video is ready, you can share it to YouTube!

Step 1: Open the Export window
Click the Share button next to Save As and select YouTube.

Step 2: Sign in to your account
1. Click Sign In. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Video Suite upload videos.

Movavi Video Suite wants to
access your Google Account

This will allow Movavi Video Suite to:

) Manage your YouTube account

B Manage your YouTube vide

E:\Temp\Videos

Cancel

Cancel

Step 3: Choose a resolution
In the export window, open the Resolution list and choose a resolution that suits your video.
* For best results, choose a resolution that is equal to or less than the height of your video. For example, if your video is 1280x720, choose

the 720p resolution.
« This resolution will be the highest available quality available for your video. Lower resolutions will be generated automatically by the

website.
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M— You Tube

Resolution: 720p HD

Browse

Canoel

Step 4: Fill in the details

1. Fill in the title and description for your video.

2. Add some tags to help users find videos by relevant topics. Separate tags with commas.
3. Choose a category to help viewers find relevant content.

4. Open the Privacy box and choose who you want to see the video:

* Private — only you can see the video.

+ Unlisted - the video will not appear for other people unless you give them the link.

* Public — anyone can access the video.

You Tube

720p HDx r

Firn & Anirmation ‘

w

E:\Temp\Videos Browse

Canoel

Step 5: Save and upload the video

1. Before uploading, you can save the video to disk to keep all the editing and settings. To do that, enable the &Ml Save to box. To change
where the video file is stored, click Browse and select a folder.

Hint: by default, the option is disabled. Remember: the original recording is automatically saved in the MKV format in your output folder.
2. Check the length and size of the video. YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to
verify your account.

YouTube help — increasing your upload limit &

3. Click Start to begin saving and uploading the video.
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ScreenRecorderProject11| Resolution: 720p HD

Firn & Animation
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Using the Video Editor
After you've captured your screen, you can immediately send the video to Movavi Video Editor. To do that, click the Open in Editor button at
the top of the player window:

is Open in
Editor

Tools

See also:
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Cutting video in the Editor

Editing tools
Saving video in the Editor

Screen Recorder preferences
To open the program settings for Movavi Screen Recorder:

1. Open the Settings menu.
2. Choose Preferences.

Capture Effects Media Files Settings Help

Language » G o0: 00: 0o

Capture Area udio
I Preference.s...k[:trlw I

Custom

< @

000 5 X 434 %

The preferences are organized into eight categories: General, Files, Keyboard Shortcuts, Video, Webcam, Effects, Scheduler and Sharing.

General preferences
The General tab allows you to change the basic behavior of the program. The settings are organized into two groups for your convenience.

Basic settings

Basic settings

Interface anguage:

English

¥ Disable countdown
Show capture control panel during recording
Disable frame blinking during capture

Video " Allow window panes selection

Capture separate streams

Webcam " Enable sound notifications

Maore

Scheduler

Sharing Cancel

Disable countdown
Every time before the recording starts, you will see a 3-second countdown. This gives you time to prepare for your recording. Select this
option to turn the countdown off and start recording immediately.

Show capture control panel during recording
The capture control panel will appear on top of the capture frame while recording a video. You can use it to pause or stop capture, take a
snapshot, or see how much space the recording has taken up. If you are recording a full screen video, the panel will not be visible.

Recording [00:00:06 / 171.1 KB] L

Disable frame blinking during capture
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In case the blinking irritates you, check this box. The frame will stay still during recording.

Allow window panes selection
To record only the main window panes (no frames, menus or browser tabs), Movavi Screen Recorder needs access to your screen.

Capture separate streams
When recording a video, the webcam, main onscreen video, external audio, etc. will be recorded as separate streams, like layers.
This can be useful for editing the video later, so you can edit them separately.

Enable sound notifications
The program will notify you when a screenshot has been taken, a file export is finished, or if an error occurs.

Other settings

General Basic settings
More

v Launch application at startup

X Use software OpenGL implermeantation

Keyboard

Shortcuts A caun avkanded lnnc £ar fronhlachnati
Save extended logs for troubleshooting

Autormaticaly check for updates

Video

I give consent to send anonymous usage stats to Movavi

Webam Disable Aero theme during capture

Use Direct® for capturing

Scheduler

Sharing Cancel

Launch application at startup
With this option enabled, Movavi Screen Recorder will start when you log in and run in the background. This way you will always be ready to
capture your screen.

Use software OpenGL implementation (advanced)
This option can troubleshoot OpenGL problems for some graphics cards.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

Save extended logs for troubleshooting

In case you experience trouble using the program and contact our support team, they might ask you to collect logs. The logs contain the
program's actions for some period of time, as well as important error reports and descriptions. Extended logs give the most amount of
information which may be essential to solving your problem.

Automatically check for updates

The program will notify you if a new version is available. Minor updates are absolutely free (for example, from v.1.3 to v.1.4). For major
updates users with purchased Movavi Video Suite license will get a considerable discount.

| give consent to send anonymous usage stats to Movavi

Enabling this box will allow Movavi Video Suite to send us anonymous data about how you use the program. This data does not contain
any personally identifiable information and is only used for improving our software. You can find more information about how we use the
statistics on our Movavi Improvement Program page.

Disable Aero theme during capture

Windows Aero themes that use transparency require more processing power. This may slow down your computer while recording video.
With this option enabled, the program will disable the Aero theme while recording to improve performance. The theme will be restored after
recording has finished.

(For Windows Vista and Windows 7)

Use DirectX for capturing

Try this option if you are experiencing problems capturing some program windows. In Windows 8 and above, the capture method is chosen
automatically and this option is unavailable.
(For Windows 7 and earlier)
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Use alternative capture mode

If you get an error message when you start or stop recording your screen, try this option. If the problem isn't solved, click here to read full
troubleshooting instructions.

(For Windows 8 and above)

File preferences
In the Filessection of the preferences, you can change where your captured files are stored. To change a folder location, click the icon with

the dots and select a new folder: !

General Save output videos to:

E:\Temp\Videos)

Delete original recording after saving

Save screenshots to:
E:\Temp!,
Video Default screenshot format:
PNG ¥

Webcam

Scheduler

Sharing Cancel

Save output videos to...
This is where all your video recordings are saved.

Delete original recording after saving
If you save the recording in a different format, or trim the file, the original will be deleted.

Save screenshots to...
This is where all your new screenshots are saved. You can also find your recent screenshots in the editor window.

Default screenshot format

Here you can change the format for all new screenshots. You can also change the format for a single screenshot by using the Save As button
in the editor window to save a copy with a different format.

Keyboard shortcuts

The Keyboard Shortcuts tab allows you to set your own custom shortcuts for such actions as starting or pausing the capturing process. On
the right, you can see keyboard shortcuts for every action.
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Click in the Keyboard Shortcut field and press the key combination that you want to
assign to the menu command.

General:

Start/stop capture

Keyboard
Shgrrt::uts Pause/resume capture Fo

Take a screenshot Print Screen

Webcam

Resat to Default

Seheduler Disable keyboard shortcuts

Sharing

To change one of the shortcuts:

1. Click inside the box with the shortcut you want to change. The box will become blank.
2. Simultaneously press on keyboard the keys you want to use as a shortcut to the selected action. The box will now display your custom
shortcut.

3. Click OK to apply the changes. To reset all the keyboard shortcuts to their original state, click the Reset to Default button.

If there's a keyboard shortcut you want to use in other software while Movavi Screen Recorder is running, check the il Disable keyboard
shortcuts box.

In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.

Video preferences

On the Video tab, you can choose how the videos are recorded and saved, change the preferred audio quality, including the sample rate,
number of channels, and bits per second.

Output frame size:

Full Size
Audio quality:

44.1 kHz, stereo, 16-bit

Video
Enable SuperSpeed conversion

'.I.'-_,' [=} |:| cam m
GRAPHICS

- M NVIDIA.
Effects ; S yenc

ao VCE |

Scheduler

Sharing Cancel

Frame rate
The frame rate defines how many frames will be captured each second and affects the smoothness of motion in the video. A lower frame

rate will result in smaller output size, however, the video may not turn out as smooth. The recommended frame rate is 20-30 frames per
second.

Output frame size

Usually, your desktop is recorded at full size. This option allows you to reduce the original video quality to 1/2 or 1/4 of the original. The video
file will have lower quality, but take up less disk space. This can also improve performance while recording on slower computers.
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Sample rate

The first number is the audio sample rate, measured in Kilohertz (kHz). This is the number of digital samples taken each second to record
sound. Higher sample rate usually means higher quality. 44.1 kHz is the recommended sample rate, which corresponds to the human
hearing range.

Channels
Mono uses only one audio channel, which saves some disk space.
Stereo uses two audio channels, which allows distinguishing the direction a sound is coming from and usually sounds more natural.

Bit depth
Screen Recorder will record audio at 16 bits, which is the standard bit depth for most audio recordings. This means that every sample
contains 16 bits of information to encode sound.

Enable SuperSpeed conversion
This option will make saving videos faster if you use the same output video codec. For example, if you cut the video without changing the

format. Formats that work with SuperSpeed are marked with these icons: k& or Kk in the list. If you're having problems with saving some

files, try disabling this option.

Enable Intel hardware acceleration
This option will make saving videos faster if your computer is equipped with a compatible Intel® graphics chip. Intel acceleration works
when processing H.264, MP4, and MPEG-2 videos.

Enable NVIDIA GPU acceleration

This option can make saving videos faster by using the graphics card to process media files. This leaves the CPU free for other tasks and
improves performance while saving videos. This option is only available if you have an NVIDIA® graphics card compatible with the NVENC®
or CUDA® technologies.

Enable AMD acceleration
This option is meant for the same purpose as the ones above: it allows to save videos faster, too, but this time you need an AMD graphics
card to use the acceleration.

Webcam preferences
The Webcam section of the preferences allows you to set up your webcam for recording it on top of the main video.

General Use this webcam:
Microsoft LifeCam HD-3000 A4 q
Resolution: 3 ’
40 x 360 ¥ Fy
;-/
Frame rate: ]
30 Settings

Video
Video size:

Position:
Upper left Upper right

Lower left & Lower rig ht

Scheduler

Sharing Cancel

Enabling the webcam
1. Connect the camera to your computer and wait until your system installs the necessary drivers.
2. In the Webcam preferences section, select the camera you want to use from the 'Use this webcam' box.

If the camera does not appear in the list, try manually installing the driver that came with your camera. You can use the preview square on the
right to check that the camera is working properly.

Webcam properties

Clicking the Settings button will open the camera's properties. These properties are different for each manufacturer, but generally you can
use them to calibrate the brightness, contrast, and exposure of your camera.

Resolution

The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable
decrease in quality.

Frame rate
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Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work
best for videos with a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is
20-30 frames per second.

Video size
Use the video size slider to set the size of the webcam overlay relative to the main video.

Position
Use one of the position options to choose where your webcam overlay will be placed on the original video.

Effects

In the Effects section of the preferences, you can set up the visibility of your mouse and keystrokes.

General Cursor options:

+"  Show cursor on recording
+  Highlight cursor:
Size:
Keyboard Highlight clicks:

Shortcuts
1] [ L]

Mouse click sound:

Webcam
Keystroke recording options:
Do not capture keystrokes
® Keyboard shortcuts only

scheduler All keystrokes
SLNTEUUE

Sharing

Cursor options
Select &l Show cursor on recording to make the cursor visible to your viewers.

Highlight cursor

This option will add a bright circle around the mouse cursor to make it more visible.

1. Select the Highlight cursor option.

2. Click the square on the right to choose the highlight color. Use the Alpha channel box to change its opacity.
3. Use the size slider to change the size of the highlight circle.

Hint: hover your mouse over the preview square on the right to see how it will look on the recording.

Highlight clicks

This option will flash a circle around the cursor for every click. You can set two different colors for the left and right mouse buttons.
1. Enable the Highlight clicks option.

2. Click the left square to set the color for the left mouse button.

3. Click the right square to set the color for the right mouse button.

Mouse click sound

A clicking sound will be played every time you click the mouse to draw attention to your actions.

1. Enable the Mouse click sound option. The default mouse click sound will be used.

2. (optional) If you have a file with a different sound effect you want to use, open the box under 'Mouse click sound and choose Add sound.
Then, open the audio file with the sound effect. You can use WAV, MP3, AIFF, and AU files.

Keystroke recording options

+ Keyboard shortcuts only — only functional keys and key combinations (for example, Alt+Shift, or Ctrl+C) will appear on the video.
« All keystrokes — all key presses, including letters of the alphabet, will appear on the video.

Hint: avoid entering passwords when this option is enabled if you don't want everyone to see your password.

Scheduler

In the Scheduler section of the preferences, you can start and stop recordings automatically.
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General Do not schedule recording
Set time limit for recording

Schedule recording

@ﬁ¥bﬂmﬁ

10/08/2018  19:20:47  00:00:05
Video

10/15/2018 19:20:47 00:00:05

19:20:47 00:00:05

Webcam

+ Add Task

Scheduler

Sharing

Automatically ending a recording

1. Select the "Set time limit for recording" option.

2. Enter the duration of the recording as hours: minutes: seconds.
Learn more: Time limit

Scheduling a recording

To start and end a recording automatically:

1. Select the "Schedule recording" option:

2. Click "Add Task" button.

3. Fill in the details and click Create to add your task to the recording schedule.
Learn more: Scheduling

The Screen Recorder application must be running at this time for the recording to begin. To make sure you don't miss it, enable the "Launch
application at startup” option in the General section.

Sharing preferences
The Sharing tab allows you to manage your YouTube accounts used to upload videos to.

General

Video

Webcam

Scheduler

Sharing Cancel

To sign in to your YouTube account:
1. Click Sign In. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Screen Recorder upload videos.

Capture video
Follow the steps below to record video from a camera that's connected to your computer.
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Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is
working correctly.

Step 2: Open the Movavi Video Suite launcher window and click Capture from cameras, VHS, TV on the Video tab.

i & @

¢ settings

& Movavi Video Suite 18

(™ video

! Edit video

Audio

Convert video

Phota

| Record com puter screen

Capture from cameras, VHS, TV

User Guides

Watch video

Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and frame rate. A
larger resolution will be able to retain better quality, however, the video file size will be larger. A higher frame rate is necessary for recording
motion, while static scenes can be captured with a lower frame rate.

Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.

H o @
Captre solfinags

Video capture device:
Live! Cam Chat HD VFO720 L
Resolution: Frame rate:

Default ¥ 30 L]

Audio capture device:

Microphone (3- Logitech USB Hea v

View saved files

Start Capture

Step 5: (optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them somewhere else, click the

folder button under 'Save files to' and choose a different location.

Step 6: (optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file
name template.
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Save files to:

USERNAME\Videos\Movavi Library Ty

File renaming:

Add date

Start Capture

View saved files

Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button on the right.

Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.

View saved files

Start Capture

Import AVCHD
Follow the steps below to import previously recorded videos from an AVCHD camera.

Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera. Make sure that
the system recognizes the device and that it is working correctly.

Step 2: Open the Movavi Video Suite launcher window and click Import AVCHD on the Data tab.
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Movavi Video Suite17

Video
Audio Import AVCHD

Photo
DEIE]

Burn image to disc

Extras

Caplure selttings
Video capture device:

Sony Camcorder

Saving captured files

Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't need.

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere else, click the

folder button under 'Save files to' and choose a different location.

Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file
name template.

Step 7: Click Export files to start copying the files. This may take a while depending on the size of the videos.
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Caplure Sellings

Saving caplured files

Export Files

Capture audio
Step 1: Connect a microphone
Connect a microphone to your computer and make sure that it is recognized by the system.

Step 2: Open the audio recording module
Open the Movavi Video Suite launcher and click Record sound. The audio recording module will open in a separate window.

o e

Capture settings

finkion Audio)

3vi Video Suite 18

Convert audio ,
aptured files

Record sound

Bum audio to CD

User Guides

Play music

Step 3: Set up audio capture

In the Audio capture device box, choose the microphone or whichever device you want to use for recording sound. To record audio that is
playing on your computer*, choose 'Stereo MixX or 'Speakers .

* Depending on the model of your audio card, this option may be named differently. Some device manufacturers do not include a system
audio recording option.

In the Saving captured files section, you can choose a template for naming the captured files. To do that, open the File renaming box and
choose date or free text. Then, fill in the template details and the recordings will all be named after this template.

Under Save files to, specify the folder where you want to save the recordings. Click the folder icon next to the box to browse for the folder
you need.
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& e
Capture settings

Audio capture device:

Microphone (3- Logitech USB Hea ¥

Saning captured files
Save files to:

C:\Users\USERNAME\Videos\Movavi Library Falr
View saved files

Start Capture

Step 4: Record
Click Start Capture to begin recording. As you record sound, you can see the frequencies reflected as color bars in the center. When you're

done, click Stop Capture. If you need to record more audio clips, simply repeat this step.

The audio files will be saved to the folder specified in the 'Save files to' box. To open this folder, click the View saved files button.

Saning captured files

ERHAMEYVidesos Movare Library

View saved files

Start Capture

Split video
Split Movie is a lightweight program for quick video editing. With it, you can cut a video file into small scenes or cut out any number of
unwanted parts like commercials. To open the video splitter, click Split video on the Video tab of the Movavi Video Suite launcher.

& Movavi Video Suite 18

(&) Video —

Edit video
Comvernt video

) Record computer screen
Data

Mes |

Extras N I Capture from cameras, VHS, TV

Lkser Guides

Split video

Step 1: Open a video
To open a video file, simply drag it onto the Split Movie window.
Learn more: Open videos
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Step 2: Edit the file
Use the Scissors button to cut the video into scenes, then select the scenes you want to remove and click the trash can button.
Learn more: Trim from the edges | Split scenes | Cut out parts

Step 3: Save the result
In the bottom right-hand corner, choose As separate files to save each scene to its own file, or choose As a single file to save
the entire video minus the deleted scenes to one file. Then, click Save and select where you'd like to place the new file(s).
Learn more: Saving the result

How to split video
The splitting module allows you to quickly split a video file into parts or cut out fragments without reconverting the file or any quality loss.

Launch the splitter
In the Movavi Video Suite launcher, click Split video on the Video tab.

& Movavi Video Suite 18

® video

Edit video
Audio

Convert video

Record computer screen

Extras - Capture from cameras, VHS, TV

User Guides

Split video

Watch video

Open files
To start cutting videos, click Open file in the middle of the window and choose a video file.

Learn more: Opening files

& Openfile

Split scenes

To cut the video into several scenes, place the position marker where you want to cut scenes and click the scissors Ead button. Repeat this
for all scenes in the video.
Learn more: Splitting scenes
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Resulting dips

3¢ T 2. Click the scissors

Cut out unwanted fragments
To remove a fragment from the video, place the position marker onto the beginning of the fragment and click the scissors Ead button. Then,

do the same for the end of the fragment. When the fragment is separated, select it and click the trash can Ll button to remove it.
Learn more: Cutting out parts

»= 1. Cut beginning and end  ---~

“« > M) > |L 1| @ [« 2-Reject fragment

Save the result

In the bottom right-hand corner, you can choose how to save the resulting clips:

+ To save each scene as a separate file, select As separate files.

* To save all scenes to a single file without the deleted fragments, select As a single file.
Then, click Save to start processing the video.

Learn more: Saving the result

Save clips:
® As separate files

As a single file

i > M o) ) Save

Opening files
To open videos, do any of the following:
* Find a file in Explorer and drag it onto the Movavi Split Movie window.
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« Click Open file in the center of the window and choose the file.
* Open the File menu and choose Open File. Then, choose the file you want to cut.

¢ Openfile

Playback

After you've opened the video, you can use the playback tools to find where you need to cut the video.

How to position the playback marker:

* When you play the video, press the spacebar to stop the video when you see a scene border.

* Use the Previous frame / Next frame buttons on the toolbar to move the position marker by one frame.
* Use the timeline scale above the seek bar for reference.

Timeline scale

000 00:00=14.960

Previous frame :
(Left arrow)

| | |I:C|'Il]'.1"§'-!ll'0
¥ " I

e T Nl
00:01:10

Next frame o
r |7 Position marker -

i Rl el bn (Right arrow)

Play / Pause
(Space)

Jumping to a specific time:

1. Open the Playback menu and choose Jump To.
2. Enter the exact time and click OK.

The position marker will move to the specified time.

Playback Edit Settings Help
"‘ Play/Pause Space
P Jump to... k. Ctrl+T
"'I Mext Frame Right

I" Previous Frame  Left

Jump to:

QK Cancel

Cut out parts
Follow these steps to cut out an unwanted fragment from the video:

Step 1: Move the position marker to the beginning of the unwanted fragment.

Step 2: Click the scissors button.
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1. Find the beginning

J{tl 000000 ‘ | oo idsed | | | 0000 25300

00:00:11 l * 00:01:10

i > o) x [ 1 i -y

Step 3: Move the position marker to the end of the unwanted fragment.
Step 4: Click the scissors button again. The fragment is now separated from the rest of the video.

3. Find the end

makma | 0000 14,960 i T S 26500 o Bt
1 i 1 1 1 1 [ 1

O0=00:30

' ‘

M > » W) )

000021

000000000 | 000 4 PT | . |'Il 0 20500

. 000110

< > » ) YI1C|]

Repeat these steps for all other unwanted fragments in the video. After you're done, don't forget to save the result.

See also:

Opening files
Saving the result

Liking a scene
You can quickly mark fragments as you play back the video.

Like a fragment — Press L to play the video and keep the fragments you pass.

Dislike a fragment - Press K to play the video and reject the fragments you pass.

00:00:51 00:01:10

||;i:|:|:|}l:|;|_:..|:|;||:- | i ||:|;|:|:|;!:|,4~_15::| I I |.-_|;..g_|;.l.zg_g;-;| I | |mm47 [ | I:I:I:I:i:ll:sl_lati:l

You can change these keys in the Keyboard Shortcuts window.

Using the brackets
Using the bracket buttons, you can mark the beginning and end of each scene. Using the brackets works best if you only need to keep a
small part of the video.

|oeokonme 0000 14,960
: ]

A » pl o)

L

. The Left Bracket marks the beginning of a clip, rejecting the parts before it.

The Right Bracket marks the end of a clip, rejecting the parts after it.

Trimming from the ends
To trim the video from the beginning or from the end, click on the seek bar and pull on the markers on the edges:
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Splitting clips

Step 1: Move the position marker to the beginning or the end of a fragment.

Step 2: Click the scissors button to make a cut.

Repeat this for other fragments that you want to cut into separate files. After you're done, don't forget to save the result.
1. Find the place

|n‘.¢-r.|::-r.|:u:l::: i |:|!|b:r|4':¢'ﬂ i T‘Mﬂ:ﬂ [ BT
] 1 1 J 1 1 1 1

00:00:30

' ‘ 0:0110

< > » o) o

See also:

Opening files
Saving the result

Editing clips

After you've cut the video into clips, you can edit each clip for more precise splitting.

Editing clips

To change the left and right borders of a clip, do any of the following:

+ Click on a clip and drag the white markers on its edges to change its length.

* Click on a marker and press the left or right arrow keys to move it by exactly one frame.
+ To move a clip, select it and drag it by the center.

Edge markers

I':llilil:lflll:l:l: i 00 14960 i | TUCTEE RN Ta i ||:I:|-:|:rl'.’ﬂ:-'-=l-u|: i
00:00:40 . 0020110

00:00:21:401

> ) e @ - y
Current time

Setting exact time
In the Resulting clips column on the right, the exact beginning and end time is listed for each clip. Click the time and manually enter the new
time into the box.

Resulting clips

00:00:00.000

00:00:08.917

00:00:31.337

Discarding clips
To discard an entire clip, select it on the Timeline on in the Resulting clips column and click the trash can button.

| et -]
t 00:01:10

i » » o)

Merging clips

To merge two or more clips into one contiguous clip:

1. Select the clips you want to merge on the Timeline or in the Resulting clips column. Hold Ctrl to select multiple clips.

2. Right-click on the clips and select Merge from the pop-up menu. All of the selected clips (as well as any rejected fragments between them)
will be marked as one single clip.
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Resulting clips

00:00:00.000
Delete
Delete All
Merge k‘

File Information

Inverting clip selection

Open the Edit menu and select Invert clips in the pop-up menu. This will invert the selection for the entire file, meaning that previously
rejected fragments will be saved, and selected parts will be rejected.

|rx|:|x!:lxu;q:|

oy |mm|zi-..':—3|: [
00:00:38 + 00:01:10

|nc':m:m-:n:| 00l |mr:-1:-s.m ' |

00:00:38 00:01:10

Resetting clip selection
If you want to start over, click the Reset button on the toolbar or right-click in the Resulting clips section and select Delete All.

|b:rlfl?HfIZI-lfIZI: ! |-:¢l?¢-|4'il:i':| . | |fl!ID:ri'H."'tl ITI |-:I!Ib:rﬂm
1 1 1 1 1

00:00:40 00:01:10
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Saving the result

After you've split the scenes and removed unwanted fragments, you'll need to save the resulting clips. The saving options are located in the
bottom right-hand corner of the window.

Step 1: Select how you want to save the file
« If you want to cut the video into several files, select As separate files.
« If you want to save the video as a single file without the rejected parts, select As a single file.

Step 2: Click Save.

Resulting cdips

Save clips:
® As separate files
As a single file

4 > i) . Save

Step 3: You may be asked to choose a folder for saving the video. Click the folder icon in the dialog box to change the folder. Click OK to
start saving the resulting clips.

Hint: If you want to keep using this folder, choose Always save to this folder without asking. You can always change this option on the Saving
tab of the Preferences.

Destination:
C:\Users\1\Videos\Movavi Library

' Always save to this folder without asking

Cancel

Keyboard shortcuts
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For faster editing, the most commonly used actions are bound to shortcuts or hotkeys.

To open the list of shortcuts:
1. Open the Settings menu.
2. Select Keyboard Shortcuts.

To change a shortcut:
1. Double-click the field next to the action you want.
2. Press the key or key combination you want to use.

Note that some key combinations may not work because if they are used by your system.

Action

Reject Fragment
Dislike a fragment
Exit

Save as one file

Save as separate files

Jump To Specific Time
Invert Clips

Mark Clip Beginning
Like a fragment

Next frame

Open File...
Play/Pause

Previous frame

Shortcut
Del
K

Ctri+Shift+]
Ctri+5hift+5
Ctri+T
Ctrl+I

Ctri+[

L

Right

Ctrl+0
Space

Left

Cancel

List of keyboard shortcuts

Splitter preferences
To open preferences, go to the Settings menu. The options are sorted into two tabs at the top.

General
Language - Changes the interface language.

Automatically check for updates — Whenever a new version is available, you will be notified when you start the program.
Send anonymous usage stats to Movavi - Lets the program collect statistics about how you use the program. The data does not contain

any personally identifiable information and is only used for improving our software. You can find more information about how we use the
statistics on our Movavi Improvement Program page.

Use software OpenGL implementation — this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

If Movavi Split Movie runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting

General Saving

Language:

English

Autormatically check for updates

Send anonymous usage stats to Movavi

lUse software OpenGL implernentation

Cancel

Saving
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Destination folder - this is where the resulting files will be saved by default. To change the location, click the folder icon Con the right.
Always save to this folder without asking - if this option is disabled, you will be prompted to choose a folder every time you save videos.
Play notification sound when splitting is finished - a sound will play when the resulting clips have been saved.

General Saving

Destination Folder:

C:\Users\1\Videos\Movavi Library

« Always save to this folder without asking

« Play notification sound when splitting is finished

Cancel

Play video and audio
With the Movavi Video Suite player, you can play video and audio in any format without having to install any additional codecs or software.
To open the player, click Watch video in Movavi Video Suite launcher on the Video tab.

& Movavi Video Suite 18

® Video

|: 1 Edit video
Audia

Convert video

R o IZ_I O 'IF_H_Jr. er SCreen

Extras st Capture from cameras, VHS, TV
L

Uger Guides
I I |_ | Split video

Watch video

Or click Play music on the Audio tab.
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& Movavi Video Suite 18

Video

d" Audio \ Convert audio

Photo
"o

Record sound

Extras .
Burn audio to CD

User Guides

Play music
Y

Opening files
To open video or audio files, click the buttons in the bottom right, under the playlist.
+ File to open individual files
+ Folder to open all the files in a folder
+ DVD to select a disc with videos. You will need to find the VIDEO_TS folder on the disc.

Or you can simply drag any files you want to play right onto the player window.

ik

Movavi

: g’“ Media Player

WWW.movavi.com

=+ Folder <+ ovD

Playback

Basic playback buttons

Movavi

Media Player

www.movavi.com

Play / Pause Fullscreen mode

+ Foider 4+ DVD

Previous file | Next file |

Skipping frames
On the toolbar, click Skip forward m or Skip backward m buttons to skip 10 seconds forward or backward.
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Playlist buttons

The playlist displays your media queue. If you want to jump to another item, double-click it in the playlist to play.
To show or hide the playlist, click the List button E on the toolbar.
To play all items in random order, click the Shuffle button .

. . T 'S
To play the same item again and again, click the Repeat button .

Adjust video
In Movavi Video Suite, you can adjust brightness, contrast, hue and saturation of the video.

Step 1: Open Video Adjustments dialog box
Click the Adjust video button on the toolbar.

The Adjust video button
Step 2: Adjust video
Hold your mouse on the markers and drag them left or right, depending on the changes you want to make. Release the markers to see how
your video has changed.

Brightness
Contrast

Hue

Saturation ® 20

L'
T T T

e

If you are satisfied with the results, click Apply to save your settings.

Change audio track
In Movavi Video Suite, when you watch a video with two or more audio tracks, you can easily switch between them.

In the menu, click Audio and select Audio Track in the pop-up menu. A list of available audio tracks will appear. Select the one you need. You
will hear it immediately.

File Playback Video [Audio Subtitles View Settings Help

Audio Track 1) rus [AC3)

Volume Up  Ctrl+Up 2) ukr (AC3)

Volume Down Ctrl+Down v 3] eng (DTS)
MALLe i

Subtitles

Changing subtitles track
In the menu, click Subtitles and select Subtitle Track in the pop-up menu. A list of available subtitle tracks will appear. Select the one you
need. You will see it on screen immediately.

File Playback Video Audio |Subtitles | View Settings Help
Subtitle Track » Mo Subtitles
Synchronize Subtitles * Track1 -rus
Align Subtitles 4 Track 2 -rus
Track3 - rum
v Track4 -eng

Add Subtitle File...

To load subtitles from a file, select Add Subtitle File on the list.

Subtitle timing

208



You can adjust your subtitle timing in case you notice it's off track. In the menu, click Subtitles and select Synchronize Subtitles in the pop-
up menu. A list of options will appear. Select the one you need. (For example, clicking +5 seconds will make subtitles appear on screen 5
seconds later than before).

File Playback Video Audio |Subtitles View Settings Help
Subtitle Track

Synchronize Subtitles *| v  Default
Align Subtitles * +5 seconds  Cirl+PgUp
-5 seconds  Cirl+PgDown

+0.5 seconds  Ctrl+W

-0.5 seconds  Ctrl+Z

Subtitles positioning
To move subtitles, click Subtitles in the menu and select Align Subtitles in the pop-up menu. A list of positioning options will appear. To set
subtitles to a certain part of the screen, choose Top ... Right. Clicking Move up ... Move right will slightly move subtitles around the screen.

File Playback Video Audio |Subtitles View Settings Help

Sulbtitle Track k

Synchronize Subtitles »

Align Subtitles b v Default
Top
Center Vertically

Bottom

Left

Center Horizontally

Right

Move up Alt+Up
Move down Alt+Down
Move left Alt+Left
Move right Alt+Right

Burn files to disk
With the Burn Disc application you can burn videos to DVDs, create audio CDs, copy discs and burn any kinds of data to a CD, DVD or Blu-ray.

i Movvavi Video Suite: Bumn Di w

:FI|E Edit Pluging Downboad Help

Widea CD
Super Video (D

-

& VD

WIDEQ TS to DNDY
AWCHD: DVD

Blu-ray Videa

My friends
Edit .. Cptiers

& NTSC
Qualty:
_Mbch.m
CLiton
Aspect Ratio:
4 _-1:3-Hnrde\'aspec!ral:\o -

Disc Type:
My vacation VD (4.7 GbY -
Edit .. OVD Menu Template:

Fang

Cur wedding

Winter holidays ¥ 3F | "r“.
4 Y

| J I (A (N N N I (R I . Save Disc Burn Disc
nGe 1GB 2GB aGE 4GB

How-to's:
Burn videos to DVD

Burn an audio CD
Burn data to disc
Burn ISO image to disc
Copy disc to disc
Rip disc to hard drive

Step 1: Add Files
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1. In the Video tab of the Movavi Video Suite launcher, click Burn CD, DVD, Blu-ray to open the Burner module. The ChillBurner module will
open.

2. Drag and drop the files you want to burn from Windows Explorer onto the ChillBurner window to add them to the disc queue.

Step 2: Choose Disk Type

1. In the Mode section on the right, choose the type of disc that you have. Disc type and capacity should be printed somewhere on the disk
itself or on its packaging.

2. Then, choose video options for the selected disc type.

NTSC or PAL - select the TV standard depending on the DVD player you have or the country you live in.

* NTSC is used in North and Central America, most countries of South America (excluding Argentina and Brazil), Burma, Japan,
the Philippines, South Korea, Taiwan, and Vietnam.

* PAL is used in all countries of Africa, Europe, Oceania, and the Middle East, most Asian countries, as well as in Argentina,
Brazil, Paraguay, Uruguay, and French Guiana

Quality - this parameter affects video and audio bitrate. Higher quality requires more disc space.

Aspect ratio — the ratio between the width and height of the video's frame. 4:3 is the standard format used for TV, while 16:9 is used
for widescreen movies.

Disc type — select DVD if you have a regular DVD disc, or DVD DL if you have a double-layer DVD (it should be written somewhere on
the package your DVD came with).

DVD menu template — select a graphic DVD menu, which is the first thing you see when you open a disc on your player, and where you
can select which file to play.

| e £t Plugn Oownigad  Hep

e |
w - - - | e e Wy
&l || -

T " ‘
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fushn '] Cop

Guper Ve CD
= oo
VIDED T4 w WD
SACHD WD
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& HTSC BaL
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41 - Mormal TV sspect rabo
o Ty
DV 4. 7 G
[VWTH P Templa e

Step 3: Burn Disc

1. Check the disc capacity scale at the bottom. If the blue line crosses into the red, it means that there is not enough space to fit all of the
added files. In that case, you can either set a lower quality, or write some of the files to another disc.

|
nGe 1GB 2GB 3GB 4GB

Disc capacity scale
2. In the upper right-hand corner of the window, enter a name for the disc. It will show up in My Computer when you view all your drives.

3. Make sure that a writable disc of the selected type is inserted into the drive, and your hardware supports disc writing.
4. Click Burn Disc to begin recording the files to disc. This may take a few minutes.

How to open the burning module

Burn audio:
In the Movavi Video Suite launcher, click Burn audio to CD on the Audio tab.
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& Movavi Video Suite 18

Video

d° Audio

Photo

Extras

User Guides

Burn CD/DVD/Blu-ray video:
Click Burn disc on the Data tab.

Convert audio

Record sound

Burn audio to CD

Play music

& Movavi Video Suite 18

Video

Audio

Photo

Data

Extras

User Guides

Burn ISO to disk:
Click Burn image to disc on the Data tab.

Import AVCHD

Burn disc

Burn image to disc

Copy disc to disc

Copy disc to hard drive
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& Movavi Video Suite 18

Video
Audio
Photo
Data
Extras

User Guides

Copy disk to disk:
Click Copy disk to disk on the Data tab.

Import AVCHD

Burn disc

Burn image to disc

Copy disc to disc

Copy disc to hard drive

& Movavi Video Suite 18

Video
Audio
Photo
Data
Extras

User Guides

Copy disc to computer:
Click Copy disk to hard drive on the Data tab.

Import AVCHD

Burn disc

Burn image to disc

Copy disc to disc

Copy disc to hard drive
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& Movavi Video Suite 18

Video

Import AVCHD
Audio

Photo Burn disc
Data

Burn image to disc
Extras

User Guides Copy disc to disc

Copy disc to hard drive

Burn a video DVD
Step 1: Open the Burn Disc application in Video mode
1. Click Burn disc on the Data tab of the Movavi Video Suite launcher app.
2. The Burn Disc application will open. There, click on the Video tab at the top.

Step 2: Choose your disc type
In the Mode section of the right-hand column, choose DVD mode.

B Movavi Video Suite: Burn Disc (40-Day Trial Version) ‘ =aifod

File Edit Plugins Download Help

%) Video CD

*) Super Video CD
@D

) VIDEO_TS to DVD I
(©) AVCHD DVD

© Bluay Video

pions:
@ntsc OPAL

|2

2|8

iq
I<

Custom

m\_ﬁh L INTO THIS AREA | s

43 -Normal TV aspect ratio  +

N Decipe l

(]
I I

DVD (4.7 Gb)

DVD Menu Template:

3P
174 N

s .‘|“‘|““-‘w‘-|w\|w| Save Disc Burn Disc

O - 0GB 168 268 368 468

Ready

Step 3: Add the files you want to burn
+ Drag-and-drop files onto the ChillBurner window, or

* In the bottom left-hand corner, click the plus icon % t0 add a file, or the folder icon © to add the contents of one or more folders to the list.

Step 4: Set up your disc preferences
Set the following preferences in the right-hand part of the window:
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Disc name — located at the very top of the panel. You will see this as the name of the disc drive when you insert the DVD into your computer
or DVD player.

NTSC or PAL - select the TV standard depending on the DVD player you have or the country you live in.

+ NTSC is used in North and Central America, most countries of South America (excluding Argentina and Brazil), Burma, Japan, the
Philippines, South Korea, Taiwan, and Vietnam.

* PAL is used in all countries of Africa, Europe, Oceania, and the Middle East, most Asian countries, as well as in Argentina, Brazil, Paraguay,
Uruguay, and French Guiana

Quality - this parameter affects video and audio bitrate. Higher quality requires more disc space.
Aspect ratio — the ratio between the width and height of the video's frame. 4:3 is the standard format used for TV, while 16:9 is used for

4:3 |16:9 ]

Disc type — select DVD if you have a regular DVD disc, or DVD DL if you have a double-layer DVD (it should be written somewhere on the
package your DVD came with).

DVD menu template — the DVD menu is the first thing you see when you open a disc on your player, and where you can select which file

to play. The ChillBurner module allows you to select and customize professional-looking DVD menus. By default, only one theme will be
available, but you can select Download More Themes from the list and download additional themes from our official website. If you want to
customize or preview the selected theme, click Edit. You will see the following window:

Edit VD Me

DVD Title: Vacation

Loop video inside a theme: Audio: Templates\Road Trip\Sound.ogg

5sec 40 sec

u Volume: u

Here, you can set the time for the previews of each video and change the music that will play in the menu. Click OK to apply the changes.

Step 5: Burn disc
At the bottom of the ChillBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill when you
record the videos, while the yellow and red lines display the maximum capacity of the selected disc type.

0GB 1GB 2GB aGB 4GB

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete files from the list or slightly reduce quality.
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Then, check that you have a writable DVD in your DVD drive and click the Burn Disc button to begin the burning process. Your disc will be

ready in a few minutes.

Burn Disc

Burn an audio CD
Step 1: Open the Burn Disc application in Audio mode
Click Burn audio to CD on the Audio tab of the Movavi Video Suite launcher app.

Step 2: Choose audio disc type

In the Mode section of the right-hand column, choose Audio CD or MP3 CD mode. Standard audio CDs usually fit about an album's length of
music, but can retain quality very well, while MP3 CDs allow you to record several folders of audio files to one CD. Please note that not all CD
players support MP3.

Step 3: Add the files you want to burn
+ Drag-and-drop files onto the ChillBurner window, or

* In the bottom left-hand corner, click the plus icon 7 t0 add a file, or the folder icon © to add the contents of one or more folders to the list.

Step 4: Set up your disc preferences
On the right panel of the ChillBurner interface, set the following preferences:

(12 Mo veo S

[ Fie | fit Bugns  Downioad Heip

1 Besthowan's Symphony Ne. 9 (Scharzn)
2 Kabmba

1 K ol P - e i Wharld

4 Maid with the Fleoms Hair

3 Sheep Sy

6 Seng of the Wind

7 The Blees Quartet - Evening Bues

B Feerged Sesenfold < Blinded v Chaira

Name your disc
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Disc name — located at the very top of the panel. You will see this as the name of the disc drive when you insert the disc into your computer
or Blu-ray player.

Disc type — select CD if you have a regular CD Disc, or Mini-CD if you have a CD of smaller size (8 cm or 3.1 inches in diameter versus the
standard 12 cm or 4.7 inch CDs).

Quality - if you select MP3 CD mode, you can set the quality of the audio files. Higher quality files have higher bitrate, but take up more
space. If you select Audio CD mode, the best quality will automatically be selected.

Step 5: Burn disc
At the bottom of the ChillBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill when you
record the videos, while the yellow and red lines display the maximum capacity of the selected disc type.

e N N R
EIMI:]

OMb 100Mb 200Mb 300Mb 400Mb 500MbD GO0MD 70

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete files from the list or slightly reduce quality
for MP3 files.

Then, check that you have a writable CD in your disc drive and click the Burn Disc button to begin the burning process. Your disc will be ready
in a few minutes.

Burn Disc

Burn data to disc

Step 1: Open the Burn Disc application in Data mode
Open the Movavi Video Suite launcher application and click Burn disc on the Data tab.
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Step 2: Add the files you want to burn
+ Drag-and-drop files onto the ChillBurner window, or

* In the bottom left-hand corner, click the plus icon % t0 add a file, or the folder icon © to add the contents of one or more folders to the list.

Step 3: Set up your disc preferences
On the right panel of the ChillBurner interface, set the following preferences:

256.51 Mo o ruree: by
005 MS

HID lagce| e B
i Stock photos 20750 Ma| D Tre Name your dizsc
[* S eoEdRor Setup.exe M=, 10 demparm 2009 10553 MBS D (4.7 15k)

£ Fhoio Btor Senup.am M, & ko 2004 33274 M
E themepackstup. axe M, & weowm 2004 5151 M

[ Check disc capacity ]

Disc name — located at the very top of the panel. You will see this as the name of the disc drive when you insert the DVD into your computer
or DVD player.

Disc type — select the type of recordable disc that you have. Disc capacity is listed in parentheses. If you are not sure if you have a double-
layer (DL) DVD or Blu-ray™ disc, check the package that it came with.

Step 4: Burn disc
At the bottom of the ChillBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill when you
record the videos, while the yellow and red lines display the maximum capacity of the selected disc type.

|
0GB 1GB 2GB IGB 4GB

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete some files from the list or, if you are
recording video and audio files, use the conversion module to compress them.

Then, check that you have a writable disc of the selected type in your drive and click the Burn Disc button to begin the burning process. Your
disc will be ready in a few minutes.

Please make sure your optical drive supports recording to the selected type of disc.

Burn ISO to disc
The Burn Disc module can help you burn disc images with the .iso extension to an optical disc.

Step 1: Open the Burn Disc application in Copy mode
1. Open the Movavi Video Suite launcher and click Burn image to disc on the Data tab.
2. In the Burn Disc application, open the Copy tab.

Step 2: Select the image

Click the Browse icon next to the Source list to browse for the .iso file you want to burn.
In the Destination list, select the drive you want to use for recording. If you have only one DVD-RW drive, it will be selected automatically.

Step 3: Start burning
Check that you have a writable disc in the optical drive and click Burn Disc to begin burning your ISO file to disc.

Burm Disc

Copy disc to disc
If you have two CD/DVD drives:
Step 1: Insert the discs
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Insert the disc you want to copy into one of the drives. If only one of your CD/DVD drives can burn discs of this type, insert the disc into the
read-only drive (i.e. CD-R or DVD-R drive).

Then, insert a recordable disc into the other CD/DVD-RW drive. If you are using a CD/DVD-R disc, make sure that is hasn't already been
recorded to.

Please note that Movavi Video Suite is not intended to make illegal copies of copyrighted software. Some CDs and DVDs may be copy-protected and cannot be copied or
ripped to hard drive.

Step 2: Open the Burn Disc application in Copy mode
Open the Movavi Video Suite launcher and click Copy disc to disc on the Data tab.

Step 3: Set Source and Destination
In the Source list, select the drive with the disc you want to copy. If you cannot see the drive in the list, make sure that the CD/DVD you want

to rip is inserted into the drive and click the orange refreshicon " to its right.
In the Destination list, select the drive with the empty disc.

Step 4: Start copying
Click Burn Disc to begin copying data from one disc to another.

' =%
| \
| |
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¥y

[ Burn Disc

If you only have one CD/DVD-RW drive:
1. Save the contents of the disc as an I1SO.
2. Burn the ISO file to disc.

Copy disc to hard drive
Step 1: Insert the disc
Please note that Movavi Video Suite is not intended to make illegal copies of copyrighted software. Some CDs and DVDs may be copy-
protected and cannot be copied or ripped to hard drive.

Step 2: Open the Burn Disc module in Copy Disc mode
Open the Movavi Video Suite launcher application. In the Data tab, select Copy disc to hard drive. The Burn Disc module will open.

Step 3: Set Source and Destination
In the Source list, select your CD/DVD drive If you cannot see the drive in the list, make sure that the CD/DVD you want to rip is inserted into

the drive and click the orange refresh icon " to its right.
In the Destination list, select Browse folder and specify the location where you want to save the disc files.

Step 4: Start copying
Check that you have enough disc space to copy the disc and click Burn Disc to begin copying disc files to your hard drive.

Yy
¥4

[ Burn Disc
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Uploading files to the web
When you're done creating and editing your videos, surely, they deserve to be shared with your friends and maybe with the whole world! There
are several ways to upload your video.

Upload screen recordings to YouTube Upload Video Editor projects to YouTube
EX -2
(111} Tube L& You llif:
Learn more: Uploading videos online Learn more: Publishing videos online

How to upload files to YouTube, Facebook, Vk.com, Amazon S3, and FTP storage

With the free Share Online app, you can upload a whole batch of files to multiple destinations. To open the sharing app, click Share photos
online on the Photo tab of the Movavi Video Suite launcher.

217



& Movavi Video Suite 18

Video

Audio
Convert images

Photo
Create slideshows
Extras

User Guides

Share photos online

If you haven't used the sharing app, you'll need to install it first. To do that, simply click Download in the message and the app will
automatically download and install in a few minutes.

=

‘ The online sharing module is not installed. Do you want to download
and install it right now?

Download Cancel

From then on, you can use the Share photos online button to open the sharing app.

Choose the web sites

Next on sharing:

Open files

Upload videos to YouTube

Upload files to Facebook

Upload files to Amazon S3 storage
Upload files to FTP

Upload photos

Manage your accounts

Adding media files
Before you begin uploading your videos and files online, you will need to add the files to the queue. If you used the Upload to the Web option
in one of the Movavi Video Suite modules to open Share Online, the files will already be added to the program, however you can always add
additional files using one of the following ways:
Step 1: Select the necessary files in a Windows Explorer window and drag them onto the Share Online window.

Step 2:. In the top part of the Share Online window, click Add File and browse for files you want to upload.
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Step 3: If you want to add all files within a folder, click Add Folder at the top of the window and select one or more folders in the Browse
dialog box.
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Managing files on the list:

* To remove a file from the list, click the @ button to the right of it.

« If you want to temporarily exclude files from the upload queue, uncheck the box [¥I to the left of the file. The file will remain in the list, but
will not be uploaded when you click the Upload button.

+ To remove all files from the list, click Clear List at the top of the window.

Uploading photos

Besides video and audio files, Movavi Video Suite can also help you upload photo albums.

Step 1: Add files

1. In the Photo section of the Movavi Video Suite Launcher, click Share photos online to open the sharing module.

Movavi Video Suite17
Video
Audio
Photo
Data

Extras

Share photos online

2. Drag-and-drop files from Windows Explorer onto the Share Online window or use the Add File and Add Folder buttons at the top of the
window, and specify the files you want to open.
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Step 2: Choose upload destination
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Using Share Online, you can upload your photos to several sites at once.

1. To select the services to which you want to upload your photos, click their icons at the bottom of the window.
* Note that YouTube does not accept photo uploads. Photos in the upload queue will still be uploaded to other selected services.

2. If you're using a service for the first time, you will be asked to authorize with the website. Don't worry, your login data is safe: where
possible, authentication is processed through the website itself, so that your user data is not seen or stored by Share Online.

Step 3: Add descriptions

Now you can add some additional information about each file.

1. Click a file in the list. File Information fields will appear in the column on the right.

2. Fill in the title and description for the file. At the bottom of the column, you will see service-specific fields, such as privacy options.

: | Obligatory latte photo,
like, amg
lal

| coffe, latte, sweet, cafe|

You

Upload to f L' T4

Upbosd

Step 4: Upload the files

When you're ready, click the Upload button to begin sharing your photos. This may take up to a few minutes depending on your Internet
connection.

plopd., -
TATS4 KD Mot uplosd
158,81 KB Mot upload .

Uplaad to ﬁjIEIE

Uploading videos to YouTube
Follow the instructions below to upload videos to YouTube. You will need access to a YouTube or Google account to upload the videos.

Step 1:
Click Share photos online on the Photo tab of the Movavi Video Suite launcher.
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Video

Audio
Photo
Data

Extras

Share photos online

Step 2:
Add media files to the list or use the upload option in one of the Movavi Video Suite modules.

Step 3:
In the bottom part of the Share Online window, click the YouTube icon. You can also choose to upload to other services simultaneously by
clicking their icons.

.". Uploasd

Step 4:
If you have not yet logged in, the program will ask for your login data*. Enter your YouTube username and password into the respective fields
and click OK.

Google

Sign in with your Google Account

john_doe@gmail.com

Next

Need help?

One Google Account for everything Google

G~MmERD L * B E

Step 5:

In the file list, click on a file to select it. The right part of the window will display a number of fields. Here, you can fill in some information
about your video:

+ Add an eye-catching name and description that will be displayed on the video's page on YouTube.

+ Add a few tags describing the videos and select a relevant video category: this will help other users find your video.

« Define privacy settings: public will mean that any YouTube user can find your video, while private videos can only be seen by your friends
and people that you send a link to.

* Check the length information. As per YouTube limitations, only verified accounts are allowed to upload videos longer than 15 minutes. For
details on verifying your account and increasing your upload limit, please see Google's official support page.
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Repeat step for all files in the list.

Title: My friends
Length: 01:40
Size: 391.45 MB

Description: | My idiot friends

<3 you, guys

Tags: friends, party, prank

Upload to T_IITEIE

Step 6:
When you're ready, click Upload to start uploading your files to the selected services.

*Your data will only be used for authentication with the selected services and never transferred to third parties.

Uploading videos to Facebook
You will need access to a Facebook account to upload videos and other content via the Share Online module.

Step 1: Add media files to the list or use an export option in one of Movavi Video Suite modules.

Step 2: In the bottom part of the window, click the Facebook icon. You can also select other services if you want to simultaneously upload
files to them.

Upbosad

Step 3: If you have not yet authenticated with Facebook, you will see a login window appear. Enter your Email and password and click Log
In. If you don't want to sign in every time, check Keep me logged in to Movavi Share Online.
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facebook saw

Log in to Facebook

keep me loggedin to

(]

Forgotten account? - Sign up for Facebook

Step 4: In the file list, click a file to select it. You will see some fields appear in the right pane. You can use these fields to add a name and
description, as well as assign a number of tags to make your video easier to find. Please check the length of each video, as Facebook does
not allow videos longer than 20 minutes. You can still split long videos into multiple files using the Split Movie or Video Editor module and
upload them together.

Repeat this for all your files.

Step 5: When you are ready, click Upload to begin uploading your files. Soon, they will appear on your Facebook page.

Uploading videos to Amazon S3
You can use the Share Online module to upload files to your Amazon S3 storage.

Step 1: Add files to the program or use an export option in another Movavi Video Suite module.

Step 2: In the Upload to panel at the bottom of the window, click the S3 icon to select Amazon S3 as the upload server. You can select more
than one upload destination.

e e
ZU3EE ME Mot upload_.
IP0.45 ME Mot upload..

EROET P Mot upload.
Jp 0Pl Wt uplod
477,88 M8 Mot uplosd
474.93 M3 Mot upload .

OK.

Bucket: .53.amazonaws.com
Access key ID: 111AAAATATAAAN

ecret access key:  REERREEIRENEISEREEN
Directory (optional):

0K Cancel

Step 4: (Optional) In the file list, click a file to select it. You will see some fields appear in the right side of the window. You can use the
fields to provide some information about the uploaded files. You will need to do this for each file separately.
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| My vacation
01:20
312.33 M8

x |My trip to western Europe,
2018,

|wca1:i|:|n, trip, Europe |

You
Upload to

Step 5: To begin sending the files to the server, click Upload.

Uplaad to . f W . FTP:/f Up|ﬂad

Uploading videos to FTP

The Share Online module of Movavi Video Suite also supports FTP file uploads.

Step 1: Add your files to the list or export them for sharing online via another Movavi Video Suite application.

Step 2: In the bottom panel, click the FTP icon to select FTP as the upload service. You can also choose other services along with FTP to
upload files to them as well.

Uplaad to T'uIEIE

erver hostname: 192.168.1.111
Username:

Step 4: (Optional) Select a file in the file list. You will see its information appear on the right. Here, you can fill in more information about it
and specify a folder where you would like to upload the file. Repeat this for all other files.
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| My vacation
01:20
312.33 MB

“J Description: My trip to western Europe,
2014,

|wcat||:|n, trip, Europe |

| =
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Trle: :Hfmwnen

Length:  @L:20
Stzes IZIIME

Dascripiion: | My Irip o wesbem Ewrope, 2006,

Uplaad to T_Ilrﬁ! f W H ]

Accounts
To upload media files to a web site or a hosting service, you will need to provide your login credentials, such as a login and password, to
allow Share Online to upload the files on your behalf. Your account data is stored by Share Online so that you will not have to re-enter it the
next time you upload files to that service. The data is only used for authorization with the services you choose and is not sent to any other
parties.

To view information about saved accounts:
1. In the upper right-hand corner of the Share Online window, click Preferences.
2. A Preferences window will open. Click the Accounts tab at the top.

Here, you can manage saved accounts, log in to services, and erase account data. You can check the username listed under a service to see
which account you are logged in as.

3. To clear saved account data, click the Disconnect button next to the service. Next time you select this service, you will be asked to
authorize again. You can also use the Disconnect button if you want to log in to a different account.

E My vacation.avi YouTube
E Our wedding.avi . idiot friends
H Winter holidays.avi Disconnect

you, guys

| Upload to

Upload

Help and support
Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.
How to reach us
By e-mail: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!

If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information
about your system will allow us to help you faster.
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Frequently asked questions:

How to remove trial restrictions?

Why do my videos have "trial version" on them

What are the system requirements for running Movavi Video Suite?

How to update the graphics card drivers?

System requirements

Minimum system requirements
Windows XP*/Vista/7/8/10 with latest service packs and patches

Operating system
Processor
GHz

Graphics card
to-date drivers**

Resolution
RAM

Available disk space

Intel, AMD or compatible processor, 1.5

1024x768, 32-bit color

Windows XP - 512 MB
Windows Vista, 7,8, 10 - 1 GB

850 MB for installation

Recommended configuration

Intel, AMD or compatible processor, 2.8 GHz
and above

NVIDIA® GeForce™ series 6 or higher, AMD Radeon™ R600 or higher graphics card with up-

1280x1024 or higher

Windows XP - 1 GB
Windows Vista, 7,8, 10 — 2 GB

10 GB

2 GB for ongoing operations***

Additional features:

Administrator permissions are required for installation

Sound card for audio recording and playback

Intel® hardware acceleration requires a
compatible Intel processor supporting Intel HD
Graphics™ 2nd generation or higher

Learn more

For intended performance, make sure that your
graphics card drivers are up-to-date.
Updating graphics card drivers

* Windows XP does not support recording system sound simultaneously with audio devices.
** Your graphics card must support OpenGL for the program to run correctly.
*** Free disk space is required to save the temporary recording file and the output video. The required amount of disk space will depend on

the resolution, format, and length of your videos.

Movavi Video Suite may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are

not met.

Supported formats

 vmemse
3GPP (.3gp), 3GPP2 (.3g2) v |V
ASF (.asf) v
AVI (.avi) v v
v
DivX Video (.divx) v
DVD v v
Flash (.flv, .swf) v |V
v
'
Matroska (.mkv) v |V
v
MPEG Transport Stream (.m2ts) v v
MPEG Transport Stream (.ts, .mts, .m2t) v
MPEG (.mpg, .vob) v |V
MPEG (.mpeg, .mpe, .m1v, .dat, .mod, .tod, .vro) v
MPEG-4 (.mp4) v |V
v
MPEG-4 (.m4v) v
MXF — Material eXchange Format (.mxf) v
OGV - Ogg Video (.ogv) v v
v
QuickTime (.mov) v Vv
v
QuickTime (.qt) v
RM (.rm, .rmvb) v
WebM (.webm) v v
v
WMV - Windows Media Video (.wmv) v |V

m Supported codecs

H.263, H.264, MPEG-4

MPEG-4, VC-1, WMV V7

H.264, MPEG-4, MJPEG

DivX, Xvid, DV, Cinepack, Fraps, TechSmith, Uncompressed
DivX

FLV1, H.264

VP6, H.263, Flash Screen Video
MJPEG

H.264, MPEG-4, MJPEG, Theora, VP9
DV, Uncompressed

MPEG-2, H.264

MPEG-2, H.264

MPEG-1, MPEG-2

MPEG-1, MPEG-2, H.264

MPEG-4, H.264

H.263, MJPEG, ProRes

MPEG-4, H.264, H.263, MJPEG, ProRes
MPEG-2, DV

Theora

MPEG-4

H.264, MPEG-4, MJPEG

AIC, ProRes, Sorenson 1/3, PNG
H.264, MPEG-4, AIC, MJPEG, ProRes, Sorenson 1/3
Real Video 2/3/4, Cooker

VP8, VP9

VP7

WMV V8
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WMV V7, WMV 9, WMV 9 Screen, WMV 9 Advanced profile, MPEG-4,
WMV 9.1 Image V2

WTV (wiv) H.264, MPEG-2
ouputl  suponsconecs
AAC - Advanced Audio Coding (.aac) v AAC
AIFF (.aif,.aiff) AIFF
APE - Monkey's Audio (.ape) Monkey's Audio
Au (.au, .snd) WAV
FLAC - Free Lossless Audio Codec (.flac) v FLAC
MP3 - MPEG-1/2 Audio Layer IIl (.mp3) v  MP3
MPEG-4 (.m4a) v AAC, ALAC
MPEG-4 (.m4b) AAC, PCM
Opus (.opus) Opus
OGG - Ogg Audio (.ogg) v Vorbis
WAV - Waveform Audio File Format (.wav) v PCM
AAC, MP3
WMA - Windows Media Audio (.wma) v WMA 9

WMA Pro, WMA Voice

Image formats

APNG (.apng)

BMP (.bmp) v
DPX (.dpx)

GIF (.gif) v
JPEG (.jpg) v

JPEG (.jpeg, .jpg, .jp2, .jls)
Netpbm formats (.pgm, .pbm, .ppm, .pam)
PCX (.pcx)

PNG (.png)

PTX (.ptx)

SGI (.sgi)

TARGA (.tga)

TIFF (.iff)

WebP (.webp)

XBM (.xbm)

XWD (.xwd)

((((((((((((((((E((((((((((((((E( <

Updating graphics card drivers
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics
card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a
driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance
of applications and games on your computer.

Step 1: Find your graphics card manufacturer

1. Right-click your desktop and choose Screen Resolution

2. In the Screen Resolution settings window, click Advanced settings.

3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type
section. Note the full name of the graphics card somewhere for later.

Step 2: Download the new version

Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There,
look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility
that will automatically find the necessary driver.

NVIDIA download center

AMD download center

Warning:
Only download drivers from the official manufacturer's website. Third-
party websites offering driver downloads may contain malware.

Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on your system. Your
display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.

Updating NVIDIA® Driver
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Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows
you to optimize your computer's graphics performance.

1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please
try the method above.

2. In the Drivers section, click the Check for updates button to find the latest drivers.

3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and
install the necessary driver for your system.

MRy %y Preleences
A new driver is available for your GPU Check for updates

Dirver update

5 GeForoe 34195 Drive
-'f : Download drver

Installed driver

Updating AMD® or ATI® Driver

1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center

2. Download the auto detect utility and run it when the download has finished.
Download Auto Detect Utility

3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.

If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads
page and download the driver.

4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.

5. After the driver has been installed, it is recommended that you restart your computer.

If none of the above steps have helped, feel free to contact our support team via e-mail support@movavi.com or live chat.

If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have
encountered. This will help our support team specialists solve your problem quicker.

OpenGL troubleshooting
If you see the following message about OpenGL when you open Movavi Video Suite, your computer most likely does not support the
necessary version of OpenGL. To run Movavi Video Suite, your computer needs to support at least OpenGL version 2.0, and version 2.1 is
required for smooth performance.

Your graphics card driver does not support the necessary OpenGL version.
The program may fail to start or work incorrecthy.

Click the link below to download and install the |latest graphics card driver or see the full
troubleshooting guide.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:

Step 1: Update your graphics card driver

Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver
installation file from the manufacturer's website and install it following the on-screen instructions.

Detailed instructions on updating the driver
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It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Video Suite. If you see an error
message again, proceed to the next step.

Step 2: Try the software OpenGL implementation
If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:

In the message you see after starting Movavi Video Suite, select the Download and install software OpenGL implementation box.

Or, in the main Movavi Video Suite window, open the Settings menu and choose Preferences. There, select the Use software OpenGL
implementation option and click OK.

Your graphics card driver does not support the necessary OpenGL version.
The program may fail to start or work incorrectly.

To troubleshoot this issue, update your graphics card driver or try using the software OpenGL
implementatio

v Download and install software OpenGlL implemeantation

Cancel

After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi
Video Suite.

If these steps haven't helped:
+ Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
+ Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem.

Hardware acceleration
Movavi Video Suite is optimized for the latest Intel®, NVIDIA®, and AMD hardware acceleration technologies.

Intel acceleration

Movavi Video Suite supports hardware acceleration provided by Intel® multi-core processors and integrated graphics, which allows for faster
encoding/decoding, as well as simultaneous conversion of a large number of files by employing the full power of each core. Performance
grows up to 400% for H.264 and MPEG-2 codecs and up to 8 files can be processed simultaneously.

Supported Formats

Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec; MPEG (MPEG2 PS, MPEG2 TS) with MPEG1/MPEG2 codec;
WMV with VC-1 codec.

Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec; M2TS, MPEG with MPEG2 codec.

NVIDIA acceleration

If your computer is equipped with an NVIDIA® graphics card, you can use it to accelerate media file processing up to 5x by shifting a part
of the workload to the graphics processing unit, freeing up your computer's CPU for other tasks. This technology supports the newest
NVIDIA® graphics cards, including GeForce™, GeForce Mobile, Quadro, and Quadro Mobile. You can find the full list of supported GPUs on

our webpage.

Supported Formats:

Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec, MPEG (MPEG2 PS, MPEG2 TS) with MPEG1/MPEG2 codec,
WMV with VC-1 codec.

Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec.

AMD acceleration

If your computer is equipped with an AMD graphics card, you can use it to accelerate media file processing up to 2,5x, especially for heavy
files (2K & 4K).

Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec. MP4, MOV, MKV, M2TS with H.265 codec.

Enabling hardware acceleration

To enable Intel or NVIDIA acceleration in Screen Capture, or Video Converter:

1. Open the Settings menu and select Preferences.

2. In the Preferences window, select the acceleration method that is compatible with your computer.
3. Click OK to accept the changes.

To enable Intel or NVIDIA acceleration in the Video Editor:

1. Open the Edit menu and select Preferences.

2. In the Preferences window, switch to the Acceleration tab.

3. Select the acceleration method that you prefer. For Intel® acceleration, you can choose hardware or software acceleration methods for
each of the supported codecs.

3. Click OK to accept the changes.

Troubleshooting

If the acceleration option is unavailable it may mean one of the following:
* Your computer is not equipped with the right hardware

* The driver may be out of date or not installed.

Intel Download Center

Updating graphics card drivers

SuperSpeed mode
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With SuperSpeed mode, you can convert videos much faster to compatible formats. You can use SuperSpeed mode in the converter and
screen capture modules.

How does it work?

When you convert videos, encoding the video from one codec to another usually takes the most time. In SuperSpeed mode, the video can be
converted without changing the video codec, simply ‘transferring’ the video stream from one file to another with zero quality loss. Converting
a file in SuperSpeed mode takes little more than simply copying it.

Since SuperSpeed mode does not modify the video stream, you can't use it if you want to add a watermark, adjust the video, or compress the
file to a smaller size.

Enabling SuperSpeed
1. Open the application settings and make sure that the Enable SuperSpeed mode option is on.

2. When choosing an output format, select one with the SuperSpeed icon: M 5

Codec activation
Some video and audio codecs are patented by other companies, and it is required that new users activate the codecs they use to comply
with patent law.

Activate codecs on demand
1. When you open a media file or export your project with one of these codecs, you may see a Codec Activation message.

2. Select the Activate other codecs without asking box to activate all codecs automatically in the future. The codecs will be activated
automatically, but an Internet connection is still necessary.

3. Click Activate to complete the codec activation.

Codec could not be activated
If you see a codec activation error, make sure that you have a working Internet connection. Without Internet, the codecs cannot be activated
even if you've chosen to activate them automatically. After you've restored the network connection, please restart the application.

What kind of data is being sent?

The data we send does not contain any information that can personally identify you. We only receive information about which codecs were
used.
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